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Welcome to ImageAXS Pro
ImageAXS Pro is an application that helps you catalogue, retrieve, and display your digital content, such as image, 
audio, and video files.
With ImageAXS Pro, you create collections of digital content files, called source files. These collections contain 
information about the source files, but do not contain the source files themselves. When you acquire a file, 
ImageAXS Pro automatically creates a “snap shot,” called a thumbnail to represent the source file. The thumbnail 
can be a reduced-size version of an image, a poster frame from a movie, or a stock icon representing an audio file. 
The thumbnail is stored, along with data about the source file (e.g., file type, size, location, etc., called file 
information), as a record within your collection. In addition to file information, ImageAXS Pro provides more than 
100 fields, including a long (60,000 character) description field for every record, and keywords . The file 
information, user-modifiable fields, and keywords are all searchable.
You may create as many collections as you like with ImageAXS Pro, each containing records of diverse file types. 
The source files may be located anywhere. No matter where the source file is located, on your local hard drive, on 
removable media (floppy disks, media such as Syquests or Zip cartridges, CD-ROMs, etc.), or on remote volumes 
(servers or networked storage devices), ImageAXS Pro remembers where the file is. ImageAXS Pro tells you at a 
glance if the source file is available (on-line) or not. Information about the source file can be displayed, regardless of
whether it is on-line or off-line. If the source file is on-line, the source file itself can be presented, regardless of size, 
location, or format, without the need to launch another application.
ImageAXS Pro also contains a portfolios feature, allowing you to create and save subsets of records in your 
collections. Placing records in a portfolio does not duplicate the records or remove them from the collection; instead,
ImageAXS Pro creates a table referencing the affected records, identifying them as belonging to a specific group. 
Later, the program uses these references to quickly recall the records in the portfolio, so you can work more 
efficiently.
NOTE: ImageAXS Pro logs the last 16 collections you opened and attempts to open the most recently opened 
collection when you launch the program. If ImageAXS Pro cannot find the most recently opened collection, it 
proceeds to the previously opened collection, etc., until a collection is located (which is then opened) or the list is 
exhausted. If no previously opened collections can be found, or if you closed all open collections before quitting the 
program the last time you used it, ImageAXS Pro launches without opening a collection.

Dragging and dropping
You can use a drag and drop technique to accomplish many different actions in ImageAXS Pro:
Creating new records in a collection
Copying records between collections
Copying records into a portfolio
Reordering records in a portfolio
For instructions on how to use drag and drop techniques in ImageAXS Pro, see the description under the heading 
Drag and drop in the Glossary.



Menu commands

File menu
New Collection
Open Collection
Close Collection
Collection Info
Import ImageAXS 2.x
Import CSV Text
Import Keywords
Export 
Export CSV Text
Export HTML Pages
Export e-ZCard
Export Keywords
Page Setup
Print Setup
Print Preview
Print
File List
Exit

Edit menu
Undo
Cut 
Copy
Paste
Copy Record
Paste Record (As New Record)
Paste Record (Over Selection)
Paste Record (Merge Fields With Selection)
Paste Record (Non-Empty Into Selection)
Attach Keywords
Delete
Orientation (0)
Orientation (90)
Orientation (180)
Orientation (270)

Record menu
New Record
Delete Record
Portfolios
Add to Portfolio
First Record
Previous Record
Next Record
Last Record
Go to
Word Count

Source File menu
Acquire Source File
Update Path



Update Modified
Move Source Files
Copy Source Files
Rename Source Files
Delete Source Files
File Info
Edit Source File

Selection menu
Search
Keyword Search
Sort
Show Selection
Invert Selection
Clear Selection
Select All
Show All

View menu
Thumbnails
Text List
Info Sheet
Keywords
Source File
Slide Show
Zoom In
Zoom Out
Scroll Image
Crop Image
Image Rotation (0)
Image Rotation (90)
Image Rotation (180)
Image Rotation (270)
Best Fit
View to Image
Image to View
Tile Full Views

Tools menu
Refresh Volumes
Toolbar
Left Bar
Status Bar
Image Tool Palette
Field Labels
System Settings
PhotoCD Options
Customize Report

Window menu
Arrange Icons
Cascade
Tile Vertically
Tile Horizontally
CloseWindow



Window List

Help menu
Index
Using Help
About ImageAXS Pro



New Collection command (File menu)
Use this command to create a new collection. This command opens the Create Collection dialog box which allows 
you to specify the name and location of the new collection.
After you have specified the name and location of the new collection, ImageAXS Pro displays the ImageAXS Pro 
Collection Format dialog box, which allows you to specify the type of ImageAXS Pro collection you want to create.
You can add records to collections using the drag and drop technique. See the description of Drag and drop    in the 
Glossary for more information.

Shortcuts:

Toolbar:
Keyboard: ALT+F, N

 



Open Collection command (File menu)
Use this command to open an existing collection. When you choose this command, ImageAXS Pro displays the 
Open dialog box, which allows you to navigate to and open a collection. You can open several collections 
simultaneously. To move between collections, click the window containing the collection you want or use the 
Window menu. Each open window is listed in the Window menu; to activate the collection you want, choose it from 
the menu.
NOTE: ImageAXS Pro displays a list of the last four open collections and portfolios at the bottom of the File menu. 
You can open any of the items in the File menu by choosing it. If you choose a portfolio from this area in the File 
menu (and the collection which contains the portfolio isn’t open), ImageAXS Pro opens windows for both the 
portfolio and the collection which contains it.

Shortcuts:

Toolbar:
Keyboard: CTRL+O

ALT+F, O



Close Collection command (File menu)
Use this command to close the collection that is currently open. Closing a collection by using the Close command 
also closes all other open windows associated with the collection (e.g., Info Sheet Views, Source File Views, 
portfolios, etc.). When you close all collections, ImageAXS Pro is still running, but the display area is empty.

Shortcuts:
Keyboard: ALT+F, C



Collection Info command (File menu)
Use this command to open the Collection Information window, in which you can place and/or edit a name for and an
extensive (32KB) description of a collection.

Shortcuts:
Keyboard: ALT+F, F



Import ImageAXS 2.x command (File menu, Import command submenu)
ImageAXS Pro is capable of importing information exported from other ImageAXS Pro data files (including data 
exported from previous versions of ImageAXS Pro) and EmbARK data files (EmbARK is an high-end companion 
product also produced by Digital Arts & Sciences). Importing information saves time as well as reduces errors when 
compared to manual data entry.
When you choose the Import ImageAXS 2.x command, ImageAXS Pro displays an Open File dialog box in which 
you can navigate to and select an ImageAXS 2.x export file to import (ImageAXS 2.x export files have a “.AXS” 
extension by default). The import process begins once you select a file to import and click OK; ImageAXS Pro 
displays the progress of the import in the Status Bar (at the bottom of the ImageAXS Pro window). Each record 
appears in the collection window (as a thumbnail in the Thumbnail View or as a listing in the Text List View) as 
ImageAXS Pro imports it.
Note that ImageAXS Pro also imports all keywords attached to the records and integrates them into your Master 
Keyword List during the process.
ImageAXS Pro is capable of importing information in comma separated value (CSV) format and can also import 
keywords exported from other data files.

Shortcuts:
Keyboard: ALT+F, I, I



Import CSV Text command (File menu, Import command submenu)
ImageAXS Pro is capable of importing comma separated value (CSV) data, which allows you to easily move data 
from other database applications into ImageAXS Pro. Most database applications are capable of exporting data in 
CSV format.
When you choose this command, ImageAXS Pro displays an Open dialog box, which you can use to navigate to and
select a CSV formatted file to import. After you select a CSV formatted file to import, ImageAXS Pro begins the 
import process; you can monitor the progress of the import in the Status Bar (at the bottom of the ImageAXS Pro 
window).
ImageAXS Pro is capable of importing information in ImageAXS 2.x export format and can also import keywords 
exported from other data files.

Shortcuts:
Keyboard: ALT+F, I, X



Import Keywords command (File menu, Import command submenu)
To help you search for and sort records, ImageAXS Pro contains the Keywords feature which allows you to create a 
list of descriptive terms and phrases which you can attach to records. After creating a Master Keyword List and 
attaching keywords to records, you can use the Keyword Search to locate records you want or include keywords as 
criteria when using the Search utility in ImageAXS Pro.
To make it easier for you to use the same keywords in different collections, ImageAXS Pro allows you to export and
import keywords. When you choose the Import Keywords command, ImageAXS Pro displays an Open dialog box in
which you can navigate to and select a keywords export file to import. After you select the keywords export file you 
want to import and click OK, ImageAXS Pro begins importing the keywords into your collection. You can monitor 
the progress of the import in the Status Bar (at the bottom of the ImageAXS Pro window).
Note that if you already have keywords in your data file ImageAXS Pro merges the keywords you are importing into
the Master Keywords List, giving you a complete set of keywords (including all existing and imported keywords), 
while automatically eliminating any duplicate entries.
ImageAXS Pro can also import information exported in comma separated value (CSV) and ImageAXS 2.x formats.
Copying keywords
If you only want to move a few keywords between collections, it may be more convenient to 
copy and attach the keywords. See the description of the Copy Keywords and Attach Keywords commands for more
information.

Shortcuts:
Keyboard: ALT+F, I, K



Export command (File menu)
To help you move information between collections, ImageAXS Pro features an export utility which copies the data 
from your data file and saves it in a special export format. Exporting data, rather than copying and re-entering 
information, saves time as well as reduces errors when compared to manual data entry.
When you select the Export command, the Export command submenu is displayed at the right of the menu, allowing
you to choose the type of export you want to perform.
NOTE: Select the records you want to export BEFORE choosing the Export command; if you do not choose any 
records, ImageAXS Pro defaults to exporting all records in your collection.
ImageAXS Pro is capable of exporting data in the following formats:
· Comma Separated Value (CSV)

Most database applications are capable of importing and exporting information in this format
· As an e-ZCard

e-ZCard is a standalone application designed to distribute images on a single floppy. The viewing engine is 
incorporated into the e-ZCard file, making it fully self-contained. People who receive the floppy need no other 
software to view the images.

· As an HTML page suitable for publishing on the World Wide Web.
NOTE: HTML Page data can be exported only from the 32-bit version of ImageAXS Pro.

· ImageAXS Pro also allows you to export the keywords from your data file so you can use them in other 
collections (without having to re-enter the keywords by hand).

When you choose the Export command, the Export Command submenu is opened, allowing you to choose one of 
the four export    types. If you are exporting CSV text or keywords, ImageAXS Pro displays a Save As dialog box, 
allowing you to enter a name and location for your export file. When the export process is complete, you can import 
the exported file into another collection or into an EmbARK data file. If you are exporting HTML Pages, ImageAXS
Pro displays the HTML Export Wizard, which guides you through the process of setting up your pages. If you are 
exporting records as an e- e-ZCard, ImageAXS Pro displays the Compose e-ZCard dialog box, which allowing you 
to specify the settings for your e-ZCard.

Shortcuts:
Keyboard: ALT+F, E



Export CSV Text command (File menu, Export command submenu)
To help you move information between data files and applications, ImageAXS Pro features an export utility which 
allows you to copy data out of your collection in different formats. Exporting data, rather than re-entering 
information, saves time as well as reduces typos and errors when compared to manual data entry.
Comma Separated Value (CSV) data is accepted by most databases and is the format you will most likely use when 
moving data from ImageAXS Pro into another application.
NOTE: Select the records you want to export BEFORE choosing the Export command; if you do not choose any 
records, ImageAXS Pro defaults to exporting all records in your collection.
After you select the CSV Text command, ImageAXS Pro displays the Save As dialog box. Use the controls in the 
Save As dialog box to enter the name and location for the export file. When you are finished entering the name and 
location for the file, click OK. ImageAXS Pro creates the export file containing the data from the records you 
selected to export, in CSV format.

Shortcuts:
Keyboard: ALT+F, E, X



Export HTML Pages command (File menu, Export command submenu)
To help you publish your content on the World Wide Web, ImageAXS Pro contains a feature allowing you to 
automatically create Hypertext Markup Language (HTML) pages containing information and/or source files from 
your collection. The HTML Pages command opens the HTML Export Wizard, which guides you through the process
of setting up your pages.
NOTE: HTML Page data can be exported only from the 32-bit version of ImageAXS Pro.
NOTE: Select the records you want to export BEFORE choosing the Export command; if you do not choose any 
records, ImageAXS Pro defaults to exporting all records in your collection.

ImageAXS Pro provides templates which allow you to control the structure and design of your HTML pages. You 
can also modify these templates to create different designs. For information on how to create your own templates, 
see the section titled “ Creating Web Page Templates” in this help file or in the manual that accompanies the 
ImageAXS Pro software.
The HTML Export Wizard enables you to control how your HTML pages will be generated. ImageAXS Pro allows 
you to save your page creation settings so you can use them during subsequent HTML exports. Each setting name 
can have up to 254 characters, allowing you to create detailed descriptions for the settings. Saving settings so you 
can reuse them later to update pages, or as the basis for new pages, is a great way to save time when developing web
content.
When you choose the HTML Pages command, ImageAXS Pro displays the first dialog box of the HTML Export 
Wizard. The HTML Export Wizard consists of several dialog boxes; the first dialog box contains controls allowing 
you to load and run previously saved settings.
NOTE: Be sure to delete all files in the folder in which you want ImageAXS Pro to place your exported HTML 
pages. If you do not empty the folder before beginning the export process, your results may be unpredictable.

Contents of pages
ImageAXS Pro is capable of producing the following types of web pages:

Thumbnail (also referred to as Graphic or Main) page
The main web page ImageAXS Pro creates is primarily a table, each cell of which displays either a thumbnail, a 
caption, or field data (depending on the template you choose). The Thumbnail page is determined by the Thumbnails
template. You can use one of these templates or customize your own:
· Thumbnails - tag below: a thumbnail with a caption field below the image.
· Thumbnail list - seven fields on left or seven fields on right: a thumbnail with the first seven fields of text 

information from your ImageAXS Pro Collection.
NOTE: The preferred Info Sheet template companion for this template is “Info Description Only.”

The header of the Thumbnail page is taken from the Collection Name field you enter in the Collection Information 
dialog box, accessed using the Collection Info command; similarly, the data in the Collection Information dialog 
box’s Collection Description field is inserted as body text at the top of the page. Depending on the option(s) you 
choose in the Configure Features dialog box, clicking a thumbnail in this page can have no effect (“None”), display 
the source file for the record (“Link to Full-Size Image”), or display an Info Sheet page from which the source file 
can be accessed (“Link to Image through Info Sheet” - this option is described next). If you select the e-ZCard 
Maker selection checkbox, a checkbox appears beneath each thumbnail in your web page, allowing users to create 
an e-ZCard of images from your site. If you select the Search Engine checkbox, users will be able to perform 
keyword searches on the records included in your main web page.
NOTE: For Search Engine and e-ZCard creation capabilities to be enabled, the HTML pages and CGI scripts 
generated by ImageAXS Pro must be properly installed on a web server.

Source Image Page
The Source File Page is exactly what the name implies - a page showing the source file for the record. ImageAXS 
Pro produces a Source File Page for the records you export if you select either the Link to Full-Size Image option or 
the Link to Image through Info Sheet option in the Configure Features dialog box. As in the main web page, the 
Collection Name appears as a header in the full size image page. Below the header the selected caption field for the 
image appears. Three templates for the Source Image Page are provided:
· Full Image - white background: a full-size image on a white background.



· Full Image - dark background: a full-sized image on a dark grey background.
· Full Image - dark background with link: Click on full image to automatically return to Thumbnails Page.

Info Sheet Page
If you choose to include a link to information about records in your web pages, ImageAXS Pro creates an Info Sheet
page for each record as a part of your export. The Info Sheet page can be configured using one of    several 
templates.
· Field contents for either the first five or seven fields for each record can be displayed at the left or right of the 

record thumbnail in a two-column table. The template may also include keywords.
· The contents of the long text (Description) field for each record can be displayed below the record thumbnail in 

a two-row table. This template works best in conjunction with a “Thumbnails List” template.
Clicking the thumbnail in any info sheet page opens the Source File Page for the record. At the bottom of each info 
sheet page appear navigation buttons which allow the user to navigate to the first, previous, next, and last info sheet 
page for the exported records. A Thumbnail button allows easy navigation to the main (thumbnail) page.

Search Page
If you choose to include the ability to search records by keywords in your web pages, ImageAXS Pro creates a 
Search page as a part of your export. The Search page can be configured to allow users to search records in your 
pages in any or all of the following ways:
· By entering a keyword to search on.
· By choosing a keyword to search on from a pop-up list of your collection’s keywords.
· Alphabetically, by clicking the letter of the alphabet with which the keyword he or she is interested in begins 

and choosing a keyword from a pop-up list of the keywords beginning with that letter.

Shortcuts:
Keyboard: ALT+F, E, H

NOTE: The HTML export utility is not available on Windows 3.1 systems.



Export e-ZCard command (File menu, Export command submenu)
ImageAXS Pro allows you to export records from your ImageBase into an e-ZCard, which you can distribute. You 
can configure your e-ZCard to contain any number of records exported from your ImageBase.
When constructing e-ZCards for distribution, you may want to consider the following issues:
· Distribution Media

The media you use to distribute your e-ZCard (i.e., a 3.5 inch 1.44 MB floppy, a 5.25 inch 1.2 MB floppy, high 
capacity data cartridge, etc.) governs the size and number of images you distribute. If the media you choose has 
limited capacity, you will want to use fewer (and smaller) images, as well as construct the e-ZCard to display on
a smaller monitor (e.g., 640 x 480 rather than 1024 x 1280).

· Text Content
Each page of your e-ZCard has a title, and each image in the e-ZCard has a vertical and horizontal caption. 
While you can enter the title caption in the dialog box you use to define the content of your e-ZCard, 
ImageAXS Pro uses fields from the records included in your e-ZCard for the vertical and horizontal captions 
next to images. Before creating your e-ZCard, be sure that you have the text information you want to include in 
the e-ZCard in the appropriate fields.

To export an e-ZCard, select the records you want to place in the e-ZCard in either the Thumbnails View or Text List
View, then choose Export e-ZCard from the File menu. When you choose the Export e-ZCard command, ImageAXS
Pro displays the Compose e-ZCard dialog box. The records you selected appear in the File List area of the Compose 
e-ZCard dialog box. 
NOTE: Select the records you want to export BEFORE choosing the Export command; if you do not choose any 
records, ImageAXS Pro defaults to exporting all records in your collection. 
ImageAXS Pro is capable of exporting data in the following formats:
· ImageAXS Pro export format

Data exported in this format can be imported into other ImageAXS Pro data files and EmbARK, the relational 
database program from Digital Arts & Sciences.

· Comma Separated Value (CSV)
Most database applications are capable of importing and exporting information in this format

· As an HTML page suitable for publishing on the World Wide Web.
· ImageAXS Pro also allows you to export the keywords from your data file so you can use them in other 

collections (without having to re-enter the keywords by hand).

Shortcuts:
Keyboard: ALT+F, E, E

NOTE: The e-ZCard export utility is not available on Windows 3.1 systems.



Export Keywords command (File menu, Export command submenu)
ImageAXS Pro allows you to export the keywords in your collection so you can use them in another collection 
without having to re-enter the keywords by hand. When you choose this command, ImageAXS Pro opens a Save As 
dialog box, in which you can enter the name and location for the keywords export file. To load your exported 
keywords into another collection, use the Import Keywords command (also in the File menu).

Shortcuts:
Keyboard: ALT+F, E, K



Print command (File menu)
Use this command to print a document. Each view produces output in its own format, corresponding with the type of
information contained in the view and the settings you enter in the Page Setup dialog box and/or the Printing 
Multiple Records dialog box. When you select the Print command, ImageAXS displays the Printing Multiple 
Records dialog box, which allows you to select the format and range of the records you print.
Thumbnails View: Depending on the settings you enter in the Printing Multiple Records dialog box and/or the Page 
Setup dialog box, ImageAXS prints either all of the thumbnails in the collection or those which are currently 
selected. Thumbnail labels are automatically printed. The grid pattern used to print the Thumbnails View is 
determined by the settings you enter in the Page Setup dialog box.
Text List View: Text information about the records in your collection is printed in the form of a Text List Report. 
Text List Reports are configurable as templates and can be designed to include or disinclude any field information 
that you want. To configure the Text List Report, use the Text List Report dialog box and the Customize List Report 
dialog box, which are accessed using the Customize Report command. Depending on the settings you enter in the 
Printing Multiple Records dialog box and/or the Page Setup dialog box, ImageAXS prints text information either for
all records in the collection or for those records which are currently selected. ImageAXS prints the text information 
for the records in the order in which they appear in the Text List View.
Info Sheet View: ImageAXS prints the information in the format as it appears in the Info Sheet View. This print 
option includes    thumbnail. Record print range can be set in the Page Setup dialog box or the Printing Multiple 
Records dialog box.
Source File View: ImageAXS prints the source file for the record. If the source file is a movie, ImageAXS prints the 
poster frame. ImageAXS cannot print the source file for audio files.
When you choose this command, ImageAXS opens the Print dialog box.

Shortcuts:

Toolbar:
Keyboard: ALT+F, P

CTRL+P



Print Preview command (File menu)
Use this command to display the active view as it will appear when printed. When you choose this command, 
ImageAXS displays the Printing Multiple Records dialog box, allowing you to specify a print range for the records 
in your collection. A Print Preview window opens in which one or two pages appear in their printed format. The 
Print Preview toolbar offers you options to view either one or two pages at a time; move back and forth through the 
document; zoom in and out on pages; and initiate a print job.

NOTE: The Text List View, when printed, is organized according to the default Text List Report template. Text List 
Reports are configurable as templates and can be designed to include or disinclude any field information that you 
want. To configure the Text List Report, use the Text List Report dialog boxand the Customize List Report dialog 
box, which are accessed using the Customize Report command.

Shortcuts
Keyboard: ALT+F, V



Page Setup command (File menu)
Use this command to open the Page Setup dialog box The Page Setup dialog box allows you to set the grid pattern 
(the number of thumbnails across and down the page) for thumbnails on your printed output.

Shortcuts
Keyboard: ALT+F, G



Print Setup command (File menu)
Use this command to open the Print Setup dialog box. The Print Setup dialog box allows you to choose the printer to
which you want to send your output, specify the paper size and orientation, and select the source for the paper (such 
as manual feed or paper tray). The Print Setup dialog box also contains a Properties button which allows you to enter
any special settings for your printer. 
For more information about the Print Setup dialog box, see your Windows User’s Guide or the documentation which
came with your printer.

Shortcuts:
Keyboard: ALT+F, R



File List command (File menu)
A list of the most recently opened data files appears here. Click the number or name that corresponds to the data file 
you want to open.

Shortcuts:
Keyboard: ALT+F, (enter the number which corresponds to the data file you want)



Exit command (File menu)
Use this command to exit ImageAXS Pro. After you choose this command, all ImageAXS Pro windows close and 
the program ends.
NOTE: ImageAXS Pro logs the last 16 collections you opened and attempts to open the most recently opened 
collection when you launch the program. If ImageAXS Pro cannot find the most recently opened collection, it 
proceeds to the previously opened collection, etc., until a collection is located (which is then opened) or the list is 
exhausted. If no collections are open when you quit ImageAXS, no collections will open when you next launch the 
program.

Shortcuts:
Keyboard: ALT+F4

ALT+F,X



Undo command (Edit menu)
Use this command to reverse the last text editing action. The Undo command is unavailable if your last action 
cannot be reversed.

Shortcuts:
Keyboard: ALT+E, U

CTRL+Z



Cut command (Edit menu)
Use this command to remove selected text from a record and place it on the Clipboard. Cutting text replaces any 
previous Clipboard contents. This command is unavailable if you have no selected text. You can use the Paste 
command (also in the Edit menu) to place text contained by the Clipboard to a new location. For more information 
about the Clipboard, see your Windows User’s Guide.

Shortcuts:

Toolbar:
Keyboard: SHIFT+DEL

ALT+E, T
CTRL+X



Copy command (Edit menu)
Use this command to copy selected text to the Clipboard. This command is unavailable if you have no selected text. 
You can use the Paste command (also in the Edit menu) to place text contained by the Clipboard to a new location. 
For more information about the Clipboard, see your Windows User’s Guide.

Shortcuts:

Toolbar:
Keyboard: CTRL+INS

ALT+E, C
CTRL+C



Copy Record command (Edit menu)
When you choose the Copy Record command, ImageAXS Pro copies text information from the selected record and 
places it on the Clipboard. 
NOTE: If more than one record is selected, ImageAXS Pro copies information which is marked with the white 
rectangle cursor. 
You can then paste the information into records using one of the Paste Record commands (Paste As New Record, 
Paste Into Selection, Paste Over Selection, or Merge with Selection). 
Note that the Copy Record command does not copy the keywords attached to the record nor does it copy the 
thumbnail for the record.

Shortcuts:
Keyboard: ALT+E, Y



Copy Keywords command (Edit menu)
The Copy Keywords command allows you to copy keywords and paste them to one or more records, even between 
collections. This is useful when you want to attach one or more keywords to several records simultaneously. This 
command is available only if you have keywords selected. 
To copy keywords, open the Keywords View by either choosing the Keywords command from the View menu or by 
clicking the Keywords View icon in the Left Bar. In the In the Keywords View, you can select Keywords from either
the Master Keywords List or from the Record Keywords List; hold down the Shift key to select multiple keywords. 
After selecting your keywords, choose Copy Keywords from the Edit menu - this places the selected keywords on 
the Clipboard. Once you have copied the keywords you want to the Clipboard, you can select the records to which 
you want to attach the keywords and choose Attach Keywords from the Edit menu. Note that the records to which 
you attach the keywords do not have to be part of the collection to which the record you copied the keywords 
belongs, but you only can copy the keywords to records in a single collection at a time.
0 For more information about pasting keywords, see the description of the Attach Keywords command later 
in this document.

Shortcuts:
Keyboard: CTRL+K

ALT+E, K



Paste command (Edit menu)
Use this command to insert text that has been copied to the Clipboard (using the Cut or Copy commands) into a 
record. This command is unavailable if the Clipboard does not contain text.

Shortcuts:

Toolbar:
Keyboard: SHIFT+INS

ALT+E, P
CTRL+V



Paste Record, as New Record command (Edit menu, Paste Record command submenu)
When you choose this command, ImageAXS Pro creates a new record in your data file and pastes text information 
copied to the Clipboard using the Copy Record command (also in the Edit menu) into it. Note that the new record 
does not have a thumbnail, contains no keywords, and does not reference a source file. This command is only 
available when the Clipboard contains record information. 
NOTE: You cannot create more than one new record with this command. To create several new records in a 
collection, drag and drop the records you want to copy into the window of the target collection.

Shortcuts:
Keyboard: ALT+E, R, N



Paste Record, Non-Empty Into Selection command (Edit menu, Paste Record command 
submenu)
ImageAXS Pro allows you to paste record information copied to the Clipboard using the Copy Record (also in the 
Edit menu) into one or more selected records. When you use this command to paste record data, the copied data 
replace the information in the target records (except for fields that are empty in the copied record). Compare to the 
Paste Over Selection command (also in the Edit menu), which overwrites all fields in the selected records (including
fields in the copied record that are empty).

Shortcuts:
Keyboard: ALT+E, R, T



Paste Record, Merge Fields with Selection command (Edit menu, Paste Record command 
submenu)
ImageAXS Pro allows you to paste record information copied to the Clipboard using the Copy Record (also in the 
Edit menu) into a selected record. When you use this command to paste record data, the copied data replace the 
information in the target record (except for fields that are empty in the copied record). Compare to the Paste Over 
Selection command (also in the Edit menu), which overwrites all fields in the selected record (including fields in the
copied record that are empty).

Shortcuts:
Keyboard: ALT+E, R, E



Paste Record, Over Selection command (Edit menu, Paste Record command submenu)
ImageAXS Pro allows you to paste record information copied to the Clipboard using the Copy Record (also in the 
Edit menu) into one or more selected records. When you use this command to paste record data, the copied data 
replace the information in the target records (including fields in the copied record that are empty). Compare to the 
Paste Into Record command (also in the Edit menu), which overwrites all fields in the selected records (except for 
fields that are empty in the copied record).

Shortcuts:
Keyboard: ALT+E, R, V



Paste Record, Over Selection command (Edit menu, Paste Record command submenu)
ImageAXS Pro allows you to paste record information copied to the Clipboard using the Copy Record (also in the 
Edit menu) into a selected record. When you use this command to paste record data, the copied data replace the 
information in the target record (including fields in the copied record that are empty). Compare to the Paste Into 
Record command (also in the Edit menu), which overwrites all fields in the selected record (except for fields that are
empty in the copied record).

Shortcuts:
Keyboard: ALT+E, R, V



Paste Record, Merge Fields with Selection command (Edit menu, Paste Record command 
submenu)
ImageAXS Pro allows you to paste record information copied to the Clipboard using the Copy Record command 
(also in the Edit menu) into one or more selected records. When you use this command to paste record data, the 
copied data is merged into blank fields in the target record(s). Fields in the target record(s) that already contain 
information are left unchanged.

Shortcuts:
Keyboard: ALT+E, R, E



Paste Record, Merge Fields with Selection command (Edit menu, Paste Record command 
submenu)
ImageAXS Pro allows you to paste record information copied to the Clipboard using the Copy Record command 
(also in the Edit menu) into a selected record. When you use this command to paste record data, the copied data is 
merged into blank fields in the target record. Fields in the target record that already contain information are left 
unchanged.

Shortcuts:
Keyboard: ALT+E, R, E



Attach Keywords command (Edit menu)
The Attach Keywords command allows you to attach keywords you have placed on the Clipboard using the Copy 
Keywords command (also in the Edit menu) to one or more records you have selected. This feature is useful when 
you want to attach keywords to several records simultaneously. Note that the records to which you attach the 
keywords do not have to be part of the collection to which the record you copied the keywords belongs, but you only
can copy the keywords to records in a single collection at a time. This command is available only when keyword 
data is present on the Clipboard. 

To attach keywords to records using the Attach Keywords command, select the records to which you want to attach 
keywords in either the Thumbnails or Text List View and choose Apply Keywords from the Edit menu. Note that all 
records you select must be part of the same collection (to copy the keywords on the Clipboard to records in another 
collection, open the collection that contains the records you want, select the records, and choose Attach Keywords 
from the Edit menu again). 

One of the best aspects of the Attach Keywords feature is its management capabilities. If you are copying keywords 
between records in the same collection, ImageAXS Pro automatically checks the keywords you are copying and 
eliminates any duplicates so the list of keywords in the target records remains “clean.” Also, if you are copying 
between collections, ImageAXS Pro not only checks for duplicates but also adds any new keywords to the Master 
Keyword List of the target collection during the process besides attaching the keywords to the selected records. 

You can make the process even more specific if you attach the keywords into an open Keywords View window. You 
can place the keywords into the Master Keyword List instead of attaching the keywords to the displayed record; in 
effect this is a faster, simpler way of moving a set of keywords between collections without having to use the Import
Keywords and Export Keywords commands in the File menu. Note that when you place the keywords in the Master 
Keyword List that the keywords are NOT automatically attached to the record displayed in the Keywords View (you
must attach the keywords manually). 

Shortcuts:
Keyboard: ALT+E, W



Delete command (Edit menu)
The Delete command allows you to erase text that you have selected, such as in fields or the Collection Info 
window. To delete text, select the characters you want to remove by dragging your mouse across them and choose 
Delete from the Edit menu (CTRL+Delete).

Shortcuts:
Keyboard: CTRL+Delete

ALT+E, D



Orientation 0 Degrees command (Edit menu, Orientation command submenu)
ImageAXS Pro allows you to set the orientation of images so they appear correctly in the Thumbnail, Info Sheet, 
Keywords, and Source File Views. You can select from four different settings; if you choose this command the 
rotation is set to 0 degrees ( the equivalent of no rotation). Note that using this command does not affect the source 
file. 
NOTE: This setting is saved in the record for the selected image, and is retained after you close the collection and/or
quit ImageAXS Pro. This command is unavailable if the collection you are using is read-only (ImageAXS Pro 
cannot save the changed orientation setting).

Shortcuts:
Keyboard: ALT+E, O, 0



Orientation 90 Degrees command (Edit menu, Orientation command submenu)
ImageAXS Pro allows you to set the orientation of images so they appear correctly in the Thumbnail, Info Sheet, 
Keywords, and Source File Views. You can select from four different settings; if you choose this command the 
rotation is set to 90 degrees ( the equivalent of 90 degrees clockwise rotation). Note that using this command does 
not affect the source file. 
NOTE: This setting is saved in the record for the selected image, and is retained after you close the collection and/or
quit ImageAXS Pro. This command is unavailable if the collection you are using is read-only (ImageAXS Pro 
cannot save the changed orientation setting).

Shortcuts:
Keyboard: ALT+E, O, 9



Orientation 180 Degrees command (Edit menu, Orientation command submenu)
ImageAXS Pro allows you to set the orientation of images so they appear correctly in the Thumbnail, Info Sheet, 
Keywords, and Source File Views. You can select from four different settings; if you choose this command the 
rotation is set to 180 degrees (the equivalent of 180 degrees clockwise rotation). Note that using this command does 
not affect the source file. 
NOTE: This setting is saved in the record for the selected image, and is retained after you close the collection and/or
quit ImageAXS Pro. This command is unavailable if the collection you are using is read-only (ImageAXS Pro 
cannot save the changed orientation setting).

Shortcuts:
Keyboard: ALT+E, O, 1



Orientation 270 Degrees command (Edit menu, Orientation command submenu)
ImageAXS Pro allows you to set the orientation of images so they appear correctly in the Thumbnail, Info Sheet, 
Keywords, and Source File Views. You can select from four different settings; if you choose this command the 
rotation is set to 270 degrees (the equivalent of 270 degrees clockwise rotation). Note that using this command does 
not affect the source file. 
NOTE: This setting is saved in the record for the selected image, and is retained after you close the collection and/or
quit ImageAXS Pro. This command is unavailable if the collection you are using is read-only (ImageAXS Pro 
cannot save the changed orientation setting).

Shortcuts:
Keyboard: ALT+E, O, 2



New Record command (Record menu)
Use this command to create a new, empty record without acquiring a source file. This is useful if you want to 
perform data entry before the source files are available. Source files and thumbnails can be added to these records 
later using the Update command in the Source File menu.

Shortcuts:
Keyboard: CTRL+N

ALT+R, E



Delete Record command (Record menu)
Use this command to delete selected records, or the record that is currently displayed if no records are selected. 
Please note that this command does not delete the source files associated with the records you delete.

Shortcuts:
Keyboard: Delete

0 ALT+R, D



Portfolios command (Record menu)
Use this command to create, open, delete, or rename a portfolio. A portfolio is a subset of the records (i.e., images, 
videos, audio files, etc.) in your collection. When you choose this command, ImageAXS Pro opens the Portfolios 
dialog box. 
You can have multiple portfolios (and several collections) open simultaneously. When you open a portfolio, 
ImageAXS Pro places the name of the portfolio and the name of the collection from which it was derived in the title 
bar, so you can identify the portfolio easily. This name also appears in the open window list in the Window menu to 
make navigation easier. 
You can add records to and reorder records in portfolios using the drag and drop technique. See the description of 
Drag and drop    in the Glossary for more information.

Shortcuts:
Keyboard: ALT+R, P



Add to Portfolio command (Record menu)
Use this command to add the selected records to a portfolio. Portfolios are subsets of the records in your collection 
that you can save and reopen as needed.

Shortcuts:
Keyboard: ALT+R, A



First Record command (Record menu)
Use this command to move the cursor to the first record in the active window. If you click this button while the Info 
Sheet View or the Keywords View is the active window, ImageAXS Pro displays the first record in the data set.

Shortcuts:

Toolbar:
Keyboard: ALT+R, F

Home

 



Previous Record command (Record menu)
Use this command to move the cursor to the previous record in the active window. If you click this button while the 
Info Sheet View or the Keywords View is the active window, ImageAXS Pro displays the previous record in the data
set.

Shortcuts:

Toolbar:
Keyboard: SHIFT + F6

ALT+R, V
LEFT ARROW
Page Up

 



Next Record command (Record menu)
Use this command to move the cursor to the next record in the active window. If you click this button while the Info 
Sheet View or the Keywords View is the active window, ImageAXS Pro displays the next record in the data set.

Shortcuts:

Toolbar:
Keyboard: F6

ALT+R, N
RIGHTARROW
Page Down

 



Last Record command (Record menu)
Use this command to move the cursor to the last record in the active window. If you click this button while the Info 
Sheet View or the Keywords View is the active window, ImageAXS Pro displays the last record in the data set.

Shortcuts:

Toolbar:
Keyboard: ALT+R, L

End

 



Go To command (Record menu)
Use this command to open the Go To dialog box. The Go To dialog box allows you to navigate directly to the record 
you want by entering its number. You can see the number of a record by selecting it and referring to the Record 
Number indicator at the lower right corner of the ImageAXS Pro window.

Shortcuts:
Keyboard: CTRL+G

ALT+R, G



Revert to Saved command (Record menu)
This command is only available when the Info Sheet View is active. If you make changes to the text data in a record 
and want to discard your changes and restore the original text content, choose this command. Note that this 
command does not restore changes made to the source file, thumbnail, or keywords attached to the record.

Shortcuts:
Keyboard: ESC

ALT+E, R



Save Record command (Record menu)
This command is available when the Info Sheet View is active. If you are making changes to a series of records or 
extensively editing a single record and want to save your changes without closing the Info Sheet, choose this 
command. ImageAXS Pro writes your changes to the data file without closing or changing the record in the Info 
Sheet View.

Shortcuts:
Keyboard: ALT+E, S



Word Count command (Record menu)
Use this command to open the Word Count dialog box. ImageAXS counts the words in all selected records and lists 
the results in the Word Count dialog box.

Shortcuts:
Keyboard: ALT+R, W



Acquire Source File command (Source File menu)
Use this command to acquire new source files into your collection. Each source file you acquire creates a new 
record. Choosing this command opens the Acquire Files dialog box. For a list of the file types ImageAXS Pro can 
accept, see the entry for File types in the Glossary. 
The Acquire Files dialog box contains controls which allow you to acquire source files as a batch, eliminating the 
need to acquire source files and create records one at a time.

Shortcuts:
Keyboard: ALT+O, A



Update Path command (Source File menu)
Use this command to update the path and file information for the source file(s)of selected records. You can also use 
this command to acquire new thumbnails for selected records. Source files are not contained within your data file; 
instead (for reasons of efficiency), ImageAXS Pro stores a “link” to the location of source files. When ImageAXS 
Pro cannot find source files (because they have been renamed, moved, deleted (using Windows Explorer, File 
Manager, or another tool outside ImageAXS Pro), or the volume containing the source files is not mounted), the 
records are said to be off-line. Choosing this command opens the Update Path dialog box. 
NOTE: If you want to move, copy, rename, or delete source files, it is recommended that you use the Move Source 
Files, Copy Source Files, Rename, and Delete Source Files commands in the Source File menu. By using these 
commands, you prevent records from going off-line (except, of course, in the case of the Delete Source Files 
command).

Shortcuts:
Keyboard: ALT+O, U



Update Modified command (Source File menu)
If you modify one or more source files (such as by cropping, color correcting, or any other type of editing) and want 
to change the thumbnail to reflect its new appearance, use the Update Modified command. When you choose this 
command, ImageAXS Pro automatically reacquires the thumbnails for the selected records. When the source files 
have been reacquired, the new thumbnails for the records appear in the Thumbnails View.

Shortcuts:
Keyboard: ALT+O, F



Move Source Files command (Source File menu)
Use this command to move the source files for the selected records from one location to another. Source files are not
contained within your data file; instead (for reasons of efficiency), ImageAXS Pro stores a “link” to the location of 
source files. When ImageAXS Pro cannot find source files (because they have been renamed, moved, deleted, or the
volume containing the source files is not mounted), the records are said to be off-line. Using the Move Source Files 
command allows you to move source files to a new location while maintaining the database links between the source
files and the affected records. Choosing this command opens the Move Source Files dialog box.

Shortcuts:
Keyboard: ALT+O, V



Copy Source Files command (Source File menu)
Use this command to copy source files from one location to another. Choosing this command opens the Copy Source
Files dialog box. If you want the selected records in your collection to reference the new source files (created as a 
result of the copy), select the Update Collection checkbox (otherwise the records will continue to reference the 
original files).

Shortcuts:
Keyboard: ALT+O, C



Rename Source Files command (Source File menu)
Use this command to change the file name of the source file for the selected record. Source files are not contained 
within your data file; instead (for reasons of efficiency), ImageAXS Pro stores a “link” to the location of source 
files. When ImageAXS Pro cannot find source files (because they have been renamed, moved, deleted, or the 
volume containing the source files is not mounted), they are said to be off-line. Using the Rename Source Files 
command allows you to rename source files without the selected records falling off-line. This command is not 
available if more than one record is selected. Choosing this command opens the Rename Source Files dialog box.

Shortcuts:
Keyboard: ALT+O, M



Delete Source Files command (Source File menu)
Use this command to delete the source files for the selected records. When you delete the source file, it is 
permanently removed from your system and the record that references the source file becomes off-line. You cannot 
open a Source File View for records that are off-line.

Shortcuts:
Keyboard: ALT+O, D



File Info command (Source File menu)
Use this command to open the File Information dialog box. When you acquire a source file to create a new record, 
ImageAXS Pro stores information about the source file (including the file name, type, size in bytes, width and height
in pixels, when the file was last modified, and the path for the file). The information displayed in the File 
Information dialog box is read only.

Shortcuts:
Keyboard: ALT+ENTER

ALT+O, I
Mouse: Double click the Thumbnail icon (below the image in the 

Thumbnails View) to bring up the file information for that specific record.



Edit Source File command (Source File menu)
Use this command to open the source file for the selected record in an application outside of ImageAXS Pro 
associated with the file (if any). For example, if the source file is an image, you may open the source file in an 
application such as Photoshop or Paintbrush; if the source file is a movie you may open it in an application such as 
Premier or Videoshop; if it is a sound file, you may open it in an application such as SoundEdit Pro.
You can also initiate this command from the Thumbnails View by holding down the Alt key and double-clicking the 
file’s thumbnail. ImageAXS Pro launches the associated application and opens the source file which corresponds to 
the thumbnail.
After modifying the source file, you may want to use the Update command in the Source File menu to create a new 
thumbnail for the record. 
NOTE: To change the association between the file type and the opening application, use Windows Explorer or File 
Manager. For more information on file associations, see the User’s Guide for your version of the Windows operating
system.

Shortcuts:
Keyboard: ALT+O, L
0 Mouse: Double-click thumbnail while holding down the ALT key.



Search command (Selection menu)
Use this command to open the Search dialog box. The Search dialog allows you to search for records in the open 
collection according to any criteria, including the contents of any field or the file information for source files 
associated with records. 
The Search dialog box contains controls allowing you to build sophisticated searches containing multiple search 
lines. Each line in a search represents one item you are looking for, for example, a line may read “Title begins with 
Y.” You connect search lines using conjunctions; using the previous line as an example, you may add another line 
stating “and Photographer is equal to Adams.” The results of this search would include “Yosemite Valley” and 
Yosemite Falls” by Ansel Adams. This is a simple example; you can create highly complex searches in the Search 
dialog box. 
ImageAXS Pro also allows you to store and recall search criteria, saving you the trouble of recreating complex 
searches.

Shortcuts:
Left Bar:

Toolbar:
Keyboard: CTRL+F

ALT+S, E

 



Keyword Search command (Selection menu)
Use this command to open the Keyword Search dialog box. The Keyword Search dialog box allows you to search 
for records in your collection using keywords attached to the records as criteria. 
The Keywords Search dialog box also provides access to the Advanced Keyword Search dialog box, in which you 
can create, save, and load complex keyword search criteria.

Shortcuts:
Left Bar:

Toolbar:
Keyboard: ALT+S, K

 



Sort command (Selection menu)
Use this command to open the Sort dialog box. The Sort dialog box allows you to sort the records in your collection 
according to any criteria, including the contents of fields and the file information for the source file associated with 
the record. You can build your sort criteria from several elements, such as the contents of the first three fields in 
records, and arrange them so you get the exact sort you want. You can also configure the sort to deliver your results 
in ascending (e.g., 1,2,3 or a,b,c) or descending (e.g., 9,8,7 or z,x,y) order. The results of your sort appear in the 
layout in which you chose the Sort command (i.e., the Thumbnails View or the Text List View).

Shortcuts:
Left Bar:

Toolbar:
Keyboard: ALT+S, O

 



Show Selection command (Selection menu)
Use this command to reduce the contents of the active window to only those records that are selected. For example, 
if you have four records selected in a collection of 30 records and choose the Show Selection command, ImageAXS 
Pro removes the 26 unselected records from the window, displaying only the four selected records. Note that the 
records are not deleted, but merely are no longer part of your data set.

Shortcuts:
Keyboard: ALT+S, W



Invert Selection command (Selection menu)
Use this command to invert the current selection in the active window (i.e., select all of the records that are not 
currently selected and deselect all of the records that are currently selected). This command is only available from 
the Thumbnails View and the Text List View, when at least one record is selected.

Shortcuts:
Keyboard: ALT+S, I



Clear Selection command (Selection menu)
Use this command to deselect all records in the active window. This command is only available from the 
Thumbnails View and the Text List View, when at least one record is selected.

Shortcuts:
Keyboard: ESC

ALT+S, L



Select All command (Selection menu)
Use this command to select all records in the active window. This command is only available from the Thumbnails 
View and the Text List View.

Shortcuts:
Keyboard: CTRL+A

ALT+S, A



Select All command (Selection menu)
Use this command to select all records in the active window. This command is only available from the Thumbnails 
View and the Text List View.

Shortcuts:
Keyboard: CTRL+A

ALT+S, A



Show All command (Selection menu)
Use this command to display the entire contents of the collection or portfolio you have open. If you have previously 
used the Show Selection command, or used some other technique to reduce the current data set (such as by 
performing a search), this command restores the data set to the entire contents of the collection or portfolio.

Shortcuts:

Toolbar:
Keyboard: ALT+S, A

 



Thumbnails command (View menu)
Use this command to display the current data set in the Thumbnails View. The Thumbnails View provides a visual 
overview of the records in your data set. Each thumbnail in the Thumbnails View shows a small image representing 
the source file referenced by the record, and contains a caption (which you can define) as well as an icon depicting 
the kind of source file referenced by the record (i.e., an image, sound, or movie file).

Shortcuts:

Left Bar:
Toolbar:
Keyboard: ALT+V, N

 



Text List command (View menu)
Use this command to display the current data set in the Text List View. The Text List View displays a columnar list 
of the text information in records. Each row in the Text List View shows one record; each column in the Text List 
View shows one field in the record (for example, one of the text, numeric, date/time, or Boolean fields in the record, 
or one of the file information fields). 
You can select the field that appears in the column by choosing it from the Field pop-up menu. To open the Field 
pop-up menu, click the icon at the right edge of the head of each column. When you choose the field you want, the 
view changes to show the contents of that field for every record in your data set. 
Click this icon to open the Field pop-up menu: 
You can open the Sort dialog box in the Text List View by clicking the sort icon at the left edge of the head of each 
column.
Click this icon to open the Sort dialog box: 
You cannot edit the information in fields in the Text List View; to edit the information in a record you must open the 
record in the Info Sheet View.
Columns can be resized in the Text List View by placing the cursor between two column heads with your mouse. 
When the cursor turns into a column resize tool, click and drag the column divider to your desired width. To return 
the column size to its default, double-click the column head with your right mouse button.

Shortcuts:
Left Bar:

Toolbar:
Keyboard: ALT+V, T

 



Info Sheet command (View menu)
Use this command to open the Info Sheet View. The Info Sheet View contains fields designed to hold information 
about the records in your collection. You can add or edit information about records in the Info Sheet View. 
When you have the Info Sheet View open for multiple records, use the navigation buttons (in the Toolbar) to move 
among records. Note, however, that a record can appear in only a single Info Sheet View window. If you use the 
record navigation buttons in the Toolbar to scroll through records in the Info Sheet View and you display a record 
for which there is already a Info Sheet View window open, ImageAXS Pro closes the inactive Info Sheet View 
window. 
NOTE: You can control how many Info Sheet View windows ImageAXS Pro will open simultaneously using the 
Appearance area of the System Settings dialog box. 
You can also attach keywords to records and add keywords to the Master Keyword List in the Info Sheet View. For 
more information, see the description of the Info Sheet View.

Shortcuts:
Left Bar:

Toolbar:
Keyboard: ALT+V, I
Mouse: Double-click thumbnail caption in Thumbnails View

 



Keywords command (View menu)
Use this command to open the    Keywords View. Keywords are words and phrases used to describe records in your 
collection in terms of their content, method of creation, etc. ImageAXS Pro allows you to build a list of keywords 
and attach them to records in your collection. You can later search for records using keywords as your criteria. The 
Keywords command is available only when you have one or more records selected.When you choose the Keywords 
command, ImageAXS Pro opens the Keywords View. The Keywords View contains controls allowing you to add 
and remove keywords from the Master Keyword List, as well as attach and detach keywords from records. You can 
copy and attach keywords in the Keywords dialog box using the Copy Keywords and Attach Keywords commands 
in the Edit menu. ImageAXS allows you to copy keywords between collections using these commands. 
NOTE: A record can appear in only a single Keywords View window. If you use the record navigation buttons in the
Toolbar to scroll through records in the Keywords View and you display a record for which there is already a 
Keywords View window open, ImageAXS Pro closes the inactive Keywords View window. 
You can also attach keywords to records and add keywords to the Master Keyword List using the Info Sheet View. 
See the description of the Info Sheet View in the Glossary for more information.

Shortcuts:
Left Bar:

Toolbar:
Keyboard: ALT+V, K

 



Source File command (View menu)
Use this command to open the Source File View. The Source File View displays the source file(s) for the currently 
selected record(s); for images ImageAXS Pro shows the file in its own window and the cursor becomes a 
magnifying glass, for audio tracks and movies ImageAXS Pro plays the file using the standard Windows audio and 
movie controls. 
To display the source file for a record, it must be on-line. If the source file is not on-line, ImageAXS Pro displays an 
alert box warning you that the source file cannot be found. For an explanation of how to bring source files back on-
line, see the description for the Update command. 
If the source file you display is an image, an Image Tool Palette appears in the Source File View window. The Image
Tool Palette contains controls allowing you to zoom in, zoom out, scroll, and open the best fit for the source file in 
the Source File View. 
When you have multiple windows displaying source files open simultaneously, you can use the Cascade, Tile Full 
Views, Tile Vertically, and Tile Horizontally commands to arrange the windows on your screen. 
NOTE: You can control how many Source File View windows ImageAXS Pro will open simultaneously using the 
Appearance area of the System Settings dialog box.

Shortcuts:
Left Bar:

Toolbar:
Keyboard: ALT+V, S

 



Slide Show command (View menu)
Use this command to begin a slide show, which displays a series of records in your collection in a dedicated 
window. Using controls in the Behavior area in the System Settings dialog box, you can set the Slide Show to cycle 
the records automatically, pausing on the screen for a duration you specify, or you can set the Slide Show so it is 
controlled manually, allowing you to cycle the records using the Slide Show palette. 
The Slide Show command is only available from the Thumbnails View and the Text List View, when you have a 
selection of records. 
Press ESC to stop the slide show.

Shortcuts:
Keyboard: ALT+V, D



Zoom In command (View menu)
Use this command to zoom in on a source file in the Source File View. This command is only available when an 
image file appears in the active window. The cursor becomes a magnifying glass in the Source File view; when you 
select the Zoom In command, the symbol in the magnifying glass becomes a plus sign (+). Clicking in the Source 
File View window while the cursor is a magnifying glass showing the plus sign zooms in on the image. You can also
use the Zoom In tool in the Image Tool Palette to zoom in on the image in the Source File View. If the Image Tool 
Palette is not visible, the Zoom In tool appears in the Left Bar. 
NOTE: Zooming does not permanently affect the source file.

Shortcuts:
Keyboard: PLUS (+)

ALT+V, Z
Mouse: Click the source file while cursor appears as a magnifying glass 

showing a plus symbol (+)
Image Tool Palette:

Left Bar:

 



Zoom Out command (View menu)
Use this command to zoom out on a source file in the Source File View. This command is only available when an 
image file appears in the active window. The cursor becomes a magnifying glass in the Source File view; when you 
select the Zoom Out command, the symbol in the magnifying glass becomes a minus sign (-). Clicking in the Source
File View window while the cursor is a magnifying glass showing the minus sign zooms out from the image. You 
can also use the Zoom Out tool in the Image Tool Palette to zoom out from the image in the Source File View. If the 
Image Tool Palette is not visible, the Zoom Out tool appears in the Left Bar. 
NOTE: Zooming does not permanently affect the source file.

Shortcuts:
Keyboard: MINUS (-)

ALT+V, O
Mouse: Hold down the CTRL key and click the source file
Image Tool Palette:

Left Bar:

 



Scroll Image command (View menu)
Use this command to change the position of a source file in the Source File View. This command is only available 
when an image file appears in the active window AND the image is larger than the window. The cursor becomes a 
four pointed arrow when you select the Scroll Image command; you can reposition the source file in the window by 
dragging it to a new location. Note that you can also perform this function using the scroll bars in the window (using
the mouse permits greater accuracy, however). You can also use the Scroll Image tool in the Image Tool Palette to 
scroll the image in the Source File View. If the Image Tool Palette is not visible, the Scroll Image tool appears in the 
Left Bar.

Shortcuts:
Keyboard: ALT+V, M

Hold down the Shift key while cursor appears as a Magnifying glass
Image Tool Palette:

Left Bar:

 



Crop Image command (View menu)
This command is available only when the Source File View is active. The Crop Image command allows you to select
part of a source file (that is an image) and copy it to the Clipboard. When you choose Crop Image from the View 
menu, the mouse cursor becomes a crosshair. Position the crosshair cursor at one corner of the area in the Source 
File View that you want to crop and, while holding down the mouse button, drag the mouse diagonally across the 
area you want. When you release the mouse button, ImageAXS Pro copies the area you selected to the clipboard. A 
rectangle remains in the Source File View allowing you to confirm your cropping action captured everything you 
wanted. You can also use the Crop Image tool in the Image Tool Palette to scroll the image in the Source File View. 
If the Image Tool Palette is not visible, the Crop Image tool appears in the Left Bar.

Shortcuts:
Keyboard: ALT+V, R
Image Tool Palette:

Left Bar:

 



Image Rotation 0 Degrees command (View menu, Image Rotation submenu)
This command is available only when the Source File View is active and displaying a source file that is an image. 
Use this command to temporarily rotate an image in the Source File View. Unlike the Orientation commands in the 
Edit menu, the changes you make using the Image Rotation commands in the View menu are not saved after you 
close the Source File View. When you select this command, the source file appears with a rotation of 0 degrees (the 
equivalent of no rotation).

Shortcuts:
Keyboard: ALT+V, G, 0
Image Tool Palette:

 



Image Rotation 90 Degrees command (View menu, Image Rotation submenu)
This command is available only when the Source File View is active and displaying a source file that is an image. 
Use this command to temporarily rotate an image in the Source File View. Unlike the Orientation commands in the 
Edit menu, the changes you make using the Image Rotation commands in the View menu are not saved after you 
close the Source File View. When you select this command, the source file appears with a rotation of 90 degrees (the
equivalent of 90 degrees clockwise rotation).

Shortcuts:
Keyboard: ALT+V, G, 9
Image Tool Palette:

 



Image Rotation 180 Degrees command (View menu, Image Rotation submenu)
This command is available only when the Source File View is active and displaying a source file that is an image. 
Use this command to temporarily rotate an image in the Source File View. Unlike the Orientation commands in the 
Edit menu, the changes you make using the Image Rotation commands in the View menu are not saved after you 
close the Source File View. When you select this command, the source file appears with a rotation of 180 degrees 
(the equivalent of 180 degrees clockwise rotation).

Shortcuts:
Keyboard: ALT+V, G, 1
Image Tool Palette:

 



Image Rotation 270 Degrees command (View menu, Image Rotation submenu)
This command is available only when the Source File View is active and displaying a source file that is an image. 
Use this command to temporarily rotate an image in the Source File View. Unlike the Orientation commands in the 
Edit menu, the changes you make using the Image Rotation commands in the View menu are not saved after you 
close the Source File View. When you select this command, the source file appears with a rotation of 270 degrees 
(the equivalent of 270 degrees clockwise rotation).

Shortcuts:
Keyboard: ALT+V, G, 2
Image Tool Palette:

 



Best Fit command (View menu)
This command automatically scales the Source File View window and the source file it contains so that the source 
file appears in the window at its current size without scroll bars or blank borders between the edges of the image and
the window border. This command is only available from the View menu when an image or movie file appears in the
active window. You can also use the Best Fit tool in the Image Tool Palette to display the image in the Source File 
View at the optimum size. Note that the Best Fit command only works when displaying source files that are images; 
the Best Fit command does not work for movies or sound files.

Shortcuts:
Keyboard: ALT+V, B
Image Tool Palette:

 



View to Image command (View menu)
Use this command to resize the window so that the source file is displayed without cropping (if possible). This 
command is only available from the View menu when an image or movie file appears in the active window.

Shortcuts:
Keyboard: CTRL+R

ALT+V, V



Image to View command (View menu)
Use this command to scale the image in the Source File View to the maximum size that will fit in the window 
without scroll bars. This command is only available from the View menu when an image or movie file appears in the
active window.

Shortcuts:
Keyboard: ALT+V, A



Tile Full Views command (View menu)
When you choose this command, ImageAXS Pro arranges all open Full View windows so they appear without 
overlapping.

Shortcuts:
Keyboard: ALT+V, F



Refresh Volumes command (Tools menu)
Use this command after a volume which contains source files has been mounted or dismounted. After you choose 
the Refresh Volumes command (from the menu or by using a function key), ImageAXS Pro checks the status of the 
source files catalogued in the records in your collection and determines if the status been changed (by going on-line 
or off-line). If the status has changed, ImageAXS Pro changes the Thumbnail icon (shown in the Thumbnails View 
and Text List View) to reflect the source file’s status.

Shortcuts:
Keyboard: F5

ALT+T, R



Toolbar command (Tools menu)

Use this command to display or hide the Toolbar. Hiding the Toolbar prevents you from using the shortcut buttons 
which allow quick access to menu commands, but provides a little more screen space when viewing source files, etc.
NOTE: When the Left Bar is hidden, its buttons appear in the Toolbar.

Shortcuts:
Keyboard: ALT+V, T



Left Bar command (Tools menu)
Use this command to display or hide the Left Bar. Hiding the Left Bar provides a little more screen space when 
viewing source files, etc. 
NOTE: When the Left Bar is hidden, its buttons appear in the Toolbar.

Shortcuts:
Keyboard: ALT+T, L



Status Bar command (Tools menu)

 Use this command to display or hide the Status Bar. Hiding the Status Bar prevents you from seeing information 
about your collection in the bar at the bottom of the screen, but provides a little more screen space when viewing 
source files, etc.

Shortcuts:
Keyboard: ALT+T, A



Image Tool Palette command (Tools menu)
Use this command to display or hide the Image Tool Palette when the Source File View is active. The Image Tool 
Palette contains tools which enhance your ability to view and use source files, allowing you to zoom, rotate, scale, 
and crop the displayed image. A checkmark appears next to the command when the Image Tool Palette is displayed.

Shortcuts:
Keyboard: ALT+T, I



Field Labels command (Tools menu)
Use this command to open the Field Labels dialog box. The Field Labels dialog box contains controls allowing you 
to set the labels for fields; the labels appear next to the fields in the Info Sheet View and at the tops of the columns in
the Text List View. 
Field labels can be up to 254 characters, allowing you to enter highly descriptive text for labeling fields. In the Info 
Sheet View, however, only the first 16 characters appear. In the Text List View, you can resize the width of columns 
to see the entire label and contents of fields. 
You can also specify if you want one or more fields (and their contents) to be hidden from public view. If you 
choose to hide a field (by selecting the Hidden checkbox for the field), it no longer appears in the Text List or Info 
Sheet Views, nor will the field appear when you print from ImageAXS Pro. To see, add, and/or edit the information 
in hidden fields, you must first deselect the Hidden checkbox for the fields in the Field Labels dialog box. 
Specifying a field as hidden also affects whether the field can be used as criteria when searching and sorting records 
in your collection. If you want to be able to use hidden fields as criteria when searching and sorting, you need to 
select the Search and Sort by Hidden Fields checkbox in the Behavior area of the System Settings dialog box. To 
open the System Settings dialog box, choose the System Settings command from the Preferences menu.

Shortcuts:
Keyboard: ALT+T, F



System Settings command (Tools menu)
Use this command to open the System Settings dialog box. The System Settings dialog box contains controls 
allowing you to set how ImageAXS Pro operates. The controls are divided into five areas: 

Appearance This area contains controls allowing you to set the background for ImageAXS Pro windows (dark or 
light gray), whether or not you want the Image Tool Palette to appear, if you want the full path for source files to 
appear in the title bar of the Source File View window, and how many Source File View and Info Sheet View 
windows you want ImageAXS Pro to allow open simultaneously. 

Behavior This area contains controls allowing you to set whether ImageAXS Pro can open several records 
simultaneously, and if you want the program to search and sort using hidden fields as criteria. For more information 
about hidden fields, see the description of the Field Labels command.

Messages This area contains controls allowing you to set the actions for which ImageAXS Pro returns confirmation 
messages to the user. The actions for which ImageAXS Pro can return confirmation messages include changes to 
keywords, changes made to the data file by another user over a network, attempts to open more Source File Views or
Info Sheet Views than specified in the Appearance section of the System Settings dialog box, or attempts to display 
thumbnails at a different size than the size in which they were saved.

Thumbnail Size When you acquire a source file, ImageAXS Pro creates a thumbnail version of the source file for 
display in the Thumbnails, Info Sheet, and Keywords Views. ImageAXS Pro can create and display thumbnails in 
three sizes; small (64 x 64 pixels), medium (96 x 96 pixels), and large (128 x 128 pixels). If you have a large number
(e.g., thousands) of records, you can save disk space by using the smaller thumbnail sizes. You can also set whether 
you want ImageAXS Pro to compress the thumbnails it creates and the compression ratio for thumbnails in the 
Thumbnails Size area. Although ImageAXS Pro allows you to set any compression ratio you want (up to 100%), 
higher compression settings (i.e., greater than 75%) may seriously degrade image quality. 

Data Source ImageAXS Pro is capable of accessing information stored by a number of leading software products, 
including Borland’s dBase and Paradox, Microsoft’s Excel, Access, and FoxPro, FileMaker Pro from Claris, as well 
as many SQL relational database management systems (RDBMS’s) and ASCII text data. The Data Source area 
contains controls allowing you to designate the product from which you are accessing information, as well as enter 
the data configuration string for ImageAXS Pro to use when accessing information.

Shortcuts:
Keyboard: ALT+T, S



PhotoCD Options command (Tools menu)
When you acquire images from a PhotoCD disc, the images on the disc may be stored in different formats 
depending on the original images, the specifications you gave for the scans, etc. The PhotoCD Options dialog box 
(which appears when you choose the PhotoCD Options command) contains controls allowing you to define the 
format of PhotoCD files you acquire.

Shortcuts:
Keyboard: ALT+T, P



Customize Report command (Tools menu)
Using the Customize Report command, you can create and save multiple templates for printing text information 
from the records in your collections. When you choose the Customize Report command, ImageAXS displays the 
Text List Report dialog box, which displays the current default report template and contains controls allowing you to
load alternate reports and customize and save new reports. Text List Report templates are customized using controls 
in the Customize List Report dialog box, which is accessible from the Text List Report dialog box.

NOTE: Text List reports can be printed using the Print command when initiated from the Text List View.

Shortcuts:
Keyboard: ALT+T, U



Arrange Icons command (Window menu)
When you open several Source File View, Keywords View, Portfolio, or Info Sheet View windows, you may find 
that you lack sufficient screen space to display everything simultaneously. To help you organize windows, 
ImageAXS Pro allows you to minimize windows to an icon state which you can reopen as you need. Use this 
command to arrange all program-item icons into rows along the bottom of the main ImageAXS Pro window.

Shortcuts:
Keyboard: ALT+W, A



Close Window command (Window menu)
Use this command to close the currently active window. ImageAXS Pro does not allow you to close the last open 
window for a collection with this command; to close a collection use the Close command in the File menu.

Shortcuts:
Keyboard: ALT+W, W



Tile Vertically command (Window menu)
Use this command to arrange open ImageAXS windows so they appear without overlapping.

Shortcuts:
Keyboard: ALT+W, V



Window List command (Window menu)
A list of all open ImageAXS Pro windows appears here. Click the number or name that corresponds to the window 
you want to activate.

Shortcuts:
Keyboard: ALT+W, (enter the number which corresponds to the window you want)



Index command (Help menu)
When you choose this command, ImageAXS Pro opens the Index for the on-line help system included in the 
program. You can choose to view the introductory message in the Welcome to ImageAXS Pro section, open a list of 
the Menu commands in ImageAXS Pro, or use the Glossary to find the information you want.

Shortcuts:
Keyboard: ALT+H, I



Using Help command (Help menu)
When you choose this command, Windows displays the Windows Help dialog box, in which you can find 
information on how to use the Help system.

Shortcuts:
Keyboard: ALT+H, U



Using Help command (Help menu)
When you choose this command, Windows displays the Windows Help dialog box, in which you can find 
information on how to use the Help system.

Shortcuts:
Keyboard: ALT+H, U



About ImageAXS Pro command (Help menu)
When you choose this command, ImageAXS Pro opens the About ImageAXS Pro dialog box, which contains 
information about the program.

Shortcuts:
Keyboard: ALT+H, A

Icon:

 



Data Source dialog box
This dialog box allows you to select the data source for the new collection. Because ImageAXS Pro is fully 
compliant with the Microsoft Open Data Base Connectivity (ODBC) standard, you can use ImageAXS Pro to access
information from any ODBC compatible database.

Dialog box options:
Data Source

Select the data source for the information from this list. If the data source you want to use doesn’t appear, 
use the scroll bar to navigate the list to it.

Setup
Click this button to set up the connection to the data source.



Create Collection dialog box
This dialog box allows you to name and specify the location of a new collection file.

Dialog box options:
File Name

Type the name for the new collection you are creating in this area.
Save File as Type

Type or select the name of the file type that you want to save the collection as. The default file type is: 
Database Files (*.IAX).

Folders
Select the folder in which you want to save the new collection.

Drives
Select the drive to which you want to save the new collection.



ImageAXS Pro Collection Format dialog box
This dialog allows you to choose the format or type of collection to create.

Dialog box options:
Compact (ImageAXS Pro)

Select this option to create a collection with the following field configuration: eight text fields (up to 128 
characters), two number fields, two date fields, and one long text field (up to 60 KB).

Professional (ImageAXS Pro 1.0)
Select this option to create a collection with the following field configuration: 16 text fields (up to 254 
characters), four number fields, four date fields, and one long text field (up to 60 KB).

ImageAXS 2.x
Select this option to create a collection with the following field configuration: seven text fields (up to 80 
characters), and one long text field (up to 0 KB). Collections of this type have the same field configuration 
as ImageAXS 2.x collections. However, collections created with this option are not ImageAXS 2.x 
collections and cannot be read by versions of ImageAXS Pro earlier than 1.0. To read data from ImageAXS
Pro in previous versions of ImageAXS, use the Export command (in the File menu).

Custom
Select this option to create a collection with a custom (user-defined) field configuration. You can create an 
ImageAXS Pro file with up to 254 fields (240 of which you can modify according to the data you want to 
catalogue), using any field types you want. After you have selected this option, click OK to open the 
Custom Collection Definition dialog box.



Custom Collection Definition dialog box
This dialog box allows you to define the field configuration of your collection. You may create collections with a 
maximum of 254 fields (240 of which you can modify according to the data you want to catalogue). You can also 
save collection definitions you create and use them to create other collections.
NOTE: This dialog box also appears if you select the custom database format when exporting information from 
ImageAXS Pro in custom format.

Dialog box options:
Collection Field

ImageAXS Pro allows you to save collection definitions you create; a list of saved collection definitions 
appears here. If you are creating a new custom collection definition, enter the name for the new definition 
here. If you want to use a previously created definition, select it from the pop-up menu; when you select the
definition, the fields specified in the definition appear in the Fields area (described later in this entry).

Save
After entering the name for the custom collection definition, click Save. ImageAXS Pro saves the custom 
collection definition so you can use it to create other collections.

Delete
If you want to delete a custom collection definition, select the definition you want to delete from the 
Collection pop-up menu and click Delete. ImageAXS Pro removes the custom collection definition from 
your system.

Field Name
This is the internal name of the field. ImageAXS Pro allows you to create labels for the fields using the 
Field Label command in the Preferences menu.

Field Type
This pop-up menu allows you to choose the type for the field you are defining. There are four basic field 
types: 
TEXT
DATETIME
NUMERIC
BOOLEAN

Field Length
The maximum length of the field being configured, e.g., for a text field you may set the maximum length to
254 characters.

Indexed
Click this check box to instruct ImageAXS Pro to index the field being configured. When you set a field to 
be indexed, ImageAXS Pro maintains a table of the values contained in the field in all records. Indexing 
fields allows the search mechanisms in ImageAXS Pro to operate at top efficiency; searches on unindexed 
fields force ImageAXS Pro to look at the full contents of every record in your collection (an inefficient way
to search).

Field List
This list displays the fields you have configured for the current collection. It displays the fields in the order 
in which they were defined.

Add button
This button adds the current field definition to the collection and displays it in the Field List.

Remove button
This button removes the selected field definition from the Field List.

Move Up button
This button reorders the selected field definition upwards in the Field List.

Move Down button
This button reorders the selected field definition downwards in the Field List.

Create
Click this button to create the new collection using the field definitions you entered.

Cancel
Clicking this button closes the Custom Collection Definition dialog box without creating a new collection.





Custom Collection Definition dialog box
This dialog box allows you to define the field configuration of your collection. You may create collections with a 
maximum of 254 fields (240 of which you can modify according to the data you want to catalogue). You can also 
save collection definitions you create and use them to create other collections.
NOTE: This dialog box also appears if you select the custom database format when exporting information from 
ImageAXS Pro in custom format.

Dialog box options:
Collection Field

ImageAXS Pro allows you to save collection definitions you create; a list of saved collection definitions 
appears here. If you are creating a new custom collection definition, enter the name for the new definition 
here. If you want to use a previously created definition, select it from the pop-up menu; when you select the
definition, the fields specified in the definition appear in the Fields area (described later in this entry).

Save
After entering the name for the custom collection definition, click Save. ImageAXS Pro saves the custom 
collection definition so you can use it to create other collections.

Delete
If you want to delete a custom collection definition, select the definition you want to delete from the 
Collection pop-up menu and click Delete. ImageAXS Pro removes the custom collection definition from 
your system.

Field Name
This is the internal name of the field. ImageAXS Pro allows you to create labels for the fields using the 
Field Label command in the Preferences menu.

Field Type
This pop-up menu allows you to choose the type for the field you are defining. There are four basic field 
types: 

TEXT
0 DATE/TIME
1 NUMERIC
2 BOOLEAN

Field Length
The maximum length of the field being configured, e.g., for a text field you may set the maximum length to
254 characters.

Indexed
Click this check box to instruct ImageAXS Pro to index the field being configured. When you set a field to 
be indexed, ImageAXS Pro maintains a table of the values contained in the field in all records. Indexing 
fields allows the search mechanisms in ImageAXS Pro to operate at top efficiency; searches on unindexed 
fields force ImageAXS Pro to look at the full contents of every record in your collection (an inefficient way
to search).

Field List
This list displays the fields you have configured for the current collection. It displays the fields in the order 
in which they were defined.

Add button
This button adds the current field definition to the collection and displays it in the Field List.

Remove button
This button removes the selected field definition from the Field List.

Move Up button
This button reorders the selected field definition upwards in the Field List.

Move Down button
This button reorders the selected field definition downwards in the Field List.

Create
Click this button to create the new collection using the field definitions you entered.

Cancel
Clicking this button closes the Custom Collection Definition dialog box without creating a new collection.





Collection Info window
The Collection Info window allows you to enter a name for your collection and an extensive (up to 32 KB) 
description of its contents. It may be more convenient for you to create your text in a word processing application 
(such as WordPerfect, Microsoft Word, etc.) to take advantages of features such as spell checking, etc., and then 
paste the text into the Collection Info window. The text in the Collection Info window is always “live,” allowing you
to update the window contents as your collection changes.

Window buttons:
OK

Clicking this button saves your changes and closes the Collection Info window.
Cancel

Clicking this button closes the Collection Info window without saving your changes.



Portfolios dialog box
The Portfolios dialog box allows you to create, open, rename, and delete portfolios in the currently open collection. 
For more information about portfolios, see the definition in the Glossary.

Dialog box options:
Portfolio list

This list shows all portfolios in the currently open collection. Select the portfolio that you want to open, 
rename, or delete in this list.

Open
After selecting a portfolio in the Portfolio list, click this button to open the portfolio. The portfolio appears 
in the Thumbnails View.

New
Clicking this button opens the Portfolio Name dialog box. Enter the name for the new portfolio and click 
OK. ImageAXS Pro opens a new window for the portfolio.

Rename
After selecting a portfolio in the Portfolio list, clicking this button opens the Portfolio Name dialog box. 
Enter the new name for the portfolio and click OK.

Delete
After clicking this button ImageAXS Pro opens an alert box warning you that you are about to delete the 
selected portfolio. Click OK to delete the portfolio, otherwise click Cancel.



Create Portfolio dialog box
Use this dialog box to enter the name for your new portfolio. The dialog box also contains a checkbox which, when 
selected, causes ImageAXS Pro to add the currently selected records to the new portfolio.

Dialog box options:
Portfolio Name

Enter the name for the new portfolio here.
Copy Current Selection into Portfolio checkbox

Selecting this checkbox causes ImageAXS Pro to add the currently selected records to the new portfolio 
you are creating.

OK
When you are finished entering the name for your Portfolio (and selecting or deselecting the Copy Current 
Selection into Portfolio checkbox), click OK. ImageAXS Pro creates you new portfolio. The name of your 
new portfolio appears in the Portfolio list of the Portfolios dialog box.

Cancel
Clicking Cancel closes the Create Portfolio dialog box and returns you to the Portfolios dialog box without 
creating a new portfolio.



Rename Portfolio dialog box
This dialog box contains controls allowing you to rename a portfolio. Be sure to select the correct portfolio in the 
Portfolio list of the Portfolios dialog box before trying to rename a portfolio - this action cannot be recovered using 
the Undo command in the Edit menu.

Dialog box options:
Portfolio Name

Enter the name for the new portfolio here.
OK

When you are finished entering the name for your Portfolio, click OK. ImageAXS Pro renames the selected
portfolio and closes the Rename Portfolio dialog box. The new name for the portfolio appears in the 
Portfolio list of the Portfolios dialog box.

Cancel
Clicking Cancel closes the Rename Portfolio dialog box and returns you to the Portfolios dialog box 
without renaming the portfolio.



Map dialog box
The Map dialog box contains controls allowing you to map the fields for your export. The field map consists of the 
fields from which ImageAXS Pro draws the data and the fields to which ImageAXS Pro writes the data.
Items to consider when configuring your export
1. Create a selection of the records that you want to export.

ImageAXS Pro exports whichever records you select in your collection. If you don’t select any records, 
ImageAXS Pro exports the information in all records in your collection (i.e., a selection of none equals a 
selection of all).

2. Make sure you map field types properly.
ImageAXS Pro allows you to mix field types when mapping. Be sure that you do not map data into a field type 
which is incompatible (i.e., attempting to place text data into a date/time field). ImageAXS Pro warns you when
fields are mismatched by placing a red arrow between the fields in the Mapping area of the Map dialog box. If 
the fields are matched properly, a green arrow appears between the fields in the Mapping dialog box.

3. Note which fields you want to export before beginning the configuration process.
If you use the Name Mapping feature in the Map dialog box, you can select which fields you want to export 
(and exclude other fields). While this feature can save time and disk space, there is no provision to see the 
content of the fields you export. While this shouldn’t be a problem if fields have descriptive names (indicating 
the content), collections in which the names are less intuitive can cause difficulty.

Selecting the fields for your export
ImageAXS Pro provides three options when setting up your export:
1. Linear Mapping, which creates a one-to-one correspondence between the fields in the data file you are 

exporting and the format of your export file
2. Name Mapping, which attempts to create a correspondence between the names of fields in the data file you are 

exporting and the format of your export file
3. Individual field mapping, in which you select each field you want in the data file you are exporting and your 

export file individually
If you create collections using standardized formats (e.g., compact, professional, ImageAXS 2.x, or a standardized 
custom format) AND you want to export all the information in the records, it is likely that the Name Mapping or 
Linear Mapping options will be most efficient way to configure your export file. If you want to specify a subset of 
fields to export and/or want to map the fields to specific fields in the export file, use the technique below:
To map the fields for your export:
1. Select a field which contains information you want to export in the Source Fields List.

ImageAXS Pro highlights the field you select.
2. Select the field into which you want to place the exported data in the Destination Fields List.

ImageAXS Pro highlights the field you select.
3. Click Add.

You can complete the process in a single action by double-clicking the target field. When you compete the 
process, ImageAXS Pro places the fields you selected in the Mapping area. If a green arrow appears between 
the fields you select, the data should export successfully. If a red arrow appears between the fields, it is likely 
that the exported data will be unusable.

4. Continue adding fields to the Mapping area using the above techniques until all fields you want are in the 
Mapping area.

5. Click OK.
ImageAXS Pro begins exporting the data you specified. When complete, ImageAXS Pro closes the Map 
window and returns you to the view that was displayed when you began the import.

Dialog box options:
Source Fields

Select the fields which contain the information you want to export from this list. The fields in this list 
correspond with the field structure of the data file from which you are exporting information. When you 
select a field in the list, ImageAXS Pro highlights it.

Destination Fields
Select the fields to receive the information you are exporting in this list. The content of this list changes 
according to the format you selected for your export file (compact, professional, ImageAXS 2.x, or 



Custom. When you select a field in the list, ImageAXS Pro highlights it.
Add

After selecting a source field and a destination field, click Add to add the fields to the list in the Mapping 
area. You can also add fields to the mapping area in a single action by selecting a field and then double-
clicking its companion (i.e., target or source) field.

Mapping area
As you select sets of target and source fields, they appear in the mapping area. ImageAXS Pro displays an 
arrow between the fields when they appear in the Mapping area; a green arrow indicates that the fields are 
matched properly (i.e., are of compatible types, such as text, numeric, date/time, and Boolean), a red arrow 
means that the fields are incompatible types and an attempt to move data between the fields will likely fail. 
You can select fields in the Mapping area by clicking them, hold down the CTRL key to select multiple 
fields. ImageAXS Pro highlights the fields you select.

Linear Map
Clicking the Linear Map button causes ImageAXS Pro to create a one-to-one correspondence between the 
fields in your data file and your target file, based upon the position of the fields in each file. If the field 
structure of your data file and the target file are exactly similar, using the Linear Map function will be the 
most effective way

Name Map
Clicking the Name Map button causes ImageAXS Pro to create a one-to-one correspondence between the 
fields in your source data file and your target file based on the names of the fields in the files. If the fields 
in your source data file and your target file are structured differently but share similar field names, using the
Name Map function can be a very efficient way to structure your export.

Remove
Click Remove to remove pairs of fields from the Mapping area. To remove fields from the mapping area, 
select the field(s) you want (hold down the CTRL key to select multiple fields) and then click remove.

Remove All
Click Remove All to remove all fields from the Mapping area.

OK
Click OK to begin the export. You can monitor the export process in the Status Bar. When the export is 
complete, the Map dialog box closes and you are returned to ImageAXS Pro.



HTML Export Wizard - Presaved Settings dialog box
When creating pages, you will enter information for ImageAXS Pro to use when outputting your finished HTML. 
Much of this information (such as the location on your system you want to save the HTML page, what response you 
want when users click links on the page, and so on) will probably remain constant for each version of a page, and 
also may apply to other web pages you create. ImageAXS Pro allows you to save your page creation settings so you 
can use them again. You can give the settings you save names up to 254 characters long, allowing you to use 
detailed descriptions as names for the settings. Saving settings so you can reuse them later to update a page, or use 
them as a base for another page, is a great way to save time when developing web content.

Dialog box options:
Settings list

The settings you have saved appear in the Settings list. Select a saved setting in the list by clicking it with 
your mouse. You can load a saved setting by double-clicking it in the list.

Load Settings
Click Load Settings after selecting a setting in the list. ImageAXS Pro loads the setting immediately. The 
values stored in the saved settings appear in the following dialog boxes of the HTML Export Wizard.

Run Export
Click Run Export to run a saved export after you have loaded its settings. ImageAXS Pro closes the HTML 
Export Wizard and automatically runs the export.

Remove
Click Remove to delete a selected setting.

Next
Click Next if you do not want to load saved settings (or if you have no saved settings). After you click 
Next, ImageAXS Pro displays the Destination Path dialog box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.



HTML Export Wizard – Destination Path dialog box
Use this dialog box to enter the name and location on your system for the HTML pages ImageAXS Pro creates.

NOTE: Be sure to delete all files in the folder in which you want ImageAXS Pro to place your exported HTML 
pages. If you do not empty the folder before beginning the export process, your results may be unpredictable.

Dialog box options:
Web Server Root or Local Folder

Enter the path for the root folder in which you want ImageAXS Pro to save your exported pages here. This 
could be your web server’s root folder or a folder on your local drive. If you do not want ImageAXS Pro to 
place the HTML page in the root folder of your web server, enter an alternate location here. If you are not 
certain of the exact path you want ImageAXS Pro to use, click the Select Web Root Folder button and use 
the Select Folder dialog box to navigate to the folder you want (normally, this will be a path such as “G:\
inetserv\wwwroot”).

Select Web Root Folder
Click this button to open a Select Folder dialog box, which allows you to navigate to the root folder you 
want ImageAXS Pro to use when creating your HTML page. 

Pages Path Name
In this box, enter the path, relative to your root folder, for the folder in which you want ImageAXS Pro to 
save your exported pages. If you want the pages saved in the root folder you entered, leave this box empty. 
It is recommended that you check this folder on your web server previous to the export. If there are 
extraneous files in the folder, your results may be unpredictable.

Select Pages Path Name
Click this button to open a Select Folder dialog box, which allows you to navigate to the destination folder 
you want ImageAXS Pro to use when creating your HTML page. 

Home Page File Name
Enter the file name for your main web page here. The file name must have no blank spaces and end with 
the extension “.htm” (e.g., “sample.htm”).

Back
Clicking this button returns you to the Presaved Settings dialog box of the HTML Export Wizard.

Next
Click Next after specifying the name and location for your HTML export files. After you click Next, 
ImageAXS Pro displays the Configure Features dialog box.

Cancel
Click this button to exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.

When your export is complete, the URL for your generated pages will be your standard domain name (e.g, 
http//www.yourdomain.com) plus the pages path name (relative to the web root folder) you entered for your 
exported HTML pages (e.g., “/catalog/”), plus the home page file name (e.g., “sample.htm”). In this example, the 
complete URL would be: http//www.yourdomain.com/catalog/sample.htm.



Select Folder dialog box
Use the controls in this dialog box to navigate to the folder in which you want ImageAXS Pro to store the HTML 
pages you export.

NOTE: Be sure to delete all files in the folder in which you want ImageAXS Pro to place your exported HTML 
pages. If you do not empty the folder before beginning the export process, your results may be unpredictable.

Dialog box options:
Folder list

Select the folder you want to use in this area. If the folder you want to use doesn’t appear, use the scroll bar 
and/or click the folders in the area to navigate through the list.

Drives pop-up menu
Select the drive which contains the folder you want to use from this pop-up menu. The content of the 
Folder list changes as you select new drives.

Cancel
Click Cancel to close the Select Folder dialog box (without selecting a destination folder) and return to the 
HTML Export Wizard.

OK
After selecting the folder you want to use, click OK to return to the HTML Export Wizard.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - Configure Features dialog box
Use the controls in the Configure Features dialog box to define what happens when users click the active areas in the
HTML pages ImageAXS Pro creates.

Dialog box options:
None

Selecting None instructs ImageAXS Pro to create only a page of thumbnails with no additional links. This 
option creates a static web page with no interactivity.

Link to Full-Size Image
Selecting this option instructs ImageAXS Pro to create a page in which clicking the thumbnail image in the 
page displays the source file for the record.

Link to Image through Info Sheet
Selecting this option instructs ImageAXS Pro to create a main web page in which clicking the thumbnail 
image in the page displays the information for the record (similar to the Info Sheet View). Info Sheet 
thumbnail images can be clicked to display a Source File Page.

Search Engine
Selecting this checkbox includes keyword search capabilities on your main web page. Using controls in the 
Search Page Configuration dialog box, you can enable any of three keyword search controls in your main 
page.
NOTE: The search engine uses a CGI script and must be configured on a web server. For more information 
about configuring your ImageAXS Pro exports for use on your web server consult your system 
administrator.

e-ZCard Maker selection
Selecting this checkbox includes an option in your HTML page which allows web site visitors to create an 
e-ZCard of records they select. When this checkbox is selected, ImageAXS Pro places a checkbox below 
each thumbnail in your HTML page which users can select to include the data in an e-ZCard. Using 
controls in the e-ZCard Maker Configuration dialog box , you can configure which two data fields will be 
available, the quality and compression of the images, and prepare a cover sheet. For more information 
about how ImageAXS Pro creates e-ZCards from web pages, see the section titled Creating Web Page 
Templates in the on-line help or the manual that came with ImageAXS Pro.
NOTE: The e-ZCard Maker uses a CGI script and must be configured on a web server. For more 
information about configuring your ImageAXS exports for use on your web server consult your system 
administrator.

Back
Clicking this button returns you to the Destination Path dialog box of the HTML Export Wizard.

Next
Click Next after specifying the link actions in your exported HTML page. After you click Next, ImageAXS 
Pro displays the Thumbnail Page Setup dialog box.

Cancel
Exit the HTML Export Wizard without exporting HTML pages.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - Thumbnail Page Setup dialog box
Use the controls in this dialog box to set up your thumbnail page by choosing a template for it and designating its 
grid pattern. ImageAXS Pro features a set of standard templates; however, you can create your own templates if you 
want. For a description of how to create templates for your HTML pages, see the description titled “ Creating Web 
Page Templates” in the on-line help or in the manual which accompanies ImageAXS Pro.

NOTE: Be sure to select a template that corresponds to the type of page you are creating. If you select the wrong 
template (e.g., select an Info Sheet View template for your Thumbnails page), your results will be unpredictable.

Dialog box options:
Template for Thumbnail Page

Enter the name of the template you want to use for your thumbnail page here. ImageAXS Pro comes 
complete with a set of web page templates you can use, or you can create your own. If you are not sure of 
the name of the web page template you want to use, click the Select Thumbnail Page Template button.

Select Thumbnail Page Template
Clicking this button opens the HTML Templates dialog box. The HTML Templates dialog box contains 
controls allowing you to either select the template you want for your graphics page from a list or browse 
the content of your system to find the template you want. For a description of how to create templates for 
your HTML pages, see the description titled “ Creating Web Page Templates” in the on-line help or in the 
manual which accompanies ImageAXS Pro.

Thumbnails per Page
Click the radio button that corresponds to the grid pattern you want for the thumbnails in your thumnail 
page. ImageAXS Pro provides three preset grid patterns for you to use (width by height): 5 x 4, 6 x 5, and 7
x 6. You can also specify a custom grid pattern by selecting the Custom radio button and entering the 
dimensions for the grid.
NOTE: If you choose to use a custom grid pattern, be certain that the target screen size you selected in the 
Screen Configuration dialog box can accommodate the grid (and thumbnail size) you specify.

Custom Width
Enter the width you want for your thumbnail grid pattern. To activate this field, you must select the Custom
radio button in the Thumbnail Table Dimensions area.
NOTE: If you want the custom width to overwrite any suggestions included in the template you have 
chosen, select the Overwrite Template Suggestion (if any) checkbox.

Custom Height
Enter the height you want for your thumbnail grid pattern here. To activate this field, you must select the 
Custom radio button in the Thumbnail Table Dimensions area.
NOTE: If you want the custom height to overwrite any suggestions included in the template you have 
chosen, select the Overwrite Template Suggestion (if any) checkbox.

Overwrite Template Suggestion (if any)
The thumbnail page template you selected may include specifications for how many thumbnails appear on 
the page(s) ImageAXS Pro generates. For example, if you selected ImageAXS Pro’s “Thumbnail list - 7 
fields on left” template, your thumbnail page(s) will automatically appear with four thumbnails (1 x 4). To 
overwrite the template’s specifications, select or enter your preference and click the Overwrite Template 
Suggestion (If Any) checkbox.

Back
Clicking this button returns you to the Configure Features dialog box of the HTML Export Wizard.

Next
Click Next after specifying the thumbnail page template and number of thumbnails per page to use for your
exported HTML pages. After you click Next, ImageAXS Pro displays the Thumbnail Configuration dialog 
box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - Thumbnail Configuration dialog box
The Thumbnail Configuration dialog box contains controls allowing you to specify for your main page the size and 
quality of thumbnails, as well as the field information you want used as a caption for each.

NOTE: Be sure to select a template that corresponds to the type of page you are creating. If you select the wrong 
template (e.g., select an Info Sheet View template for your Thumbnails page), your results will be unpredictable.

Dialog box options:
Thumbnail size (pixels)

Click the radio button that corresponds to the size you want for your thumbnails. Smaller thumbnails load 
faster, but lack the detail of larger thumbnails. ImageAXS Pro provides four choices for thumbnail size (32 
x 32, 64 x 64, 96 x 96, or 128 x 128), or you can specify a custom size for your thumbnails by clicking the 
Custom radio button and entering the width and height you want for your thumbnails.
NOTE: If you choose to use a custom thumbnail size, be certain that the target screen size you select in the 
Screen Configuration dialog box can accommodate the thumbnail size (and grid) you specify.

Custom Width
Enter the width (in pixels) you want for your thumbnails here. To activate this field, you must select the 
Custom radio button in the Thumbnail Size area.

Custom Height
Enter the height (in pixels) you want for your thumbnails here. To activate this field, you must select the 
Custom radio button in the Thumbnail Size area.

Thumbnail Caption field
Select the field which contains the information you want to appear below thumbnails in your Thumbnail 
HTML page.

Thumbnail Quality
Enter the number, from 25 to 100, corresponding to the resolution quality you want for your thumbnails. 
Lower quality thumbnails load faster, but lack the detail of better quality thumbnails.

Back
Clicking this button returns you to the Thumbnail Page Setup dialog box of the HTML Export Wizard.

Next
Click Next after specifying the thumbnail size, caption, and quality. After you click Next, depending on the 
settings you chose in the Configure Features dialog box, ImageAXS Pro displays one of the following 
dialog boxes in the HTML Export Wizard: the Screen Configuration dialog box;the Info Sheet 
Configuration dialog box; the Search Page Configuration dialog box; or the e-ZCard Maker Configuration 
dialog box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - Info Sheet Configuration dialog box
The Info Sheet Configuration dialog box is displayed in the HTML Wizard if you have linked your thumbnail page 
to either or both Info Sheet pages or Full-Image pages using the controls in the Configure Features dialog box. Use 
the controls in the Info Sheet Configuration dialog box to specify templates for your Info Sheet and Full-Image 
pages.

NOTE: Be sure to select a template that corresponds to the type of page you are creating. If you select the wrong 
template (e.g., select an Info Sheet page template for your Full-Image pages), your results will be unpredictable.

Dialog box options:
Info Sheet Template

The name of the currently selected template for your Info Sheet page(s) appears here.
Select Info Sheet Template

Click this button to open the HTML Templates dialog box, which contains a clickable list of all templates 
on your system that have been saved in the Templates folder (in the ImageAXS Pro program folder), have 
an “.HTT” extension, and are applicable as Info Sheet templates. If the template you want does not appear, 
it may not have an “.HTT” extension, an Info Sheet template description tag, or may be elsewhere on your 
system. If this is the case, use the Browse button in the HTML Templates dialog box to select the template 
elsewhere on your system. Select a template by clicking it with your mouse and then clicking OK; when 
you select a template it appears in the Info Sheet Template area. For a description of how to create 
templates for your HTML pages, see the description titled “ Creating Web Page Templates” in the on-line 
help or in the manual which accompanies ImageAXS Pro.

Source Image Template
The name of the currently selected template for your Source Image page(s) appears here.

Select Source Image Template
Click this button to open the HTML Templates dialog box, which contains a clickable list of all templates 
on your system that have been saved in the Templates folder (in the ImageAXS Pro program folder), have 
an “.HTT” extension, and are applicable as Source Image templates. If the template you want does not 
appear, it may not have an “.HTT” extension, a Large Image template description tag, or may be elsewhere 
on your system. If this is the case, use the Browse button in the HTML Templates dialog box to select the 
template elsewhere on your system. Select a template by clicking it with your mouse and then clicking OK;
when you select a template it appears in the Source Image Template area. For a description of how to create
templates for your HTML pages, see the description titled “ Creating Web Page Templates” in the on-line 
help or in the manual which accompanies ImageAXS Pro.

Back
Clicking this button returns you to the Thumbnail Configuration dialog box of the HTML Export Wizard.

Next
Click Next after specifying the Info Sheet and/or Source Image page templates you want to use. After you 
click Next, depending on the settings you chose in the Configure Features dialog box, ImageAXS Pro 
displays one of the following dialog boxes in the HTML Export Wizard: the Screen Configuration dialog 
box; the Search Page Configuration dialog box; or the e-ZCard Maker Configuration dialog box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - Search Page Configuration dialog box
The Search Page Configuration dialog box is displayed in the HTML Wizard if you have selected the Search Engine 
checkbox in the Configure Features dialog box. Use the controls in the Search Page Configuration dialog box to 
specify a template for your Search page and which type(s) of search capabilities you want included in it.

NOTE: The Search page exported by ImageAXS Pro uses a CGI script and must be configured on a web server. For 
more information about configuring your ImageAXS exports for use on your web server,consult your system 
administrator.

Dialog box options:
Search Page Template File

The name of the currently selected Search Page template appears here.
NOTE: ImageAXS Pro includes one default Search Page Template file, named “Search Page with 
description.” If you modify this template or create your own, it is recommended that you include the 
instructions for the use of the keyword search(es) in your template. For a description of how to create 
templates for your HTML pages, see the description titled “ Creating Web Page Templates” in the on-line 
help or in the manual which accompanies ImageAXS Pro.

Select Template File
Click this button to open the HTML Templates dialog box, which contains a clickable list of all templates 
on your system that have been saved in the Templates folder (in the ImageAXS Pro program folder), have 
an “.HTT” extension, and are applicable as Search Page templates. If the template you want does not 
appear, it may not have an “.HTT” extension, a Search template description tag, or may be elsewhere on 
your system. If this is the case, use the Browse button in the HTML Templates dialog box to select the 
template elsewhere on your system. Select a template by clicking it with your mouse and then clicking OK;
when you select a template it appears in the Search Page Template File area. For a description of how to 
create templates for your HTML pages, see the description titled “ Creating Web Page Templates” in the 
on-line help or in the manual which accompanies ImageAXS Pro.

Enable Line Input Control
Select this option to enable users to enter a keyword for which they want to search your collection.
NOTE: You can enable any or all of the three search types available in your HTML export.

Enable Keyword Listbox Control
Select this option to enable users to select a keyword for which they want to search your collection from a 
pop-up list.
NOTE: You can enable any or all of the three search types available in your HTML export.

Enable First Letter Keyword Table
When you select this option, a clickable list of the letters of the alphabet will appear on your search page. 
When users click a letter in the list, a pop-up list of searchable keywords beginning with that letter appears, 
allowing them to select a keyword with which to search your collection.
NOTE: You can enable any or all of the three search types available in your HTML export.

Back
Clicking this button returns you to the Info Sheet Configuration dialog box of the HTML Export Wizard.

Next
Click Next after specifying the Search page templates you want to use. After you click Next, depending on 
the settings you chose in the Configure Features dialog box, ImageAXS Pro displays one of the following 
dialog boxes in the HTML Export Wizard: the Screen Configuration dialog box or the e-ZCard Maker 
Configuration dialog box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - e-ZCard Maker Configuration dialog box
The e-ZCard Maker Configuration dialog box is displayed in the HTML Wizard if you have selected the e-ZCard 
Maker Selection checkbox in the Configure Features dialog box. Use the controls in this dialog box to enter the CGI
Script location on your web server and to select the proper CGI script file extension for your system.

NOTE: The e-ZCard Maker capability in ImageAXS Pro web pages uses a CGI script and must be configured on a 
web server. For more information about configuring your ImageAXS exports for use on your web server,consult 
your system administrator.

Dialog box options:
CGI Script File Extension radio buttons

The e-ZCard Maker capability in ImageAXS Pro web pages uses a CGI script and must be configured on a 
web server. Different web servers require various file name and file extension conventions in the use of 
CGI scripts. Use these radion buttons to designate the file extension required by your web server. Click the 
radio button which corresponds to the correct extension. To enter an alternate name and extension, click the
data entry radio button and enter the file name in the first data entry field and the file extension in the last. 
For information about the correct CGI script extension for use with your web server, consult your system 
administrator.

Default CGI Scripts Location
Enter the path for your web server’s default CGI script location folder (e.g., “Bin”) in this area. You can 
also use the Browse button to locate the folder on your system where CGI scripts are stored. For 
information about your web server’s configuration, consult your system administrator.

Browse
Click this button to open a Select Folder dialog box, with which you can select a default CGI scripts folder 
on your system. When you click OK, the selected folder appears in the Default CGI Scripts Location area.

Back
Clicking this button returns you to either the Info Sheet Configuration dialog box or the Search Page 
Configuration dialog box.

Next
After you click Next, ImageAXS Pro displays the continued e-ZCard Maker Configuration dialog box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - e-ZCard Maker Configuration dialog box (continued)
The e-ZCard Maker Configuration (continued) dialog box is displayed in the HTML Wizard if you have selected the
e-ZCard Maker Selection checkbox in the Configure Features dialog box. Use the controls in this dialog box to 
define the performance and appearance of e-ZCards visitors to your web site create using your HTML pages.

NOTE: The e-ZCard Maker capability in ImageAXS Pro web pages uses a CGI script and must be configured on a 
web server. For more information about configuring your ImageAXS exports for use on your web server,consult 
your system administrator.

Dialog box options:
Configure e-ZCard

Clicking this button displays the Compose e-ZCard dialog box. The Compose e-ZCard dialog box contains 
controls allowing you to define the performance attributes and appearance of e-ZCards visitors to your web 
site create using your HTML pages.

Back
Clicking this button returns you to the preliminary e-ZCard Maker Configuration dialog box.

Next
After you click Next, ImageAXS Pro displays the Large Images Setup dialog box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - Large Images Setup dialog box
All images published on the web must in either JPEG or GIF format. Images which are not in either JPEG or GIF 
format, when exported by ImageAXS for use on the web, are automatically converted to JPEG format. Using 
controls in the Large Images Setup dialog box, you can set the image quality for the JPEG images used in your 
exported web pages. Lower quality images load faster, but lack the detail of better quality images.

NOTE: JPEG conversion during ImageAXS Pro HTML exports does not affect the original source files.

Dialog box options:
Image Quality

Enter the number, from 25 (poorer quality) to 100 (higher quality), corresponding to the resolution quality 
you want for your thumbnails. Lower quality thumbnails load faster, but lack the detail of better quality 
thumbnails.

Recompress JPEG Files
Images exported from ImageAXS Pro which are already in JPEG format are not converted. To maintain 
desired file size, you can choose to recompress existing JPEG images during the HTML export using the 
image quality setting you have entered. Select this checkbox if you want existing JPEG images 
recompressed.

Recompress GIF Files
Images exported from ImageAXS Pro which are already in GIF format are not converted. To maintain 
desired file size, you can recompress existing JPEG images during the HTML export using the image 
quality setting you have entered. Select this checkbox if you want existing JPEG images recompressed.

Back
Clicking this button returns you to the Screen Configuration dialog box.

Next
After you click Next, ImageAXS Pro displays the Finish! dialog box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Wizard - Screen Configuration dialog box
The Screen Configuration dialog box allows you to configure the size (in pixels) of your exported HTML pages so 
they will appear best for your target audience. For example, if you are developing pages for the World Wide Web, 
you will probably want to make your pages 640 x 480 pixels (the dimensions of a 13" monitor, the most commonly 
used size). If you are creating pages for an intranet, however, (such as for a company), use a size that is common 
among your users.

Dialog box options:
Screen Size Radio buttons

Select the screen size radio button that corresponds to the screens used by your target audience. If you are 
planning to publish your page on the World Wide Web, you will probably want to use the 640x480 option. 
To create custom size web pages, click the Custom radio button; the Custom Media Dimensions areas will 
activate.

Custom Media Dimensions (Width, Height)
Enter the width and height (in pixels) of the screen size for which you want to format your web pages. To 
activate this area you must click the Custom radio button in the Screen Size area.

Back
Clicking this button returns you to the previous dialog box in the HTML Export Wizard.

Next
Click Next after specifying the target screen size for your exported HTML pages. After you click Next, 
ImageAXS Pro displays the Large Images Setup dialog box.

Cancel
Exit the HTML Export Wizard without exporting an HTML page.

Help
Click this button to display the help topic for the current dialog box.



HTML Export Finish! dialog box
The Finish! dialog box contains controls allowing you to save the settings you entered to create your HTML page 
(so you can use them again; refer to the description of the Load Settings dialog box for more information), as well as
a checkbox which directs ImageAXS Pro to open your page using your Internet browser software.

Dialog box options:
Launch Browser on Generated Pages

If you select this checkbox, once the export procedure is complete, ImageAXS Pro launches the Internet 
browser software you have loaded on your system and opens the HTML page created from your export. All 
links in the HTML page you create are active, so you can check the appearance of all generated pages 
(including Search, Info Sheet, and Full-Image pages).
NOTE: Search pages and e-ZCard capabilities depend on CGI scripts and must be stored and configured on
a web server to be used. When ImageAXS Pro launches your browser, it points at the page as a file on your 
system. You will need to navigate to the actual URL to view your pages with search and e-Zcard 
capabilities enabled.

Name and Save Settings
Type the name (up to 254 characters) you want to save your settings under in this box. Click the box’s right 
arrow to open a list of previously saved settings, from which you can select a name to edit and save (this 
can be particularly useful if you are saving settings under a long descriptive name).

Save Settings
Click this button to save your settings once you have entered a name for them. ImageAXS Pro defaults to 
saving the settings in the Templates folder in the folder in which you installed ImageAXS Pro.

Back
Click Back to return to the Large Images Setup dialog box.

Finish
When you click Finish, the HTML Export Wizard closes and ImageAXS Pro begins exporting the records 
you selected into the HTML pages you requested. ImageAXS Pro displays a progress bar at the bottom of 
the application window, allowing you to track the export process. If you selected the Launch Browser on 
Generated Page checkbox, when the export is complete ImageAXS Pro launches the Internet browser on 
your system and displays the exported page in it. If you did not select this checkbox, ImageAXS Pro returns
you to the view that was open when you began the export procedure.

Cancel
Clicking Cancel closes the HTML Export Wizard and returns you to ImageAXS Pro without exporting any 
information.

Help
Click this button to display the help topic for the current dialog box.



Compose e-ZCard dialog box
The Compose e-ZCard dialog box contains controls allowing you to define an e-ZCard of images from your data file
which you can distribute.

Dialog box options:
Horizontal Caption

Choose a field from the pop-up menu to appear as the horizontal caption below images in your e-ZCard. 
Note that the area below the image holds approximately ten characters; be certain that the field you specify 
contains information that will fit in this space. The contents of the field you select appears in the Horizontal
Caption column, allowing you to check the length of the information before creating your e-ZCard.

Vertical Caption
Choose a field from the pop-up menu to appear as the horizontal caption below images in your e-ZCard. 
Note that the area below the image holds approximately twelve characters; be certain that the field you 
specify contains information that will fit in this space. The contents of the field you select appears in the 
Vertical Caption column, allowing you to check the length of the information before creating your e-ZCard.

File Name
The records you specified for your export appear in this list. The field you specified to appear as the 
thumbnail label in the Field Labels dialog box is used as the name for each record.

Target Resolution
The radio buttons in the Target Resolution area allow you to specify the type of monitor on which you 
expect your e-ZCard to be displayed. Selecting a higher resolution increases the file size of your e-ZCard. 
For more information about monitor resolutions, consult the documentation that came with your monitor or 
the monitor manufacturer (as a rule, 640 x 480, the size of 13” monitors, works in most circumstances).

Target Media Size
The size of your target media appears here. ImageAXS Pro can adjust the size of your exported e-ZCard to 
match your target media; for more information, see the sections covering the Customize and Fit to Media 
buttons later in this description. The target media size is shown in kilobytes.

Estimated File Size
After you have configured your e-ZCard (by selecting the records you want to export, the target media size,
etc.) you can see the estimated size of your output by clicking the Estimate button (described later). This 
function is useful if you want to add more records, or if you need to remove records to fit the e-ZCard 
output onto a specific type of media. ImageAXS Pro can adjust the size of your exported e-ZCard to match 
your target media; for more information, see the sections covering the Customize and Fit to Media buttons 
later in this description. The estimated file size is shown in kilobytes.

e-ZCard File Name
Enter the name you want for your e-ZCard here(the filename is all that is necessary - ImageAXS Pro will 
add the default “.ex” extension for Windows to recognize it as an executable file). Note that if you plan for 
users to view your e-ZCard on Windows 3.1 systems, you should limit your filename to eight characters. 
The default location for saving your e-ZCard is the folder in which you installed ImageAXS Pro; if you 
want to change the location to which your e-ZCard is saved, use the Browse button (described later).

Title String
The title string appears at the upper left corner of the e-ZCard viewing window and can be used to display 
copyright information, a title for the e-ZCard, etc. The title string display area is limited to approximately 
30 characters on a 640 x 480 screen; you may want to adjust the length of the text accordingly.

Edit Front Page
e-ZCards you create contain an Info Page, in which you can place up to 64 KB of text describing the 
contents of your e-ZCard. This Info Page appears during the e-ZCard program startup process and when 
users click the Info button at the lower left corner of the e-ZCard window. When you click this button, 
ImageAXS Pro displays the Edit e-ZCard Text dialog box, which contains controls allowing you to modify 
the content and appearance of the Info Page for the e-ZCard.

Fit to Media
Clicking this button instructs ImageAXS Pro to scale the images in the e-ZCard to fit in the media 
displayed in the Target Media Size area. This action is useful if the data size of the images included in your 
e-ZCard are slightly larger than your target media. Please note that significantly altering the size of images 



(i.e., by more than 25%) can affect the image quality. ImageAXS Pro allows you to choose the media on 
which you want to place your e-ZCard; for more information see the section on the Customize button later 
in this description.

Customize
Click this button if you want to change the size of the media on which you want to distribute your e-ZCard. 
When you click this button ImageAXS Pro opens the Destination Media dialog box, which contains 
controls allowing you to specify the size and capacity of your target media. ImageAXS Pro also allows you 
to adjust the size of your e-ZCard to match your target media; for more information see the section 
covering the Fit to Media button earlier in this description.

Estimate
When you click this button, ImageAXS Pro estimates the size of your final e-ZCard. This feature is useful 
if you are designing an e-ZCard to be distributed on a specific type of media, giving you feedback as you 
adjust the number and size of files. ImageAXS Pro displays the result in the Estimated File Size area; the 
results are displayed in kilobytes.

Browse
Clicking the Browse button opens the Save As dialog box, which contains controls allowing you to 
designate the drive and/or folder in which you want to save your e-ZCard output. After you use the controls
in the Save As dialog box to enter the location and/or name for your e-ZCard, information you enter 
(including the pathname) appears in the e-ZCard file name area (described earlier).

Settings
Clicking the Settings button opens the e-ZCard Settings dialog box, which contains controls allowing you 
to configure the appearance of your e-ZCard, including the appearance of images and controls, the number 
of thumbnails that appear, and so on.

Create
After entering all settings for creating your e-ZCard, clicking Create begins the process of exporting the 
information for your e-ZCard. When the process is complete, ImageAXS Pro closes the Compose e-ZCard 
dialog box and returns you to the previously open view in ImageAXS Pro.

Close
Clicking this button closes the Compose e-ZCard dialog box and returns you to the previously open view in
ImageAXS Pro without creating an e-ZCard.



Destination Media dialog box
The Destination Media dialog box contains controls allowing you to specify the size of the media which you want to
use to distribute your e-ZCard. When you specify the media size, ImageAXS Pro automatically scales your e-ZCard 
output to optimize it, giving you the best quality images for the media you select.

Dialog box options:
Media

Select the radio button that corresponds to the media you want to use here; your choices are outlined in the 
following table:
Default drive Create an e-ZCard without optimizing the data size (images in the e-ZCard will 

not be scaled)
3-inch floppy Create an e-ZCard that will fit on a 1.44 MB, 3.5 inch floppy disk
5-inch floppy Create an e-ZCard that will fit on a 1.2 MB, 5.25 inch floppy disk
Custom size When you select this radio button, the Custom Size field activates, allowing you

to enter a custom size for your e-ZCard. ImageAXS Pro will scale the size of 
the images in your e-ZCard to optimizing them for the size of e-ZCard you 
specify. Note that if the size you enter is larger than that of your source files 
(and the e-ZCard Player program, et al), ImageAXS Pro will NOT increase the 
size of your image files.

Custom Size
This area activates when you click the Custom radio button in the Media area. Enter the size of the media (in 
kilobytes) you want to use to distribute your e-ZCard here.

OK
After setting the size of your destination media, click OK. ImageAXS Pro closes the Destination Media dialog 
box and returns you to the Compose e-ZCard dialog box.

Cancel
Click Cancel to close the Destination Media dialog box without defining a destination media size and return to 
the Compose e-ZCard dialog box.



Edit e-ZCard Text dialog box
e-ZCards you create contain an Info Page, in which you can place up to 32 KB of text describing the contents of 
your e-ZCard. The Info Page appears during the e-ZCard program startup process and when users click the Info 
button at the lower left corner of the e-ZCard window. The EDIT e-ZCard Text dialog box contains controls 
allowing you to enter and edit the text in the Info Page, as well as set the colors for the text and background of the 
Info Page.

Dialog box options:
Text entry area (designated with the default text “e-ZCard Info Page” when the dialog box first appears)

Enter the text you want in the Info Page here. You may want to create the text you want to appear in the Info 
Page using a word processor application (such as WordPerfect or Microsoft Word, so you can take advantage of 
spelling checkers, etc.) and then paste the text into the Text entry area.

Choose Font
Clicking this button opens the Font dialog box, which contains controls that allow you to set the appearance of 
the text in the Info Page.

Background Color
Clicking this button opens the Color dialog box, which contains controls that allow you to specify the color used
for the background of your Info Page.

OK
Clicking this button saves your changes to the Info Page, closes the Edit e-ZCard Text dialog box, and returns 
you to the Compose e-ZCard dialog box.

Cancel
Clicking this button closes the Edit e-ZCard Text dialog box and returns you to the Compose e-ZCard dialog 
box without saving your changes.



Font dialog box
The Font dialog box contains controls allowing you to set the appearance of the text in the Info Page for your e-
ZCard.

Dialog box options:
Font

A scrolling list of the fonts installed on your system appears in this area. Set the font for your Info Page text by 
clicking it in the list. When you select the font for the Info Page text, a short piece of text in the Sample area 
allows you to see the results of your change.

Font Style
Select the style (bold, italic, etc.) for your Info Page text here. When you select the style for the Info Page text, 
a short piece of text in the Sample area allows you to see the results of your change.

Size
Select the size for your Info Page text (in points) here. When you select the size for the Info Page text, a short 
piece of text in the Sample area allows you to see the results of your change.

Effects
Specify the effects (strikethrough, underline) for your Info Page text here. When you specify the effects for the 
Info Page text, a short piece of text in the Sample area allows you to see the results of your change.

Color
Select the color for your Info Page text from the pop-up menu that appears here. Note that ImageAXS Pro also 
allows you to specify the color of the background in the Info Page using the Background Color button in the 
Edit e-ZCard Text dialog box; be sure that the color you select for your text complements the background color. 
If you specify the same color for your text as the background color, the text will be invisible in the Info Page 
dialog box. When you specify the color for the Info Page text, a short piece of text in the Sample area allows 
you to see the results of your change.

Sample
Changes you make to the appearance of the font are reflected here, allowing you to check the results of your 
settings.

OK
Clicking OK closes the Font dialog box and returns you to the Edit e-ZCard Text dialog box. Any changes you 
made to the appearance of the Info Page text are reflected in the Edit e-ZCard Text dialog box.

Cancel
Clicking Cancel closes the Font dialog box and returns you to the Edit e-ZCard Text dialog box without saving 
your changes.



Color dialog box
The Color dialog box contains controls allowing you to specify the background color for the Info Page dialog box. 
Note that the background color you select should be complementary with the color you select for your text in the 
Font dialog box. If you select the same color for your background and your text, your text will be invisible in your 
Info Page.

Dialog box options:
Basic Colors

This area displays the standard colors offered by the operating system. Click a color in this area to select if for 
the background of the Info Page; the color you select appears in the Color/Solid area (described later in this 
entry).

Custom Colors
If you have defined custom colors (described later in this entry), the colors you defined appear here. Click a 
color in this area to select if for the background of the Info Page; the color you select appears in the Color/Solid 
area (described later).

Color area
This rainbow-colored area allows you to specify a color using your mouse. When you click the mouse in the 
Color area, the color located where you clicked appears in the Color/Solid area (described later in this entry). 

Luminosity bar
The Luminosity bar (which appears to the right of the Color area, described previously), displays the degree of 
brilliance of the color (i.e., the greater the degree of luminosity, the closer to white or brighter the color 
becomes; the lesser the luminosity, the closer to black or darker the color becomes). The small triangle 
positioned at the right of the Luminosity bar shows the degree of luminosity for the current color; you can also 
control the degree of luminosity by using the triangle as a slider or by entering a number in the Lum field 
(described later).

Color/Solid
The current color you have selected for the background of the Info Page appears here. Changes to the current 
color appear in this area, allowing you to see the results of your settings. 

Hue
The value in this field reflects the actual color (i.e., red, green, blue) that characterizes the background color. 
Changing the value of this field has the effect of moving horizontally across the Color area; a value of zero (0) 
is at the extreme left of the Color area, a value of 239 is at the extreme right of the Color area. Changes to the 
current color appear in the Color/Solid area (described earlier), allowing you to see the results of your settings.

Sat (Saturation)
The value in this field reflects the density of the background color. Changing the value in this field has the effect
of moving vertically (up and down) through the Color area; a value of zero (0) is at the bottom of the color area 
and returns a dark gray or black color, a value of 240 is at the top of the Color area and returns a rich, “fully 
saturated” color. Changes to the current color appear in the Color/Solid area (described earlier), allowing you to 
see the results of your settings.

Lum (Luminosity)
The value in this field reflects the degree of brilliance of the of the color (i.e., the greater the degree of 
luminosity, the closer to white or brighter the color becomes; the lesser the luminosity, the closer to black or 
darker the color becomes). A value of zero (0) returns black (no luminosity); a value of 240 returns white 
(maximum luminosity). You can also control the luminosity setting using the Luminosity bar at the right of the 
Color area (described earlier). Changes to the current color appear in the Color/Solid area (described earlier), 
allowing you to see the results of your settings.

Red
The value in this field reflects the intensity of red of the color. A value of zero (0) means the color has no red 
component, a value of 254 means the color has a maximum amount of red. Changes to the current color appear 
in the Color/Solid area (described earlier), allowing you to see the results of your settings.

Green
The value in this field reflects the intensity of green of the color. A value of zero (0) means the color has no red 
component, a value of 254 means the color has a maximum amount of green. Changes to the current color 



appear in the Color/Solid area (described earlier), allowing you to see the results of your settings.
Blue

The value in this field reflects the intensity of blue of the color. A value of zero (0) means the color has no red 
component, a value of 254 means the color has a maximum amount of blue. Changes to the current color appear
in the Color/Solid area (described earlier), allowing you to see the results of your settings.

Define Custom Colors
This button is disabled in the current version of ImageAXS Pro.

Add to Custom Colors
After defining a color, you can save it (so you can use it again) by clicking the Add to Custom Colors button. 
After you click the Add to Custom Colors button, the color appears in the Custom Colors area (described 
earlier).

OK
After selecting a color, click OK to close the Color dialog box and return to the Edit e-ZCard Text dialog box. 
The color you selected appears as the background color in the Edit e-ZCard Text dialog box.

Cancel
Clicking this button closes the Color dialog box and returns you to the Edit e-ZCard Text dialog box without 
saving your changes.



e-ZCard Settings dialog box
The e-ZCard Settings dialog box contains controls for optimizing the appearance of the images in your e-ZCard, 
allowing you to achieve a precise balance between image compression and display quality.

Dialog box options:
Full Image Size

The controls in this area allow you to scale the full image stored in your e-ZCard - this can be helpful if you 
need to reduce your e-ZCard’s data size. You can modify the scale of the image along the vertical or horizontal 
axis using either the scroll bars or by typing the size you want for the axis (in pixels). You can reduce an image 
axis down to 50% of its original size; ImageAXS Pro automatically scales the entire image to maintain its 
perspective. The results of your scaling appears in the display area, allowing you to check the results of your 
action.
0 NOTE: The display area represents the shape of the monitor you specified in the Target Resolution area of 
the Compose e-ZCard dialog box. If the image does not fill the display area, the full image in the e-ZCard will 
not fill the monitor screen. Also, if you have selected the Apply Sharpening and Compression to Full Image 
Preview checkbox (described later in this entry), the thumbnail in this area reflects how the changes you make 
using the Sharpening and Compression controls (described later) will affect the appearance of the full size 
image in the e-ZCard. The changes you make to the full size image also affect the appearance of the thumbnails 
and preview in the e-ZCard, as they are generated “on-the-fly” from the full image by the e-ZCard player.

Sharpening Threshold
If you need to significantly reduce the size of the images in your e-ZCard (through compression, scaling, etc.), 
you can improve the quality of the images by increasing the sharpening. The higher the number you enter in the 
sharpening field, the more defined the edges of the image become; with lower values the edges of the image 
become less distinct. The value you enter can range from 1 to 254; change the value by using the scroll bar or 
by typing a value directly into the sharpening field. The changes you make to the sharpening setting are 
reflected in the thumbnail in the Sharpening Threshold area (and in the thumbnail in the Full Image Size area if 
you have selected the Apply Sharpening and Compression to Full Image Preview checkbox - described later) as 
you make them.

Compression/Quality
This control allows you to specify the exact degree of compression you want ImageAXS Pro to use on the 
images in your e-ZCard. The lower the number you enter in the compression field the more compressed the file 
becomes; image quality decreases as you lower the number. The value you enter can range from 1 to 100; 
change the value by using the scroll bar or by typing a value directly into the compression field. The changes 
you make in the compression field are reflected in the thumbnail in the Compression/Quality area (and in the 
thumbnail in the Full Image Size area if you have selected the Apply Sharpening and Compression to Full 
Image Preview checkbox - described later) as you make them.

Apply Sharpening and Compression to Full Image Preview
To make monitoring changes you make to the appearance of the images that appear in your e-ZCard more 
convenient, you can select this checkbox and all changes you make to the sharpening and compression settings 
will be reflected in the Full Image Size thumbnail.

Enable 3-D Thumbpads
Selecting this checkbox changes the appearance of the thumbnails in the main e-ZCard layout so they have a 
three dimensional appearance.

Decompress All Images at Once
Selecting this checkbox sets the e-ZCard player to decompress all images in the e-ZCard during its startup. 
When selected, this option causes the startup period of the e-ZCard to take slightly longer, but full size images 
appear on the screen more quickly. It is recommended that you select this option if you plan to play or distribute
your e-ZCard using floppy disks.

Use Grayscale-Rich Palette for 256 Colors
If you are making an e-ZCard using grayscale (i.e., monochrome or black and white) images and expect that it 
will be displayed on 256-color (8-bit) systems, select this checkbox. Selecting this optimizes the appearance of 
your images, using a custom gray palette rather than the limited system palette at that setting.

Number of Thumbnails per Page



ImageAXS Pro allows you to specify the number of thumbnails you want to appear on the main e-ZCard layout;
you can choose from the following settings (numbers in parentheses indicate the grid pattern): 4 (2 x 2), 6 (2 x 
3), 8 (2 x 4), 9 (3 x 3), 12 (3 x 4), 15 (3 x 5), 16 (4 x 4). The size of the thumbnails decreases as you increase the
number of thumbnails that appear on the layout.

Default
Clicking the Default button returns the settings in the e-ZCard Settings dialog box to their default values.

OK
After making all of your changes, click OK to save your settings, close the e-ZCard Settings dialog box, and 
return to the Compose e-ZCard dialog box.

Cancel
Click Cancel to close the e-ZCard Settings dialog box and return to the Compose e-ZCard dialog box without 
saving your changes.



Print dialog box
The Print dialog box allows you to specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Dialog box options:
Printer

This is the active printer and printer connection.
Setup

Displays the Print Setup dialog box, which allows you to select a printer and printer connection.
Print Range

Specify the pages you want to print:
All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the page range you specify.

Collate Copies
Prints copies in page number order, instead of separate, multiple copies of each page.

Print Quality
Select the quality of the printing. Generally, lower quality printing takes less time to print.



Page Setup dialog box
This dialog box allows you to configure the way the active view is printed. The dialog box is divided into two 
sections. The Thumbnails View controls are activated when you print from the Thumbnails View and the Text List 
View controls are activated when you print from the Text List View. ImageAXS retains your settings until you 
change them again.

NOTE: Format and page range settings can also be made using controls in the Printing Multiple Records dialog box,
which is displayed by default (unless otherwise specified) when you select the Print or Print Preview commands.

Dialog box options:
Grid Layout

This option allows you specify the number of thumbnails to print vertically and horizontally on a page when 
printing thumbnail images from the Thumbnails View. ImageAXS scales the thumbnail images to fit the 
grid/page.

Thumbnails View Format radio buttons
Use these buttons to specify the format you want records printed in when printed from an active Thumbnails 
View window. Select the Thumbnails radio button if you want records printed as thumbnail images with label 
text. Select the Info Sheet radio button if you want records printed as Info Sheet pages.

Range radio buttons
Use these buttons to specify the range of records that you want printed. Select the Selection Only radio button to
print only selected records. Select the Entire Collection radio button to print the entire collection.

Ask Me Every Time checkbox
Select this checkbox if you want the Printing Multiple Records dialog box displayed each time you select the 
Print or Print Preview commands while the Thumbnails View is active. If this checkbox is deselected, the 
Printing Multiple Records dialog box will not be displayed.

Text List View Format radio buttons
Use these buttons to specify the format you want records printed in when printed from an active Text List View 
window. Select the Text List radio button if you want record information printed as a text list. Select the Info 
Sheet radio button if you want records printed as Info Sheet pages.

Range radio buttons
Use these buttons to specify the range of records that you want printed. Select the Selection Only radio button to
print only selected records. Select the Entire Collection radio button to print the entire collection.

Ask Me Every Time checkbox
Select this checkbox if you want the Printing Multiple Records dialog box displayed each time you select the 
Print or Print Preview commands while the Text List View is active. If this checkbox is deselected, the Printing 
Multiple Records dialog box will not be displayed.

Cancel
Click this button to close the Page Setup dialog box without saving your changes.

OK
Click this button to close the Page Setup dialog box and save your changes.



Printing Multiple Records dialog box
Activated when you choose the Print or Print Preview commands, this dialog box allows you to configure the way 
the active view is printed. Its contents are dependent on which view is active when you choose the Print or Print 
Preview command. The controls in the Printing Multiple records dialog box are identical to the Format and Range 
controls found in the Page Setup dialog box.

NOTE: The Printing Multiple Records dialog box is not displayed if the Ask Me Every Time checkbox is deselected 
for the active view in the Page Setup dialog box or if you selected the Do Not Ask Me Again checkbox when the 
Printing Multiple Records dialog box was previously displayed.

NOTE: Format and page range settings can also be made using controls in the Page Setup dialog box.

Dialog box options:
Format radio buttons

If the Thumbnails View was active when you chose the Print or Print Preview command, you can choose to 
print either thumbnail images with label text or Info Sheet formatted pages. If the Text List View was active 
when you chose the Print or Print Preview command, you can choose to print either Text List formatted record 
information or Info Sheet formatted pages.

Range radio buttons
Use these buttons to specify the range of records that you want printed. Select the Selection Only radio button to
print only selected records. Select the Entire Collection radio button to print the entire collection.

Do Not Ask Me Again checkbox
Select this checkbox if you do not want the Printing Multiple Records dialog box displayed each time you select
the Print or Print Preview commands for the active view type. If this checkbox is deselected, the Printing 
Multiple Records dialog box will automatically be displayed. The Printing Multiple Records dialog box can be 
reactivated using the controls in the Page Setup dialog box.

OK
Click this button to close the Printing Multiple Records dialog box and save your changes. The Print dialog box 
is displayed.

Cancel
Click this button to close the Printing Multiple Records dialog box without saving your changes. The Print or 
Print Preview command is aborted.



Print Setup dialog box
The Print Setup dialog box allows you to select the destination printer and its connection.

Dialog box options:
Printer

Select the printer you want to use. Choose the Default Printer or choose the Specific Printer option and select 
one of the current installed printers shown in the box. You can install printers and configure ports using the 
Windows Add Printers control panel.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper for the document.

Paper Source
Some printers offer multiple trays for different paper sources; specify the tray here.

Options
Displays a dialog box that allows you choose to different printer settings. These options are specific to the type 
of printer you have selected.

Network…
Choose this button to connect to a network printer.



Acquire Files dialog box
This dialog allows you to acquire new source files into your collection. The Acquire Files dialog box contains 
controls allowing you to build a list of source files from various locations around your system and acquire them into 
your data file as a single batch.
For a list of the file types ImageAXS Pro can accept, see the entry for File types in the Glossary.

Dialog box options:
Acquire In

Select the volume and/or folder in which the file(s) you want to acquire are located. The button showing a 
folder with an arrow on it moves you up one folder level when you click it. 

List/Icon View buttons
These buttons allow you to toggle the display in the file selection area between list (columnar text) and icon
(graphic representation of the files according to their type) views.

Show Preview checkbox
When this checkbox is selected, ImageAXS Pro displays a preview of selected files in the Preview display 
area. This feature allows you to visually inspect the file before acquiring it. If the file you are acquiring is a 
movie, the movie plays in the preview area if the Show Preview checkbox is selected.

File Name
Select the files you want to acquire using this control. You can either type the file name (and path, if 
necessary) of the source file you want to acquire in the File Name area, or use the file navigation controls 
above the File Name entry area to select the source file(s) you want. Hold down the Shift key to select 
multiple, contiguous files; hold down the CTRL key to make a random selection. If you have selected the 
Preview checkbox, a preview of the file you select appears in the Preview display area (except when 
making multiple selections using the Shift or CTRL keys).

List Files of Type
Use this pop-up menu to select the type of files that you want to appear in the File Name list. The default 
file type is Image Files, which includes all files that ImageAXS Pro can accept (for a list of the file types 
ImageAXS Pro can accept, see the entry for File types in the Glossary). You can select All Files in the List 
Files of Type pop-up menu; this option, however, also displays file types that cannot be acquired by 
ImageAXS Pro.

Acquire Log
Each file you select to acquire appears in this log area. By providing this log to hold the files you select to 
acquire, ImageAXS Pro allows you to locate and select files from many different locations on your system 
and acquire them into your data file as a batch. 

Add
Adds the file(s) you have selected in the File Name field to the Acquire Log. You can also add files to the 
Acquire Log in a single step by double-clicking them in the File Name area.

Remove
Removes selected file(s) from the Acquire Log. If, for example, you want to acquire all files in a folder 
except for three or four, you can use the Add All button to place all the files in the folder in the Acquire Log
in a single step, and then remove the files you don’t want by selecting them and clicking the Remove button

Add All
Adds all of the image files in the folder you have selected to the Acquire Log.

Remove All
Removes all of the source files from the Acquire Log.

OK
Acquires all of the files listed in the Acquire Log into the open collection. A thumbnail appears in the 
collection window as ImageAXS Pro acquires each file.
NOTE: If you are acquiring a movie file, ImageAXS Pro displays the Select Thumbnail dialog box when 
acquiring the file. The controls in the Select Thumbnail dialog box work identically to all other movie 
player dialog boxes, with the exception that when you click the OK button, ImageAXS Pro grabs the 
displayed frame and uses it as the thumbnail for the file in your collection. For instructions on how to 
acquire a thumbnail for a movie file, see the description of the Select Thumbnail dialog box.

Cancel



Cancels out of the operation and closes the Acquire Files dialog box.



Acquire Log
A list of the source files ImageAXS Pro will acquire appears here. To add a source file to this list, navigate to the file
you want, select it and click Add. To remove a file from the Acquire Log select it in the list and click Remove. You 
can also clear the entire Acquire Log by clicking Remove All.



Acquire Files dialog box
This dialog allows you to acquire new source files into your collection. The Acquire Files dialog box contains 
controls allowing you to build a list of source files from various locations around your system and acquire them into 
your data file as a single batch.
0 For a list of the file types ImageAXS Pro can accept, see the entry for File types in the Glossary.

Dialog box options:
Acquire In

Select the volume and/or folder in which the file(s) you want to acquire are located. The button showing a 
folder with an arrow on it moves you up one folder level when you click it. 

List/Icon View buttons
These buttons allow you to toggle the display in the file selection area between list (columnar text) and icon
(graphic representation of the files according to their type) views.

Show Preview checkbox
When this checkbox is selected, ImageAXS Pro displays a preview of selected files in the Preview display 
area. This feature allows you to visually inspect the file before acquiring it. If the file you are acquiring is a 
movie, the movie plays in the preview area if the Show Preview checkbox is selected.

File Name
Select the files you want to acquire using this control. You can either type the file name (and path, if 
necessary) of the source file you want to acquire in the File Name area, or use the file navigation controls 
above the File Name entry area to select the source file(s) you want. Hold down the Shift key to select 
multiple, contiguous files; hold down the CTRL key to make a random selection. If you have selected the 
Preview checkbox, a preview of the file you select appears in the Preview display area (except when 
making multiple selections using the Shift or CTRL keys).

List Files of Type
Use this pop-up menu to select the type of files that you want to appear in the File Name list. The default 
file type is Image Files, which includes all files that ImageAXS Pro can accept (for a list of the file types 
ImageAXS Pro can accept, see the entry for File types in the Glossary). You can select All Files in the List 
Files of Type pop-up menu; this option, however, also displays file types that cannot be acquired by 
ImageAXS Pro.

Acquire Log
Each file you select to acquire appears in this log area. By providing this log to hold the files you select to 
acquire, ImageAXS Pro allows you to locate and select files from many different locations on your system 
and acquire them into your data file as a batch.

Add
Adds the file(s) you have selected in the File Name field to the Acquire Log. You can also add files to the 
Acquire Log in a single step by double-clicking them in the File Name area.

Remove
Removes selected file(s) from the Acquire Log. If, for example, you want to acquire all files in a folder 
except for three or four, you can use the Add All button to place all the files in the folder in the Acquire Log
in a single step, and then remove the files you don’t want by selecting them and clicking the Remove button

Add All
Adds all of the image files in the folder you have selected to the Acquire Log.

Remove All
Removes all of the source files from the Acquire Log.

OK
Acquires all of the files listed in the Acquire Log into the open collection. A thumbnail appears in the 
collection window as ImageAXS Pro acquires each file.
NOTE: If you are acquiring a movie file, ImageAXS Pro displays the Select Thumbnail dialog box when 
acquiring the file. The controls in the Select Thumbnail dialog box work identically to all other movie 
player dialog boxes, with the exception that when you click the OK button, ImageAXS Pro grabs the 
displayed frame and uses it as the thumbnail for the file in your collection. For instructions on how to 
acquire a thumbnail for a movie file, see the description of the Select Thumbnail dialog box.

Cancel



Cancels out of the operation and closes the Acquire Files dialog box.



Select Thumbnail dialog box
The Select Thumbnail dialog box contains controls allowing you to select images for ImageAXS Pro to use as a 
thumbnail for movie files you acquire. ImageAXS Pro allows you to select any frame you want from movies to use 
as thumbnails.
To select a frame from the movie as a thumbnail, play the movie using the controls in the Select Thumbnail dialog 
box. When the frame appears that you want to appear as the thumbnail, click OK. If you want greater control when 
displaying the movie, use the Pause, Back One Frame, and Forward One Frame controls and/or the slider to display 
the frame you want. After you click OK, ImageAXS Pro completes the acquisition process for the movie file. The 
frame you selected appears as the thumbnail for the record in ImageAXS Pro.

Dialog box options:
Sound Control

Clicking the Sound Control opens the Volume Control dialog box for your system. Depending on the configuration 
of your computer, the Volume Control dialog box may contain controls allowing you to adjust the overall system 
volume and balance, the wave volume and balance, MIDI volume and balance, CD volume and balance, line in 
volume and balance, and the treble and bass intensity.
Play button

Clicking the Play button begins playing the movie. While the movie is playing, the Play button becomes the Pause 
button.
Pause button

Clicking the Pause button temporarily halts the movie, allowing you to move through the movie using the Forward 
One Frame button, the Back One Frame button, and the Slider. While the movie is paused, the Pause button reverts 
to the Play button. Click the Play button to resume playing the movie.
Slider

The slider allows you to navigate quickly through the movie to the location of the frame you want to use as a 
thumbnail. To use the slider, drag the slider box. The movie changes in the display to reflect the position of the slider
box (the left side of the slider is the beginning of the movie, the right side is the end).
Back One Frame

Clicking this button moves you back one frame in the movie. This control is useful when you need to make small 
adjustments while selecting your thumbnail frame.
Forward One Frame

Clicking this button moves you forward one frame in the movie. This control is useful when you need to make small
adjustments while selecting your thumbnail frame.
OK

When you click this button, ImageAXS grabs the currently displayed frame as the thumbnail image, closes 
the Select Thumbnail dialog box, and continues the acquire process.

Cancel
Clicking this button closes the Select Thumbnail dialog box and terminates the acquire process.



Update Path dialog box
When you acquire source files into your collection, ImageAXS Pro does not copy the source files, but instead 
creates a reduced version of the source file (called a thumbnail) and stores it and the path to the source file in the 
record. The path for source files must be kept current, or you will not be able to display the source file for the record
in the Source File View. If, for some reason, the path for a source file changes (because the file name has been 
changed or the file has been moved to another folder or volume), the source file is said to be off-lineOff_Line and 
you will need to update the path to see the Source File View for the record.
Use the controls in the Update Path dialog box to bring source files for records back on-lineOn_Line, or to create a 
new thumbnail for a record (you may want to do this if a source file has been edited, but not moved, and you want 
the thumbnail to reflect the latest version). When you update the path of a source file, ImageAXS Pro automatically 
saves new file information for the source file.

Dialog box options:
Folder

Select the volume and/or folder in which the file(s) you want ImageAXS Pro to reference are located. The 
button showing a folder with an arrow on it moves you up one folder level when you click it. 

List/Icon View buttons
These buttons allow you to toggle the display in the file selection area between list (columnar text) and icon
(graphic representation of the files according to their type) views.

Show Preview checkbox
When this checkbox is selected, ImageAXS Pro displays a preview of selected files in the Preview display 
area. This feature allows you to visually inspect the file.

Update Thumbnail checkbox
When this checkbox is selected, ImageAXS Pro creates a new thumbnail for the record when updating the 
path.

File Name
Select the files you want to acquire using this control. You can either type the file name (and path, if 
necessary) of the source file you want to acquire in the File Name area, or use the file navigation controls 
above the File Name entry area to select the source file(s) you want. Hold down the Shift key to select 
multiple, contiguous files; hold down the CTRL key to make a random selection. If you have selected the 
Preview checkbox, a preview of the file you select appears in the Preview display area (except when 
making multiple selections using the Shift or CTRL keys).

List Files of Type
Use this pop-up menu to select the type of files that you want to appear in the File Name list. The default 
file type is Image Files, which includes all files which ImageAXS Pro can accept (for a list of the file types 
ImageAXS Pro can accept, see the entry for File types in the Glossary). You can select All Files in the List 
Files of Type pop-up menu; this option, however, also displays file types that cannot be acquired by 
ImageAXS Pro.

OK
When you click this button, ImageAXS Pro updates the selected record to use the source file you specify.

Cancel
Cancels out of the operation and closes the Update Path dialog box.



Update Source File dialog box
When you acquire source files into your collection, ImageAXS Pro does not copy the source files, but instead 
creates a reduced version of the source file (called a thumbnail) and stores it and the path to the source file in the 
record. The path for source files must be kept current, or you will not be able to display the source file for the record
in the Source File View. If, for some reason, the path for a source file changes (because the file name has been 
changed or the file has been moved to another folder or volume), the source file is said to be off-line and you will 
need to update the path to see the Source File View for the record.
0 Use the controls in the Update dialog box to bring source files for records back on-line, or to create a new 
thumbnail for a record (you may want to do this if a source file has been edited, but not moved, and you want the 
thumbnail to reflect the latest version). When you update the path of a source file, ImageAXS Pro automatically 
saves new file information for the source file.

Dialog box options:
Image File

The name of the file to which the record is currently linked appears in this area.
File Name

The name of the source file you want the record to reference appears here. You can type the name of the file
or select it from the File List below the File Name field.

List Files of Type
Use this pop-up menu to select the type of files that you want to appear in the File Name list. The default 
file type is Multimedia Files, which includes all files which ImageAXS Pro can accept (for a list of the file 
types ImageAXS Pro can accept, see the entry for File types in the Glossary). You can select All Files in the
List Files of Type pop-up menu; this option, however, also displays file types that cannot be acquired by 
ImageAXS Pro.

Folders
A list of the folders to which you can navigate appear in this list. When you select a folder, its contents 
appear in the File list.

Drives
Select the drive in which the file(s) you want ImageAXS Pro to reference are located. When you select a 
drive, the files and folders in the drive appear in the File list and Folder list, respectively.

Update Thumbnail checkbox
When this checkbox is selected, ImageAXS Pro creates a new thumbnail for the record when updating the 
path.

Preview checkbox
When this checkbox is selected, ImageAXS Pro displays a preview of selected files in the Preview display 
area. This feature allows you to visually inspect the file.

Preview area
A thumbnail version of the file you select appears in this area if the Preview checkbox is selected.

Skip
Clicking this button causes ImageAXS Pro to skip the update process for the current record and progress to 
the next record in your selection.

OK
When you click this button, ImageAXS Pro updates the selected record to use the source file you specify.



Update Path dialog box
When you acquire source files into your collection, ImageAXS Pro does not copy the source files, but instead 
creates a reduced version of the source file (called a thumbnail) and stores it and the path to the source file in the 
record. The path for source files must be kept current, or you will not be able to display the source file for the record
in the Source File View. If, for some reason, the path for a source file changes (because the file name has been 
changed or the file has been moved to another folder or volume), the source file is said to be off-line and you will 
need to update the path to see the Source File View for the record.
0 Use the controls in the Update Path dialog box to bring source files for records back on-line, or to create a 
new thumbnail for a record (you may want to do this if a source file has been edited, but not moved, and you want 
the thumbnail to reflect the latest version). When you update the path of a source file, ImageAXS Pro automatically 
saves new file information for the source file.

Dialog box options:
Folder

Select the volume and/or folder in which the file(s) you want ImageAXS Pro to reference are located. The 
button showing a folder with an arrow on it moves you up one folder level when you click it. 

List/Icon View buttons
These buttons allow you to toggle the display in the file selection area between list (columnar text) and icon
(graphic representation of the files according to their type) views.

Show Preview checkbox
When this checkbox is selected, ImageAXS Pro displays a preview of selected files in the Preview display 
area. This feature allows you to visually inspect the file.

Update Thumbnail checkbox
When this checkbox is selected, ImageAXS Pro creates a new thumbnail for the record when updating the 
path.

File Name
Select the files you want to acquire using this control. You can either type the file name (and path, if 
necessary) of the source file you want to acquire in the File Name area, or use the file navigation controls 
above the File Name entry area to select the source file(s) you want. Hold down the Shift key to select 
multiple, contiguous files; hold down the CTRL key to make a random selection. If you have selected the 
Preview checkbox, a preview of the file you select appears in the Preview display area (except when 
making multiple selections using the Shift or CTRL keys).

List Files of Type
Use this pop-up menu to select the type of files that you want to appear in the File Name list. The default 
file type is Image Files, which includes all files which ImageAXS Pro can accept (for a list of the file types 
ImageAXS Pro can accept, see the entry for File types in the Glossary). You can select All Files in the List 
Files of Type pop-up menu; this option, however, also displays file types that cannot be acquired by 
ImageAXS Pro.

OK
When you click this button, ImageAXS Pro updates the selected record to use the source file you specify.

Cancel
Cancels out of the operation and closes the Update Path dialog box.



Move/Copy Source Files dialog box
This dialog box contains controls allowing you to copy and/or move source files from one location to another. This 
dialog box is essentially the same for both the Copy Source Files and Move Source Files commands. 
If you choose the Copy Source Files command, ImageAXS Pro copies the source file(s) to a new destination. 
ImageAXS Pro allows you to update the path for the source file to the new source file (created by the copy 
command) if you want. Update the path to use the new source file by selecting the Update Collection checkbox. 
If you choose the Move Source Files command, ImageAXS Pro copies the source file(s) to a new destination and 
updates your collection to use the new path. Afterwards, the original source file is deleted. 
NOTE: If you are moving source files to a new location, always use the Move Source Files command in ImageAXS 
Pro. If you do not use the Move Source Files command, the records for the source files you move will fall off-line.

Dialog box options:
Copy to Folder:

Select the folder to which you want to move/copy the source file(s).
Drive

Select the drive in which you want to move/copy the source file(s).
Update Collection

Check this option to switch the paths of the source files from the original files to the copied files.
NOTE:This option is available only in the Copy Source Files dialog box. It is not available in the Move Source Files
dialog box because ImageAXS Pro automatically updates the path(s) for source file(s) during the move.



Rename Source Files dialog box
This dialog box allows you to rename the selected source file.
NOTE: If you are renaming source files, always use the Rename Source Files command in ImageAXS Pro. If you do
not use the Rename Source Files command, the records for the source files you rename will fall off-line.

Dialog box options:
From

This is the original name of the source file.
To

This is the new name of the source file.



File Information dialog box
The File Information dialog box lists specific information about the source file for the selected record. This 
command is not available if more than one record is selected. 
NOTE: The information in the File Info dialog box is read only.

Dialog box contents:
Name

The name of the source file.
Type

The file type of the source file (for a list of the file types ImageAXS Pro can accept, see the entry for File 
types in the Glossary).

Size
The storage size of the source file (in bytes).

Width
The width of the source file (in pixels).

Height
The height of the source file (in pixels).

Modified
The date and time the source file was last modified.

Volume
The drive on which the file is located (e.g., a hard disk, a CD-ROM, a Syquest, etc.)

Location
The full path to the location of the source file.



Go to dialog box
When you create a collection of records, ImageAXS Pro assigns a number to each record to help you navigate. This 
dialog box allows you to specify the number of the record you want.

Dialog box options:
Number

The record number to go to.



Word Count dialog box
When you select a record or group of records and choose the Word Count command in the Record menu, ImageAXS
Pro counts the total words in all selected records. When ImageAXS Pro completes the word count, the Word Count 
dialog box is displayed. In it are displayed the word counts for the selected record(s), broken down by field. Also 
included are word counts for the Master Keyword List and a total word count for all fields.

Dialog box options:
Word Count display area

The word counts for the selected record(s) are displayed here.
OK

Click this button to close the dialog box.



System Settings dialog box - Appearance area
The System Settings dialog box contains controls allowing you to configure the appearance and behavior of 
ImageAXS Pro. The Appearance area contains controls allowing you to set the background for ImageAXS Pro 
windows (dark or light gray), whether or not you want the Image Tool Palette to appear, if you want the full path for 
source files to appear in the title bar of the Source File View window, and how many Source File View and Info 
Sheet View windows you want ImageAXS Pro to allow open simultaneously.

Dialog box options:
Dark Background checkbox

When selected, ImageAXS Pro uses a dark gray background for windows, when unselected, ImageAXS 
Pro uses a light gray background. The default is a dark gray background. 

Scaleable Font checkbox
When selected, ImageAXS Pro uses a scaleable font in the Text List View and the Info Sheet View 
windows. By setting ImageAXS Pro to use a scaleable font, ImageAXS Pro changes the size of the font 
when you resize windows to enhance readability and ensure that the maximum amount information is 
presented. 

Image Tool Palette checkbox
Selecting this checkbox instructs ImageAXS Pro to display the Image Tool Palette when a Source File View
window is open. The Image Tool Palette contains tools designed to help you view and manipulate source 
files in the Source File View. 

Show Full Path on Image Title bar checkbox
Selecting this checkbox instructs ImageAXS Pro to display the full path for images displayed in the Source 
File View. The path for the image appears in the Title bar of the Source File View window. 

No More than “X” Full Image Views
Enter a number here to limit the number of Source File View windows ImageAXS Pro can display 
simultaneously. You may want to enter a lower number (e.g., 4 or less) if your system has only 8 MB of 
RAM. 

No More than “X” Info Sheet Views
Enter a number here to limit the number of Info Sheet View windows ImageAXS Pro can display 
simultaneously. You may want to enter a lower number (e.g., 4 or less) if your system has only 8 MB of 
RAM.
NOTE: The number you set for Info Sheet Views also affects how many Keywords View windows you can 
open simultaneously.



System Settings dialog box - Behavior area
The System Settings dialog box contains controls allowing you to configure the appearance and behavior of 
ImageAXS Pro. The Behavior area contains controls allowing you to set whether ImageAXS Pro can open several 
records simultaneously, and if you want the program to search and sort using hidden fields as criteria. For more 
information about hidden fields, see the description of the Field Labels command.

Dialog box options:
Multiple Records May Be Open Simultaneously checkbox

Selecting this checkbox allows you to open several records simultaneously in the Info Sheet View. This is 
convenient if you want to cut and paste information between records (using the Cut command and Paste 
command in the Edit menu).

Search and Sort by Hidden Fields checkbox
Selecting this checkbox allows you to include hidden fields as criteria for searching and sorting. For more 
information about hidden fields, see the description of the Field Labels command.

Slide Show Delay “X” seconds
When running the slide show automatically, ImageAXS Pro uses the number you enter here as the length a 
source file displays (before displaying the next source file). For more information about running slide 
shows, see the description of the Slide Show command.



System Settings dialog box - Messages area
The System Settings dialog box contains controls allowing you to configure the appearance and behavior of 
ImageAXS Pro. The Messages area contains controls allowing you to set the actions for which ImageAXS Pro 
returns confirmation messages to the user. The actions for which ImageAXS Pro can return confirmation messages 
include changes to keywords, changes made to the data file by another user over a network, attempts to open more 
Source File Views or Info Sheet Views than specified in the Appearance section of the System Settings dialog box, 
or attempts to display thumbnails at a different size than the size in which they were saved.

Dialog box options:
Confirm Create Keyword checkbox

If this checkbox is selected and you attempt to add a keyword to the Master Keyword List, ImageAXS Pro 
will display an alert box asking you to confirm the action.

Confirm Detach Keyword checkbox
If this checkbox is selected and you attempt to detach a keyword from a record, ImageAXS Pro will display
an alert box asking you to confirm the action.

Watch for Multi-user Changes checkbox
If you are working with ImageAXS Pro in a multi-user environment (sharing a data file over a network), 
you can set ImageAXS Pro to watch for any changes made that affect your work. For example, if you are 
entering data into a record and another user opens the same record and makes changes to a field you have 
edited, ImageAXS Pro will warn you about the potential conflict (if this checkbox is selected).

Show Warnings checkbox
If this checkbox is selected, ImageAXS Pro will display warnings under circumstances such as when you 
attempt to show thumbnails saved in a different size than the one you have selected in the Thumb Size area 
of the System Settings dialog box, or if you attempt to simultaneously display more Info Sheet View or 
Source File View windows than the number you have set in the Appearance area of the System Settings 
dialog box.



System Settings dialog box - Thumbnail Size area
The System Settings dialog box contains controls allowing you to configure the appearance and behavior of 
ImageAXS Pro. The Thumbnail Size area allows you to specify the size of thumbnails created and displayed by 
ImageAXS Pro. 
When you acquire a source file, ImageAXS Pro creates a thumbnail version of the source file for display in the 
Thumbnails, Info Sheet, and Keywords Views. ImageAXS Pro can create and display thumbnails in three sizes; 
small (64 x 64 pixels), medium (96 x 96 pixels), and large (128 x 128 pixels). If you have a large number (e.g., 
thousands) of records, you can save hard disk space by using the smaller thumbnail sizes. Smaller thumbnails, of 
course, will not display as much detail as larger thumbnails. 
Note that if you attempt to display thumbnails in a different size than you have selected, ImageAXS Pro will display 
an alert box (if you have the Show Warnings checkbox selected in the Behavior area of the System Settings dialog 
box. 
You can also set whether you want ImageAXS Pro to compress the thumbnails it creates and the compression ratio 
for thumbnails in the Thumbnail Size area. To enable thumbnail compression, select the Compress Thumbnails 
checkbox. At a compression ratio of 100%, thumbnails are not compressed and image quality is at its highest. Lower
compression ratios degrade image quality but increase access speed. ImageAXS Pro allows you to set any 
compression ratio you want (between 25 and 100%). For moderate compression, rendering average quality 
thumbnails, it is recommended that you set the compression ratio at 75%. 
Select the Do Not Enlarge Thumbs for Tiny Images checkbox to prevent ImageAXS Pro from increasing the size of 
small images to match the pixel sizes you have designated. Small images can be distorted if enlarged.



System Settings dialog box - Data Source area
The System Settings dialog box contains controls allowing you to configure the appearance and behavior of 
ImageAXS Pro. The Data Source area contains controls allowing you to specify the type of database on which you 
want to base data files you create. 
ImageAXS Pro is capable of accessing information stored by a number of leading software products, including 
Borland’s dBase and Paradox, Microsoft’s Excel, Access, and FoxPro, FileMaker Pro from Claris, as well as many 
SQL relational database management systems (RDBMS’s) and ASCII text data. The Data Source area contains 
controls allowing you to designate the product from which you are accessing information, as well as enter the data 
configuration string for ImageAXS Pro to use when accessing information. 



PhotoCD Options dialog box
The PhotoCD Options dialog box contains controls allowing you to specify the format of PhotoCD images you 
display in the Source File View. Specifying the correct color palette and resolution is necessary to have the image 
appear correctly in the Source File View.

Dialog box options:
Color Mode area

Select the color mode for your PhotoCD image here; your choices are Grayscale, RGB, or Lab Color.
Resolution area

The PhotoCD image can be saved in any of five resolutions; select the radio button that is appropriate for 
the resolution of your image.

Always Ask for PhotoCD Options checkbox
When you select this checkbox, ImageAXS Pro will always display the PhotoCD Options dialog box 
whenever you display a PhotoCD file in the Source File View.



Search dialog box
This dialog box allows you to search all the fields in every record in your collection. To find records, you create a set
of search criteria (the value or values used to evaluate records) and tell ImageAXS Pro to find the records that match
your search criteria. Search criteria can be as simple or complex as required, from a single line search for a name in 
a field to multi-line search using operators and omissions. For example, you may create search criteria reading “Title
begins with Y” and “Photographer is equal to Adams.” The results of this search would include “Yosemite Valley” 
and “Yosemite Falls” by Ansel Adams. This is a simple example; you can create highly complex searches in the 
Search dialog box.
ImageAXS Pro also allows you to save and reload sets of search criteria, eliminating the need to re-enter data.

Dialog box options:
Field

This pop-up list allows you to choose the field to search.
Not

Click this option to exclude records that match the search criteria.
Operators

This pop-up list allows you to choose an operator for your search.
contains Directs ImageAXS Pro to return records in which the data in the selected field contains 

the character(s) entered in the Value field.
begins with Directs ImageAXS Pro to return records in which the data in the selected field begins 

with the character(s) entered in the Value field.
ends with Directs ImageAXS Pro to return records in which the data in the selected field ends with

the character(s) entered in the Value field.
equal to Directs ImageAXS Pro to return only those records in which the data in the selected 

field exactly matches the character(s) entered in the Value field.
greater than Directs ImageAXS Pro to return records in which the value in the selected field is 

greater than the value entered in the Value field.
less than Directs ImageAXS Pro to return records in which the value in the selected field is less 

than the value entered in the Value field.
between Directs ImageAXS Pro to return records containing values between the two values 

specified. Enter only two values, separated by a space or comma.
one of When you select this operator, ImageAXS Pro allows you to enter a series of values 

(separated by spaces or commas) to use as criteria. ImageAXS Pro returns all records 
matching any one of the values you enter. Values can be numbers or individual words 
(not phrases).

Value
Use this text box to type in the specific value for which you want to search. When entering multiple values 
(for “between” and “one of” searches), separate the values by commas or spaces. If the value you are 
looking for contains a space, surround the value with quotation marks (“value1 value2”). If the value 
contains quotation marks, use two sets of quotations marks (““value””).

Criteria
Displays all of the search lines from the current search. As you add criteria, the lines containing the criteria 
appear in this area. To delete lines in this area, select the line you want to delete (ImageAXS Pro highlights 
the line when you select it) and then click Delete.

And
Select this option if your search is longer than one line and you want to link two of your search lines with 
AND. For example, “Photographer is equal to Adams” AND “Title begins with Y” returns the records in 
which the content of the photographer field equals Adams and the title begins with “Y” (e.g., Yosemite 
Valley and Yosemite Falls).

Or
Select this option if your search is longer than one line and you want to link two of your search lines with 
OR. For example, “Subject is equal to ocean” OR “Subject is equal to mountains” returns all records in 
which the subject is equal to ocean and also those records in which the subject is equal to mountains.



Add Line
Click this button to add a line to your search criteria.

Delete Line
Click this button to delete the selected search line from your search criteria.

Load Search…
Loads a previously saved search. Saving and loading searches permits you to run and modify complex 
searches without the need to re-enter data.

Save Search…
Saves the current search. Once saved, you can reload a search at any time, eliminating the need to re-enter 
the search criteria.



Keyword Search dialog box
This dialog box allows you to search for records to which specific keywords have or have not been attached. For 
example, if you work for a photo service bureau, you may have keywords for the levels of copyright attached to 
records in your collection (e.g., royalty-free, public domain, requires a fee, etc.). Using the Keyword Search dialog 
box, you could locate all the royalty-free images in your collection that are not in the public domain.
NOTE: If you want to create compound searches using keywords as criteria, click the Advanced button to open the 
Advanced Keyword Search dialog box.

Dialog box options:
Keywords

Select the keyword(s) that you want to search for in this area. If your keyword list is very long, you can 
type in the first few characters of the keyword you want and ImageAXS Pro will navigate to that area in the
list for you.

Search
Click this button to search for the selected keyword.

Advanced
Click this button to open to the Advanced Keyword Search dialog box.

Not
Selecting this checkbox directs ImageAXS Pro to return all records that do not have the specified keywords
attached.

NOTE: To search for records that have no keywords attached to them, select all keywords in the Master Keyword 
List and select the And Not radio button.



Advanced Keyword Search dialog box
This dialog box allows you to create compound keyword searches. For example, if the records in your collection 
depict mountain scenery, you may want to look for all records that show skiers or snowboarders, but not those that 
feature snowmobiles. The Advanced Keyword Search dialog box allows you to construct complex, multi-level 
searches using keywords as criteria. You can also save and load keyword search criteria, eliminating the need to re-
enter information.

Dialog box options:
Keyword

Select the keyword you want to use as criteria in this area. When you select a keyword in the list, it appears 
in the Keyword text entry area. You can also enter keywords in this area by typing; if your keyword list is 
very long, you can navigate to the keyword by typing the first few characters.
As you select keywords, the buttons allowing you to add the keywords to your search criteria (e.g., Add 
Criteria, And, And Not, Or, and Or Not), activate. After selecting a keyword and adding it to your search 
criteria, it appears in the Criteria area.

Criteria
As you select keywords and add them to your search criteria, they appear in this area. 

Search
Click this button to search for the criteria you enter.

Add Criteria
This button is active only after you have selected a keyword in the Keyword list. Click this button to add 
the keyword to your criteria, instructing ImageAXS Pro to return records to which this keyword has been 
attached. After you add the keyword, it appears in the Criteria area.

And
This button is active only after you have entered one or more lines of search criteria, and have selected 
another keyword in the Keyword list. Click this button to add the keyword to your criteria, instructing 
ImageAXS Pro to return records to which this keyword (and the previous one) have been attached. After 
you add the keyword, it appears in the Criteria area.

And Not
This button is active only after you have entered one or more lines of search criteria, and have selected 
another keyword in the Keyword list. Click this button to add the keyword to your criteria, instructing 
ImageAXS Pro to return records to which this keyword has not been attached. After you add the keyword, 
it appears in the Criteria area.

Or
This button is active only after you have entered one or more lines of search criteria, and have selected 
another keyword in the Keyword list. Click this button to add the keyword to your criteria, instructing 
ImageAXS Pro to return records to which this keyword has been attached. After you add the keyword, it 
appears in the Criteria area.

Or Not
This button is active only after you have entered one or more lines of search criteria, and have selected 
another keyword in the Keyword list. Click this button to add the keyword to your criteria, instructing 
ImageAXS Pro to return records to which this keyword has not been attached. After you add the keyword, 
it appears in the Criteria area.

Delete Line
This button is active only after you have added a line to the search criteria and have selected it in the 
Criteria area. Click this button to delete the selected search line from your search criteria.

Load Query
Loads a previously saved set of keyword search criteria.

Save Query
Saves the current set of keyword search criteria. Once saved, you can reload a set of keyword search 
criteria at any time, eliminating the need to re-enter the information.

NOTE: To search for records that have no keywords attached to them, select all keywords in the Master Keyword 
List and select the And Not radio button.



Sort dialog box
This dialog box allows you to sort the records in your collection according to the content of their fields. The sort 
utility in ImageAXS Pro is iterative; i.e., the first pass arranges the records based on the field’s contents; the second 
pass arranges records when two or more records have the same value in the first sort field, and so on. You can sort 
records in ascending or descending order using the Order radio buttons. When your sort is finished, ImageAXS Pro 
displays the records in their new order using the view you had open when you started the sort (e.g., the Thumbnails 
View or the Text List View). If you are viewing records in the Info Sheet View or Keywords View and use the 
navigation controls in the Toolbar to display the records, the records appear in the new sort order as you navigate.

Dialog box options:
Fields

This list displays all of the fields in your collection.
Order

Click the ascending radio button to sort the records in ascending order (i.e., from A to Z, 1 to 100, etc.).
Click the descending radio button to sort the records in descending order (i.e., from Z to A, 100 to 1, etc.).

Sort by
The fields that the collection will be sorted by.

Add
Click this button to add the selected field in the Field list to the Sort by list.

Remove
Click this button to remove a selected field from the Sort by list.

Remove all
Click this button to remove all the fields from the Sort by list.

Move Up
Click this button to move the selected field up in the Sort by list.

Move Down
Click this button to move the selected field down in the Sort by list.



Text List Report dialog box
When the Text List Report dialog box is displayed, ImageAXS inserts the name of your current collection in the title
bar of the dialog box. Use the Text List Report dialog box to preview the output of Text List Report Templates. 
Using the dialog box’s button controls, you can designate the default report template used when printing from the 
Text List View, and access the Customize List Report dialog box, which allows you to modify and save templates.
The Text List Report dialog box’s button controls include the following:

 Modify Template button
 Link Template to Collection button.
 Previous Page button
 Next Page button

Dialog box options:
Report Templates pop-up list

Click this pop-up list to display a list of the report templates saved for the current collection. To select a 
template from the list, click it with your mouse. To navigate the list, use its scrollbar. When you select a 
template from the list, a sample Text List Report based on that template is displayed in the dialog box. 
Click the Link Template to Collection button to link the template for use as the collection’s default Text List
Report template.

Modify Template button
When you click this button, ImageAXS displays the Customize List Report dialog box , allowing you to 
customize and save multiple text reports. When the Customize List Report dialog box is displayed, it 
contains the currently selected template’s settings.

Link Template to Collection button
When you click this button, ImageAXS links the template you have selected in the Report Templates pop-
up list to your collection for use as the default Text List report for the collection.

Next and Previous Page buttons
Use these buttons to navigate through pages in the displayed sample Text List Report.

Close box
Use the Close box in the right side of the dialog box’s title bar to close the dialog box.



Customize List Report dialog box
Using the controls in the List Report dialog box, templates can be designed and saved for the reports you print from 
the Text List View. Text List Reports can consist of any fields you designate from your collection and can be 
configured to print using text and formatting controls provided in the dialog box. You can easily save report 
templates you have created, allowing you to generate different reports. By loading saved templates which share 
characteristics with a new report template you are using, you can avoid repetitive data entry when creating new 
templates.

Dialog box options:
Template Name entry box

Enter the name you want for any new report template in this box and click New to save it as a template. 
Once a template name has been saved, its settings can be edited. Click the Template Name entry box’s right
arrow to open a pop-up list of your saved templates. You can select a template in the pop-up list by clicking
its name with your mouse. When you select a template in the list, its settings automatically appear as 
defaults in the Customize List Report dialog box. This can be useful when creating new report templates; 
simply select the saved template you wish to base your new template on and enter a new name for it, 
clicking New when you are done. Edit the template settings using the dialog box’s other controls and click 
Save.

New/Save
When you have entered a new name in the Template Name entry box, the New/Save button appears as a 
New button. Click New to save a name you have entered for a new template. When you are working with 
previously saved templates, the New/Save button appears as a Save button, allowing you to save changes 
you have made to settings in your templates.
NOTE: You must click the Save button before closing the Customize List Report dialog box. If you do not 
click Save, your changes will be lost when you close the dialog box. It is also recommended that you click 
Apply (described below) before closing the dialog box.

Title entry box
The text and macros you enter in this box will appear as a title centered at the top of each page of your 
report when you print it from the Text List View. Use macros to automatically enter record and page 
numbers or the name of the collection in your report’s title.

Header entry box
The text and macros you enter in this box will appear either as a header at either the right or left of the 
pages in your report. Use macros to automatically enter record and page numbers or the name of the 
collection in your report’s header.

Footer entry box
The text and macros you enter in this box will appear as a footer at either the right or left the pages in your 
report. Use macros to automatically enter record and page numbers or the name of the collection in your 
report’s footer.

Left and Right radio buttons
Left and Right radio buttons appear below the Header and Footer entry boxes. Click the radio button 
corresponding to where on your report’s pages you want the header and footer to appear.

Paper Width
Enter the paper width in inches here.

Left Margin
Enter the left margin width in inches here

Top Margin
Enter the top margin width in inches here.

Column Width
Enter the column width in inches here.

Lines per Row
Enter the maximum number of lines of text (1-8) you want in each row here. You can type the number in or 
click the entry box’s right arrow and select a number from the pop-up list.

Fields list
This list contains the names of all fields in your collection which are not already included in the Report. 



Those fields included in the report are listed in the Report Fields list (described below). To add a field from 
this list to your report, select it with your mouse and click the Add button (you can also double-click the 
field’s name). The field is removed from the Fields list and added to the Report Fields list.

Report Fields list
This list contains the names of the fields in your collection from which information will be included in your
Text List Report. The field names appear in the report’s column heads and their information from each 
record appears in successive rows in the report. The fields included in your report appear (left to right) in 
the order they are listed in the Report Fields list; the first field in the list appears in the far right of your 
report. To reorder the fields in the list, select the field(s) you want to move one at a time and use the Move 
Up and Move Down buttons to arrange them in the list.

Add
Click the Add button to add a field selected in the Fields list to the Report Fields list. The field will now 
appear in your report in the order in which it is situated in the Report Fields list.

Remove
Click the Remove button to remove a selected field from the Report fields list. Once removed, the field 
name appears in the Fields list and its information will not be included in your report.

Remove All
Click the Remove All button to remove all fields from the Report Fields list.

Move Up
Click the Move Up button to move a selected field higher in the Report Fields list. The fields included in 
your report appear (left to right) in the order they are listed in the Report Fields list; the first field in the list 
appears in the far right of your report.

Move Down
Click the Move Down button to move a selected field lower in the Report Fields list. The fields included in 
your report appear (left to right) in the order they are listed in the Report Fields list; the first field in the list 
appears in the far right of your report.

Font pull-down list
Click the Font pull-down list to select a font for your report. Select a font in the list by clicking its name 
with your mouse. You can navigate the pull-down list using its scrollbar.

Text Point Size pull-down lists
Click the Text Point Size pull-down lists to select point sizes for your report’s page title, column titles, 
header and footer, and field data. Select point sizes in the lists by clicking the size you want with your 
mouse. You can navigate the lists using their scrollbars.

Apply
It is recommended that you click Apply to apply your desired settings to the Text List Report dialog box 
before closing the Customize List Report dialog box.
The Apply button can also be useful for viewing the results of your changes to templates. While editing 
existing templates or creating new ones, you can observe a sample of the output that will be generated by 
ImageAXS using the current settings in your template. When you click Apply, the output from your current 
settings is displayed in the Text List Report dialog box.

Previous Page and Next Page
While editing existing templates or creating new ones, you can observe a sample of the output that will be 
generated by ImageAXS using the current settings in your template. When you click Apply, the out put 
from your current settings is displayed in the Text List Report dialog box. Use the Previous Page and Next 
Page buttons in the Customize List Report dialog box to navigate the pages of your report; when you click 
Next Page, for instance, the next page of your report is displayed in the Text List Report dialog box.

Close
Click Close to close the Customize List Report dialog box after you have saved and applied any changes 
you want used when printing your currently selected Text List Report. It is also necessary for you to click 
the Link Template to Collection button in the Text List Report dialog box if you have selected a new 
template for use as a default when printing from the Text List View.



Keywords View window
ImageAXS Pro contains a keywords feature, which allows you to create a list of words and phrases to describe 
records in your collection according to their content (e.g., “landscape” or “portrait”), condition (e.g., “requires a fee”
or “royalty-free”) or any other criteria appropriate to your needs. The Keywords View window contains controls 
allowing you to add keywords to the Master Keyword List, as well as attach keywords to records. 
You can later search for records in your collection using keywords as criteria. To search for records using keywords, 
choose the Keyword Search command from the Selection menu or click the Keyword Search button in the Left Bar. 
NOTE: You can navigate through the records in your data set while the Keywords View is active using the 
Navigation buttons in the Toolbar. As you navigate through the records the keywords you have selected in the 
Master Keywords List do not change, allowing you to attach the same keywords to records easily. You can also 
attach keywords to records using the Copy Keywords and Attach Keywords commands in the Edit menu.

Window options:
Keyword entry field

This entry field, which has no label, is active when the window opens. Enter keywords you want to add to 
the Master Keyword List here. Note that keywords you select in the Master Keyword List appear in this 
area.

Add
Click Add to add the word or phrase in the Keyword entry field to the Master Keyword List.

Remove
To remove a keyword from the Master Keyword List, select it by clicking it with your mouse. When you 
select the keyword, ImageAXS Pro highlights it in the list and the keyword appears in the Keyword entry 
field. Click Remove to remove the keyword from the Master Keyword List. Note that when you remove a 
keyword from the Master Keyword List, ImageAXS Pro removes the keyword from all records to which it 
has been attached.

Master Keyword List
All keywords in the collection appear in the Master Keyword List.

Attach
To attach a keyword to a record, select the keyword you want in the Master Keyword List and click Attach. 
When a keyword is attached to a record, the keyword appears in the Record Keywords List.

Detach
To detach a keyword from a record, select the keyword you want to detach in the Record Keywords List 
and click Detach. After you click Detach, the keyword is removed from the Record Keywords List and 
reappears in the Master Keywords List. Detaching a keyword from a record does not remove the keyword 
from the Master Keyword List for the collection.

Record Keywords List
The Record Keywords List shows all keywords attached to the current record.

NOTE: The number you enter in the Info Sheet View setting in the Appearance area of the System Settings dialog 
box also controls how many Keywords View windows you can have open simultaneously.



Keywords View window
ImageAXS Pro contains a keywords feature, which allows you to create a list of words and phrases to describe 
records in your collection according to their content (e.g., “landscape” or “portrait”), condition (e.g., “requires a fee”
or “royalty-free”) or any other criteria appropriate to your needs. The Keywords View window contains controls 
allowing you to add keywords to the Master Keyword List, as well as attach keywords to records. 
You can later search for records in your collection using keywords as criteria. To search for records using keywords, 
choose the Keyword Search command from the Selection menu or click the Keyword Search button in the Left Bar. 
NOTE: You can navigate through the records in your data set while the Keywords View is active using the 
Navigation buttons in the Toolbar. As you navigate through the records the keywords you have selected in the 
Master Keywords List do not change, allowing you to attach the same keywords to records easily. You can also 
attach keywords to records using the Copy Keywords and Attach Keywords commands in the Edit menu.

Window options:
Keyword entry field

This entry field, which has no label, is active when the window opens. Enter keywords you want to add to 
the Master Keyword List here. Note that keywords you select in the Master Keyword List appear in this 
area.

Add
Click Add to add the word or phrase in the Keyword entry field to the Master Keyword List.

Remove
To remove a keyword from the Master Keyword List, select it by clicking it with your mouse. When you 
select the keyword, ImageAXS Pro highlights it in the list and the keyword appears in the Keyword entry 
field. Click Remove to remove the keyword from the Master Keyword List. Note that when you remove a 
keyword from the Master Keyword List, ImageAXS Pro removes the keyword from all records to which it 
has been attached.

Master Keyword List
All keywords in the collection appear in the Master Keyword List.

Attach
To attach a keyword to a record, select the keyword you want in the Master Keyword List and click Attach. 
When a keyword is attached to a record, the keyword appears in the Record Keywords List.

Detach
To detach a keyword from a record, select the keyword you want to detach in the Record Keywords List 
and click Detach. After you click Detach, the keyword is removed from the Record Keywords List and 
reappears in the Master Keywords List. Detaching a keyword from a record does not remove the keyword 
from the Master Keyword List for the collection.

Record Keywords List
The Record Keywords List shows all keywords attached to the current record.

NOTE: The number you enter in the Info Sheet View setting in the Appearance area of the System Settings dialog 
box also controls how many Keywords View windows you can have open simultaneously.



Keywords View window
To help you search for records in your collection, ImageAXS Pro allows you to build a list of keywords – words and
phrases which describe records in terms of their content or condition. In the Keywords View window you can attach 
keywords to and detach keywords from a record, as well as add keywords to and delete keywords from the Master 
Keyword List. After attaching keywords to records in your collection, you can choose the Keyword Search 
command from the Selection menu to search for records using keywords as criteria. You can open the Keywords 
View by choosing the Keywords command from the View menu or by clicking the Keywords View button in the 
Left Bar.
You can also attach keywords to records and add keywords to the Master Keyword List using the Info Sheet View. 
See the description of the Info Sheet View in the Glossary for more information.
NOTE: You can navigate through the records in your data set while the Keywords View is active using the 
Navigation buttons in the Toolbar. As you navigate through the records the keywords you have selected in the 
Master Keywords List do not change, allowing you to attach the same keywords to records easily.
Copying keywords
To make it easier for you to copy keywords between records and collections, ImageAXS allows you to copy 
keywords in the Keywords View window and attach them using a menu command. See the description of the Copy 
Keywords and Attach Keywords commands for more information.
Exporting and importing keywords
If you want to move all the keywords in one collection to another collection, it may be most convenient to export 
and import the keywords rather than attempt to copy them. For more information, see the description of the Import 
Keyword and Export Keywords commands.

Window options:
Keyword entry field

This entry field, which has no label, is active when the window opens. Enter keywords you want to add to 
the Master Keyword List here. Note that keywords you select in the Master Keyword List appear in this 
area.

Add
Click Add to add the word or phrase in the Keyword entry field to the Master Keyword List.

Remove
To remove a keyword from the Master Keyword List, select it by clicking it with your mouse. When you 
select the keyword, ImageAXS Pro highlights it in the list and the keyword appears in the Keyword entry 
field. Click Remove to remove the keyword from the Master Keyword List. Note that when you remove a 
keyword from the Master Keyword List, ImageAXS Pro removes the keyword from all records to which it 
has been attached.

Master Keyword List
All keywords in the collection appear in the Master Keyword List.

Attach
To attach a keyword to a record, select the keyword you want in the Master Keyword List and click Attach. 
When a keyword is attached to a record, the keyword appears in the Record Keywords List.

Detach
To detach a keyword from a record, select the keyword you want to detach in the Record Keywords List 
and click Detach. After you click Detach, the keyword is removed from the Record Keywords List and 
reappears in the Master Keywords List. Detaching a keyword from a record does not remove the keyword 
from the Master Keyword List for the collection.

Record Keywords List
The Record Keywords List shows all keywords attached to the current record.

NOTE: The number you enter in the Info Sheet View setting in the Appearance area of the System Settings dialog 
box also controls how many Keywords View windows you can have open simultaneously.



Field Labels dialog box
The Field Labels dialog box contains controls allowing you to enter the text for labels appearing next to fields in the 
Info Sheet View (and also at the tops of columns in the Text List View). You can also specify if the field is to be 
hidden from view for users of your collection; this feature is useful if you are using ImageAXS Pro to publish 
information in read-only format. 
Open the Field Labels dialog box by choosing the Field Labels command from the Preferences menu.

Dialog box options:
Thumbnails’ Label

Choose the field which you want to appear below thumbnails in the Thumbnails View. The default field to 
appear is the file name for the source file referenced by the record. Note that the information that appears 
beneath thumbnails can be as little as eight characters (when displaying small thumbnails, see the 
description of the Thumbnail area in the entry for the System Settings dialog box for more information); 
you should take this into consideration when designating the field to appear beneath thumbnails.

Field Name and Type areas
Each field that appears in records in the current collection is displayed here. The type of the field (text, 
date/time, numeric, or Boolean) appears in CAPITAL letters after the position of the field and, in the case 
of text fields, the length of the field (in characters) appears in parentheses. Enter the label for the field in the
area corresponding to each field position. The label you enter should describe the type of information you 
expect the field to hold. Field labels can be up to 254 characters, allowing you to enter highly descriptive 
text for labeling fields. In the Info Sheet View, however, only the first 16 characters of the field label 
appear, and excessively long field labels can negatively affect the appearance of your printed output. In the 
Text List View, you can resize the width of columns to see the entire labels and content of fields.

Hidden checkboxes
Selecting the Hidden checkbox for a field prevents it from appearing in the Info Sheet View and the Text 
List View. If you are using ImageAXS Pro to publish information and use fields to track internal data (for 
production, management, etc.), you can use this feature to suppress fields from end users.

Long Text Label
Each record you create contains a long (60 KB) text field allowing entry of comments, descriptions, etc. for
the record. Enter the label you want for the long text field here (the default is “Description”).



About box
This dialog box contains information about ImageAXS Pro, including the version and serial number of the copy you 
are using and the individuals responsible for developing the program.



Error Alert dialog box
If ImageAXS Pro encounters an error while performing an operation such as acquiring source files or importing 
records, this dialog box appears. In this dialog box you have four choices:

Retry Always click this button first, especially if you think the error is related to data transmission (e.g., a 
network or modem glitch) or disk access (e.g., a dirty CD-ROM).
0 Ignore Click this if you’ve already used the Retry button a few times and the error won’t go away.
If the problem is related to a single file or record, you can try to complete the operation manually.
Ignore all Click this if you’re getting multiple error messages and you just want to complete as much of the
operation as possible. ImageAXS Pro will display a log at the end of the procedure which will allow you to 
go back and recover the problem files or records.
Stop If the results of the operation aren’t up to the minimum standards you can tolerate, click this button. 
ImageAXS Pro will terminate the operation and close all dialog boxes related to it.
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Acquire
When adding a record to a collection, you will typically 'acquire' a source file. Acquiring a source file does 
not physically bring the file into the collection; instead, ImageAXS Pro takes a ‘snapshot’ of the source file 
and creates a smaller, thumbnail version of it that it stores in the record. In addition to creating a thumbnail,
the acquire process catalogues certain data about the source file (file information) that is stored, along with 
the thumbnail, in the record.



Active Window
Although you may have multiple collection and portfolio windows open simultaneously, only one window 
can be 'active' at a time (this is true for the majority of operating systems, including Windows and 
Macintosh). If you have more than one window open, the title bar of the active window is highlighted. If 
you have a dialog box open, the active window is the window that was active when you opened the dialog 
box.



Associated
Term used to describe the relationship between source files and records in a collection. When you acquire a 
source file to create a record, ImageAXS Pro does not incorporate the source file into your data file. Instead
(for reasons of efficiency), ImageAXS Pro stores a “link” to the location of the source file (also referred to 
as a path). Generally speaking, each record in your collection is associated with a source file.



Attached
Term used to describe whether a keyword has been assigned to a record. Keywords are words and phrases 
used to describe the source file associated with a record, generally in terms of its content or conditions, 
such as “landscape” or “royalty-free.” You can later search for records using keywords as criteria.



Batch Update
When working with computers, the term “batch” is used whenever you set up several, similar tasks to 
happen at once, such as when you copy several files from one disk to another. A good example of how 
ImageAXS Pro allows you to process items in a batch is in the Acquire Files dialog box, in which you can 
identify source files from several locations on your system, and acquire them simultaneously. 
The Batch Update feature allows you to update the source files for multiple records simultaneously. This 
can save considerable time compared to updating records individually, especially if you have many records 
to update. 
When you acquire a source file for a record, ImageAXS Pro does not physically bring the file into the 
collection; instead, the program takes a ‘snapshot’ of the source file and creates a smaller, thumbnail 
version of it that it stores in the record. In addition to creating a thumbnail, the acquire process catalogues 
certain data about the source file (file information) that is stored, along with the thumbnail, in the record. 
Part of the file information concerns the location of the file on your system (also called the path). If, for 
some reason, the location or content of source files change (because it is moved to a new drive, or it has 
been edited in some way), you will want to use the Batch Update command so your records are on-line and 
the thumbnails accurately reflect the appearance of the source file.



Cascade
ImageAXS Pro allows you to open multiple windows simultaneously, giving you the ability to view the 
records in your collection using several methods. Occasionally, however, the windows may overlap, 
making it difficult to navigate among the views. You can arrange all open windows in ImageAXS Pro using
a single action by choosing the Cascade command from the Window menu. When you choose Cascade, 
ImageAXS Pro arranges all open windows so the title bar of each window is visible.



Clear Selection
To deselect all records in the active window (Thumbnails View or Text List View), use the Clear Selection 
command in the Edit menu. After you choose Clear Selection, no records in the active window are selected.
Note that choosing Clear Selection does not remove records from the active window.



Clipboard
The Clipboard is a temporary storage area for text or graphics that you are copying or moving from one 
location to another (such as between records). The Clipboard is a common holding area among Windows 
applications. For more information about the Clipboard, see the documentation that came with your 
Windows software.



Collections
Collections are the data files created and read by ImageAXS Pro. Each collection is an ImageBase 
composed of individual records and the source files associated with the records. ImageAXS Pro allows you 
to create and maintain as many different collections as you like. 
You can also open several collections simultaneously. To move between collections and portfolios, click the
window containing the collection or portfolio you want or choose the collection from the Window menu. 
Each collection and portfolio you open is listed in the Window menu; to activate the collection or portfolio 
you want, choose it from the menu.



Report macros
Report macros are used in constructing titles, headers, and footers in your Text List Report templates. For 
more information about creating and saving Text List Report templates, please see the help topics for the 
Customize List Report dialog box and the Customize Report command.
Using macros, you can instruct ImageAXS to automatically insert different types of generated information 
in your report’s title, header, and footer. You can enter the following macros anywhere in the text strings 
you enter for your report’s standard page text:
%C: Automatically enters the collection name.
%P: Automatically enters the report page number.
%R: Automatically enters the number (relative to the records in the report) of the first record on the page.
%r: Automatically enters the number (relative to the records in the report) of the last record on the page.
When you use macros, imagine that you are entering the text information generated by ImageAXS instead 
of the macro. For instance, it is necessary to include spaces between the macros you enter and any non-
generated text you enter.
The following is an example of a possible use of macros in the Header text entry box of the Customize List 
Report dialog box.
If you entered “Record numbers %R to %r on page %P in %C report” and the name of the collection was
“My Collection,” the header in your report pages would appear as:
“Record numbers (number of first record on page inserted by ImageAXS) to (number of last record on page
inserted by ImageAXS) on page (report page number inserted by ImageAXS) in My Collection report.”



Columns
When displaying records in the Text List View, columns are the vertical sections of the view. Each column 
represents a field in a record; the label for the field appears at the top of the column. Columns can be 
resized by placing the cursor between two column heads with your mouse. When the cursor turns into a 
column resize tool, click and drag the column divider to your desired width. To return the column size to its
default, double-click the column head with your right mouse button.
Clicking a column head (where the field label and sort icon - shown below- appears), displays the Sort 
dialog box. Clicking the Arrow button at the top of the column opens a pop-up menu displaying the fields 
in the current collection. You can change the contents of the column by selecting a field name from the list.
Sort icon: 

Arrow button: 

 



Criteria
When you search for records in your collection, your first task is to enter the items for which you want 
ImageAXS Pro to search. The items you enter (such as, “field contains ‘Adams,’” and so on) are the search 
criteria.



Cursor
The cursor indicates the active point in the window. For example, when you work with text, the cursor 
blinks at the point characters will appear when you type. In ImageAXS Pro the cursor indicates what kind 
of action you can take: 
Arrow cursor Allows you to change active windows, choose menu items, click icons in the Toolbar, or 
select records in the Thumbnails View or Text List View
Text cursor Allows you to enter information in the Info Sheet View
Magnifying glass Allows you to zoom in [when showing the plus sign “+”] or zoom out [when showing 
the minus sign “-“] on source files; available only in the Source File View
4-arrow cursor Allows you to reposition the image in the Source File View window after choosing the 
Scroll Image command from the Source File menu
White rectangle cursor (Thumbnails View and Text List View only) The white rectangle cursor appears 
when no records are selected, and you are using the Arrow Keys on the keyboard to navigate through the 
records. The white rectangle merely indicates the location of the cursor, not a selected record. To select (or 
deselect) the record indicated by the white cursor, press the Spacebar. 



Data entry
The process of entering text into records using the Info Sheet View. ImageAXS Pro allows you to create 
records without acquiring source files to allow you to begin the task of data entry if the source files for your
collection aren’t immediately available.



Data file
The data file is the file that appears in Windows Explorer (File Manager on Windows 3.1 systems) and 
holds the information about your collection, including all thumbnails, keywords, and text information. 
When you double-click a data file, ImageAXS Pro launches and opens the Thumbnails View for the data 
file. In some instances, the terms “data file” and “collection” are used interchangeably.



Data set
The records that you are currently working with. For example, when you first open a collection, the data set
is all records in the collection, but after you perform a search, select records and choose the Show Selection
command from the Selection menu, or otherwise decrease the number of records in the active window, your
data set becomes equivalent to just the records in the active window. You can save the records in your data 
set as a portfolio.



Data source
In ImageAXS Pro, the data source serves to identify the following about your information:
· The path for the data
· The host application in which the data was originally stored
· The format of the data
· The drivers to use when accessing the data
ImageAXS Pro asks you to identify the data source when creating a new data file. The data source you 
select controls how ImageAXS Pro performs when working with data from a different application. Because
ImageAXS Pro is an Open Database Connectivity (ODBC) compliant application, you can use ImageAXS 
Pro to access data from a variety of sources, such as any database application capable of transferring data 
using Structured Query Language (SQL) or a folder containing files in dBase format. The data source you 
use can be local (on your system) or remote (accessed over a local or wide area network).
When you create a new collection which accesses information from a data source outside ImageAXS Pro, 
the collection file you create (saved on your system with a “.IAX” extension) is merely a link to the original
data.



Deselect
The action of clicking an already selected thumbnail, record listing in the Text List View, or button, to 
change its status. When you deselect a thumbnail the highlight around it disappears, when you deselect a 
record in the Text List View the highlight behind the listing disappears, when you deselect a radio button or 
checkbox it becomes empty.



Digital content
Any type of image, video, or audio file which has been saved on a computer. For a list of the file types 
ImageAXS Pro can accept, see the entry for File types in the Glossary.



Drag and drop
To help you work more efficiently, ImageAXS Pro allows you to use a “drag and drop” technique to 
perform several actions.
NOTE: To use the drag and drop technique, it is important that you understand how selections and cursors 
(particularly the white rectangle) work in ImageAXS Pro. It is recommended that you read these sections 
before working with the drag and drop technique.
Creating new records by dragging and dropping
To create new records in a collection by dragging and dropping, open the collection in which you want to 
create new records, and display the collection in either the Thumbnails View or the Text List View. After 
opening the collection, return to the operating system and select the source files you want to acquire (in 
Windows Explorer on Windows ’95 systems or in File Manager on Windows 3.X systems) and drag them 
to the window for the collection into which you want to acquire them. When you drop the source files into 
the window, ImageAXS Pro opens the Acquire Files dialog box, and the files which you dropped in the 
collection window appear in the Acquire Log. Use the controls in the Acquire Files dialog box to complete 
the task of acquiring the source files into your collection.
For more information about Windows Explorer and the File Manager, see the Windows User’s Guide.
Copying records between collections by dragging and dropping
ImageAXS Pro allows you to open multiple collections simultaneously. To copy records between 
collections, open both the collection which contains the records you want and the collection into which you 
want to copy the records, displaying each collection in either the Thumbnails View or the Text List View. 
To copy the records, select the records you want (hold down the CTRL key to select multiple records), drag
them over the window of the collection into which you want to copy them, and drop them by releasing the 
mouse button. The records appear in the collection window where you released them.
NOTE: If the collection which contains the records you are copying is formatted differently than the target 
collection (e.g., the order of the fields differs or the collections have different numbers of fields), 
ImageAXS Pro opens the Map dialog box after you drop the records into the target collection. The Map 
dialog box contains controls allowing you to match the fields of the records in the source and target 
collections.
Placing records in portfolios by dragging and dropping
When using ImageAXS Pro, you work with collections that are made up of individual records. In many 
instances, however, you may want to work with only a few records at a time. To make it more convenient, 
ImageAXS Pro allows you to save these subsets of records as portfolios, which you can recall whenever 
you want.
To copy records into a portfolio, open the collection that contains the records you want, and open the 
portfolio into which you want to copy the records. Note that the portfolio into which you want to copy the 
records may not be in the same collection; if you copy the records into a portfolio in another collection, 
ImageAXS Pro automatically creates entries for the records in the new collection and places the records in 
the target portfolio. When opening the collection and portfolio windows, make sure the contents are 
displayed in either the Thumbnails View or the Text List View. If the fields in the two collections are 
formatted differently, ImageAXS Pro displays the Map dialog box, which allows you to define the fields in 
the target collection in which you want to place the information from the source records.
Select the records which you want to copy (hold down the CTRL key to select multiple records, then drag 
them to the portfolio into which you want to copy them. When you release the mouse button, the records 
appear in the portfolio window.
Reordering records in portfolios by dragging and dropping
To reorder records in a portfolio, open the collection which contains the portfolio you want, then open the 
portfolio (using the Portfolios command in the File menu). You can display the portfolio in either the 
Thumbnails View or the Text List View. Select the record(s) you want to move and drag them to a new 
position in the portfolio. Note that if you want to move a single record, you may need to press the Spacebar 
to select the record (see the description of how the cursor works in ImageAXS Pro for more information). 
When you release the mouse button the records appear in the portfolio window in their new positions.



Field
The area in the Info Sheet View where you enter information. A field holds one piece of information, such 
as the title of a record, the name of the person responsible for creating the source file, or other data. Also 
called a column in traditional database parlance. See also: label.

ImageAXS supports four types of fields:
Text - Holds up to 255 ASCII characters
Numeric - Can contain only numeric information; used primarily for sorting
Date/Time - This field is automatically filled with the system date and time when the record is created
Boolean - Designed to hold binary (true/false, yes/no) information



File Information
File information is non-modifiable (read-only) information about the source file for the selected record. You
can see file information for a selected record by clicking the Thumbnail icon which appears below 
thumbnails in the Thumbnails View, or at the left end of rows in the Text List View.
ImageAXS Pro captures the file information for a record when a source file is acquired or a thumbnail is 
updated. File information includes the following information about the source file: 
File Size (in bytes)
Image Height and Width (if the source file is an image or a movie, the display size of the source file in 
pixels)
Bits Per Pixel (if the source file if an image or movie, the color depth of the source file, e.g., 8-bit, 16-bit, 
or 24-bit)
File Name (the name of the source file as it appears on your system)
File Creator (the application in which the source file was created, e.g., Photoshop, Canvas, Avid 
VideoShop, or SoundEdit Pro)
File Type (the type of the source file; for a list of the file types ImageAXS Pro can accept, see the entry for 
File types in the Glossary.)
Volume Time (the time when the volume from which you acquired the image was created; this information
is primarily for images stored on CD-ROMs)
Volume Name (the name of the volume on which the source file resides)
File Creation Time (the time the source file was created)
File Modification Time (the time the source file was last modified)
To display the file information for a record, select a record and choose the File Information command from 
the Source File menu, or double-click the Thumbnail icon for the record in either the Thumbnails or Text 
List view. You can also see file information for a record by selecting the record, choosing Info Sheet from 
the Views menu, and scrolling to the file information fields in the Info Sheet layout.



File types
ImageAXS Pro is capable of accepting source files of the following types:
1. ASCII Convert text to image
1. ATT 1-bit CCITT G4 format
2. AVI Microsoft movie format
3. BMP Microsoft Bitmap
4. BRK Brooktrout
1. CALS Computer-aided Acquisition and Logistics Support - U.S. Government Group IV fax-

compressed black and white images
1. CLP Clipboard format saved to disk
2. CUT Media Cybernetics Dr. Halo
3. DCX Multiple PCX images in a single file
4. DIB Device Independent Bitmap
5. EPSScreen Preview only
6. GIF CompuServe Graphics Interchange Format
7. Group III 1-bit compressed format commonly used for fax
8. Group IV 1-bit compressed format commonly used for fax
9. GX2 Showpartner
10. ICOMicrosoft Windows 3.1 icon file format
11. IFF Amiga Interchange File format
12. IMG GEM
13. IOCA 1-bit CCITT G3/G4 files
14. JPEG Joint Photographic Experts Group compressed image
15. KFX Kofax
16. LV LaserData 1-bit CCITT G4 files
17. MAC MacPaint
18. MOV Apple QuickTime movie format
19. MSP Microsoft Paint
20. PCX Run length encoded format
21. PhotoCD Read only - Kodak ImagePac
22. PICT Raster only
23. PSD Photoshop
24. RLE Utah Raster Toolkit
25. SUN Sun Raster
26. TGA Targa
27. TIF Tagged Image File Format - 45 possible tags
28. WAV Microsoft/IBM format for storing waveform audio data
29. WMF Raster only - Windows Meta File
30. WPG Raster only - WordPerfect metafile format
31. XBM MIT XBitmap - simultaneously a bitmap and legal C source code
32. XPM MIT Pixmap - extension of XBM format
33. XWD X Windows System window dump format
Each file type has its own attributes and advantages; you may choose to save files in different formats 
depending on the application in which you work.
NOTE: ImageAXS Pro is capable of acquiring any file type for which you have a Media Control Interface 
(MCI) extension installed.



Grid pattern
A format for displaying data using horizontal rows and vertical columns. ImageAXS Pro prints data in the 
Thumbnails View in a grid pattern, and allows you to specify how many thumbnails across and down you 
want to appear on each page.



Image Tool Palette
The Image Tool Palette contains tools which help when viewing source files that are images in the Source 
File View window. The Image Tool Palette contains the following tools:
NOTE: Using the tools in the Image Tool Palette does not affect the source file.

 Zoom In tool Choosing this tool then clicking the image Source File View window zooms in on the image, 
increasing its size on the screen. This is the default tool when you open the Source File View. You can also activate 
this tool by choosing Zoom In from the View menu.
 Zoom Out tool Choosing this tool then clicking the image in the Source File View window zooms out from the 

image, decreasing its size on the screen. You can also activate this tool by holding down the CTRL key while 
clicking the image in the Source File View window. You can also activate this tool by choosing Zoom Out from the 
View menu.
 Scroll Image tool When you select this tool, ImageAXS allows you to reposition the image in the window by 

dragging it using your mouse. This tool functions identically to the Scroll Image command in the View menu.
 Best Fit tool When you select this tool, ImageAXS automatically resets the image display scale to 1:1 (if 

possible, without cropping the image), or the largest size which fits on your monitor. This tool functions identically 
to the Best Fit command in the View menu.
 Crop Image tool When you select this tool, the mouse cursor becomes a crosshair. Position the crosshair cursor 

at one corner of the area in the Source File View that you want to crop and, while holding down the mouse button, 
drag the mouse diagonally across the area you want. When you release the mouse button, ImageAXS copies the area
you selected to the clipboard. A rectangle remains in the Source File View allowing you to confirm your cropping 
action captured everything you wanted. This tool functions identically to the Crop Image command in the View 
menu.
 Image Rotation 0 Degrees tool Clicking this button temporarily sets the rotation of the image in the Source File

View to 0 degrees (no rotation). This tool functions identically to the Image Rotation 0 Degrees command in the 
View menu.
 Image Rotation 90 Degrees tool Clicking this button temporarily sets the rotation of the image in the Source 

File View to 90 degrees (the equivalent of 90 degrees clockwise rotation). This tool functions identically to the 
Image Rotation 90 Degrees command in the View menu.
 Image Rotation 180 Degrees tool Clicking this button temporarily sets the rotation of the image in the Source 

File View to 180 degrees (the equivalent of 180 degrees clockwise rotation). This tool functions identically to the 
Image Rotation 180 Degrees command in the View menu.
 Image Rotation 270 Degrees tool Clicking this button temporarily sets the rotation of the image in the Source 

File View to 270 degrees (the equivalent of 270 degrees clockwise rotation). This tool functions identically to the 
Image Rotation 270 Degrees command in the View menu.

 



ImageBase
An ImageBase is the combination of your collection (the data file created by ImageAXS Pro) and the 
source files referenced by the records in the collection.



Indexed
To make searching and sorting your collection more efficient, ImageAXS Pro allows you to index fields in 
each record. When you designate a field to be indexed, ImageAXS Pro creates a table listing every different
value that appears in the field. If you later search or sort records in your collection using the information in 
the indexed field, ImageAXS Pro refers to the table to produce your results, a much faster process than 
reading the information in every record.



Info Sheet View
The Info Sheet View is used for reading and entering the text information contained in records. The Info 
Sheet View features a thumbnail representing the source file and scrolling lists showing the fields and 
keywords for the records. You can open the Info Sheet View by choosing Info Sheet from the View menu or
by clicking the Info Sheet View button in the Left Bar.
You can also attach keywords to records and add keywords to the Master Keyword List in the Info Sheet 
View. To attach keywords to records, display the record you want in the Info Sheet View, then type the 
keyword you want to attach in the Keyword entry area, directly below the thumbnail in the Info Sheet View
window. Press Enter to attach the keyword to the record; if the keyword you attach to the record doesn’t 
exist in the Master Keyword List, ImageAXS Pro automatically adds the keyword to the Master Keyword 
List for the collection.
While working in the Info Sheet View, you can easily navigate using the Tab, Arrow, Page Up, and Page 
Down keys. When you navigate to a field in the view using these keys, its text is automatically highlighted. 
Use the arrow keys to move through the scrollable lists of fields and keywords one at a time and to move 
the cursor while editing field text or keywords. Use the Tab key to navigate between all currently displayed 
areas of the Info Sheet View (to move backwards, press the Tab key while holding down the Shift key). Use
the Page Up and Page Down keys to scroll incrementally through the lists of fields, text, or keywords.
NOTE: A record can appear in only a single Info Sheet View window. If you use the record navigation 
buttons in the Toolbar to scroll through records in the Info Sheet View and you display a record for which 
there is already a Info Sheet View window open, ImageAXS Pro closes the inactive Info Sheet View 
window.



Info Sheet View
The Info Sheet View is used for reading and entering the text information contained in records. The Info 
Sheet View features a thumbnail representing the source file and scrolling lists showing the fields and 
keywords for the records. You can open the Info Sheet View by choosing Info Sheet from the View menu or
by clicking the Info Sheet View button in the Left Bar.
You can also attach keywords to records and add keywords to the Master Keyword List in the Info Sheet 
View. To attach keywords to records, display the record you want in the Info Sheet View, then type the 
keyword you want to attach in the Keyword entry area, directly below the thumbnail in the Info Sheet View
window. Press Enter to attach the keyword to the record; if the keyword you attach to the record doesn’t 
exist in the Master Keyword List, ImageAXS Pro automatically adds the keyword to the Master Keyword 
List for the collection.
While working in the Info Sheet View, you can easily navigate using the Tab, Arrow, Page Up, and Page 
Down keys. When you navigate to a field in the view using these keys, its text is automatically highlighted. 
Use the arrow keys to move through the scrollable lists of fields and keywords one at a time and to move 
the cursor while editing field text or keywords. Use the Tab key to navigate between all currently displayed 
areas of the Info Sheet View (to move backwards, press the Tab key while holding down the Shift key). Use
the Page Up and Page Down keys to scroll incrementally through the lists of fields, text, or keywords.
NOTE: A record can appear in only a single Info Sheet View window. If you use the record navigation 
buttons in the Toolbar to scroll through records in the Info Sheet View and you display a record for which 
there is already a Info Sheet View window open, ImageAXS Pro closes the inactive Info Sheet View 
window.



Info Sheet View
The Info Sheet View is used for reading and entering the text information contained in records. The Info 
Sheet View features a thumbnail representing the source file and scrolling lists showing the fields and 
keywords for the records. You can open the Info Sheet View by choosing Info Sheet from the View menu or
by clicking the Info Sheet View button in the Left Bar.
You can also attach keywords to records and add keywords to the Master Keyword List in the Info Sheet 
View. To attach keywords to records, display the record you want in the Info Sheet View, then type the 
keyword you want to attach in the Keyword entry area, directly below the thumbnail in the Info Sheet View
window. Press Enter to attach the keyword to the record; if the keyword you attach to the record doesn’t 
exist in the Master Keyword List, ImageAXS Pro automatically adds the keyword to the Master Keyword 
List for the collection.
NOTE: A record can appear in only a single Info Sheet View window. If you use the record navigation 
buttons in the Toolbar to scroll through records in the Info Sheet View and you display a record for which 
there is already a Info Sheet View window open, ImageAXS Pro closes the inactive Info Sheet View 
window.



Invert Selection
The Invert Selection command in the Edit menu instructs ImageAXS Pro to change the selection status of 
all records in the active window. For example, if the active window contains ten records, four of which are 
selected, and you choose Invert Selection from the Edit menu, the four selected records are deselected and 
the six unselected records are selected.
The Invert Selection command is very useful when you are working with a large number of records and you
want to select all but a few of them. Select the few records you don’t want, and then choose Invert 
Selection from the Edit menu.



Keywords
Keywords are descriptive words and phrases that you can attach to a record to facilitate searching. 
Keywords are most commonly used to describe the image associated with a record in terms of its content or
conditions, such as “landscape” or “royalty-free.” ImageAXS Pro allows you to construct, save, and load 
complex keyword searches, eliminating the need to re-enter information. To search for records using 
keywords as criteria, choose the Keyword Search command from the Selection menu.
You can also attach keywords to records and add keywords to the Master Keyword List using the Info 
Sheet View. See the description of the Info Sheet View in the Glossary for more information.
NOTE: A record can appear in only a single Keywords View window. If you use the record navigation 
buttons in the Toolbar to scroll through records in the Keywords View and you display a record for which 
there is already a Keywords View window open, ImageAXS Pro closes the inactive Keywords View 
window.



Labels
In the Info Sheet View, labels are the tags or names that appear next to fields, and serve as the “road signs” 
denoting what kind of information to place in the field. Labels also appear at the tops of columns in the 
Text List View.



Left Bar
The Left Bar contains controls allowing you to change the view and search or sort your data set or 
collection. The controls are shown below:

 Displays the Thumbnails View
 Displays the Info Sheet View
 Displays the Text List View
 Displays the Keywords View
 Displays the Source File View
 Opens the Search dialog box
 Opens the Keyword Search dialog box
 Opens the Sort dialog box

 Opens the About box for ImageAXS. The About box contains information about the program, such as the 
version, copyright information, and the members of the team who created ImageAXS. Click OK to close the About 
box.
You can display or hide the Left Bar using the Left Bar command in the View menu. A checkmark appears next to 
the Left Bar command when the Left Bar is visible.
NOTE: When the Left Bar is hidden, its buttons appear in the Toolbar.

 



Master Keyword List
The Master Keyword List contains all of the keywords in the collection. You can select keywords from the 
Master Keyword List to attach to records. The Master Keyword List appears in the Keywords View.



Off-Line
When you acquire a source file for a record, ImageAXS Pro does not physically bring the file into the 
collection; instead, the program takes a ‘snapshot’ of the source file and creates a smaller, thumbnail 
version of it that it stores in the data file. In addition to creating a thumbnail, the acquire process captures 
certain data about the source file (file information) that is stored, along with the thumbnail, in the data file. 
Part of the file information concerns the location of the file on your system (also called the path).
Because the source file is not part of the record, ImageAXS Pro requires access to the source file to display 
the Source File View for the record (that’s why the path is stored as part of the record).
Off-line refers to whether or not ImageAXS Pro can locate the source file for a specific record. If the source
file cannot be located, then the source file is off-line. If a source file is off-line you will not be able to 
display the Source File View for that record, or copy, move, rename, modify, or delete it.



On-Line
When you acquire a source file for a record, ImageAXS Pro does not physically bring the file into the 
collection; instead, the program takes a ‘snapshot’ of the source file and creates a smaller, thumbnail 
version of it that it stores in the data file. In addition to creating a thumbnail, the acquire process captures 
certain data about the source file (file information) that is stored, along with the thumbnail, in the data file. 
Part of the file information concerns the location of the file on your system (also called the path).
Because the source file is not part of the record, ImageAXS Pro requires access to the source file to display 
the Source File View for the record (that’s why the path is stored as part of the record). The source file must
also be on-line if you want to copy, rename, move, delete, or open it in an editing program using the 
commands in ImageAXS Pro.
On-line refers to whether or not ImageAXS Pro can locate the source file for a specific record. If the source
file can be located, then the source file is on-line.



Path
The path for a source file is the combination of the filename and the “roadmap” of where the source file 
resides on the system, including the name of the drive and any folders which contain the file. Because 
ImageAXS Pro does not incorporate the source file into your ImageBase when you acquire it, it is 
important that the path for source files be up to date (so you can display, copy, rename, move, delete, or 
modify the source file). If the path for a source file is invalid, the record is said to be off-line.



Portfolios
When using ImageAXS Pro, you work with collections that are made up of individual records. In many 
instances, however, you may want to work with only a few records at a time. To make it more convenient, 
ImageAXS Pro allows you to save these subsets of records as portfolios, which you can recall whenever 
you want. Placing records in a portfolio does not duplicate the records or remove them from the collection; 
instead, ImageAXS Pro creates a reference to the selected records which tags them as belonging to a 
specific group. Later, the program uses these references to quickly recall the records in the portfolio, so you
can work more efficiently. You can name portfolios so they can be easily recalled, and also modify the 
contents of portfolios as your needs change.
You can create many portfolios in a single collection, and records can be part of several portfolios. 
Portfolios, however, can only contain records from a single collection (you cannot add records from 
different collections to the same portfolio). If you attempt to add records from another collection to a 
portfolio, ImageAXS Pro adds the records to the collection to which the portfolio is associated (as well as 
to the portfolio).
When you open a portfolio, ImageAXS Pro places the name of the portfolio and the name of the collection 
from which it was derived in the title bar, so you can identify the portfolio easily. This name also appears in
the open window list in the Window menu to make navigation easier.



Preferences (Options)
Preferences are options which allow you to customize ImageAXS Pro. Some preferences are collection 
specific; such as field labels, which controls the terms that appear next to fields in the Info Sheet View and 
at the tops of columns in the Text List View. Other preferences control the way ImageAXS Pro operates 
independently of the collection that is open; these are called System Settings. Examples of System Settings 
include the appearance of ImageAXS Pro (fonts, the number of views you can have open simultaneously, 
and so on), the actions after which ImageAXS Pro will display messages, the way thumbnails are stored 
and displayed, the data source ImageAXS Pro will use when creating data files, and other areas of the 
program.
Preferences may be set any time after a collection has been created; however, it is best to set them before 
creating any records.



Print Preview toolbar

 The Print Preview toolbar provides controls allowing you to check your output before printing. The Print button 
allows you to direct your output to the printer (after inspecting it). The Next Page and Prev Page buttons allow you 
to progress through the pages of your output, the Two Page button directs ImageAXS Pro to display two pages of 
your output simultaneously. The Zoom In and Zoom Out buttons allow you to inspect your output more closely as 
well as take a broader view (allowing you to display two pages simultaneously if you want). The Close button closes
the Print Preview window and returns you to ImageAXS Pro.



Read Only
This term is used to describe information that you can see but not modify, such as in the information in the 
File Information dialog box or the Text List View. The only place where you can modify information in 
ImageAXS Pro is the Info Sheet View.



Record
Each collection or portfolio you create is made up of individual records. A record contains information 
about a single source file. To create a record, select a source file and acquire it. To create an empty record 
(one that is not yet associated with a source file), choose the New Record command from the Record menu.
Creating empty records is sometimes convenient if you want to begin the task of data entry before the 
source files are available.



Record Number indicator

 The Record Number indicator appears at the right end the Status Bar at the bottom of the ImageAXS Pro window. 
The Record Number indicator shows how many records are in the current data set and which (if any) record is 
selected.



Referenced
In your ImageBase, the action of “pointing” to an item logically, rather than actually incorporating it into a 
record. Examples of referencing would include a record’s source file. When you acquire a source file for a 
record, the name and path of the file are stored in the record, but the source file itself remains separate. This
technique conserves disk space on your system and improves the performance of ImageAXS Pro.



Rows
When looking at a grid pattern, a row is a horizontal line of information. For example, in the Text List 
View, a row represents one record in your collection.



Search Lines
To search for records in your collection, you build a set of search criteria. The criteria are represented as 
lines of text. For example, in the case of a collection of photographs, there may be fields labeled as 
“Photographer” and “Title.” The two lines below could serve as search lines:

Photographer is equal to Adams (search line 1)
and Title begins with “Y” (search line 2)

The search criteria above, which consist of two search lines, would return records such as “Yosemite 
Valley” and “Yosemite Falls.”



Searchable
An item which you can use to locate records in your collection. For example, the keywords which you 
attach to records are searchable, and can be used to locate specific records. If you use the hidden fields 
option (in the Field Labels dialog box), ImageAXS Pro allows you to designate whether or not the 
information in the hidden fields is searchable.



Select all
The Select All command in the Edit menu instructs ImageAXS Pro to select all records in the active 
window. This feature is useful when you want to copy all records in an active window to another collection 
or portfolio.



Selection
A selection is a record or group of records in your collection that you have singled out to work with. In the 
Thumbnails View and the Text List View the record or records included in a selection are highlighted with a
red rectangle.
You can select records individually or you can select groups of records. Groups of records can be selected 
from the Thumbnails View or the Text List View. The Info Sheet View, Keywords View, and Source File 
View, however, are single image views that constitute a selection of one. It is not possible to select multiple
records from single image views.
To select a group of records in the Thumbnails View or Text List View, press the CTRL key while selecting 
the records you want. To select a group of contiguous records, press the Shift key while selecting the first 
and last records in the set you want. To select a single record, click the thumbnail or listing for the record 
then press the Spacebar.
NOTE: The white rectangle does not indicate a record is selected; it merely indicates the location of the 
cursor. This feature is useful when navigating through the Thumbnails or Text List View using the Arrow 
keys.
ImageAXS Pro also features a set of commands designed to work with selections. In the Edit menu, the 
Select All, Clear Selection, and Invert Selection commands help you create and manage selections of 
records in your collection.
If you want to preserve a selection of records beyond the current session, use the Portfolios command in the
File menu. ImageAXS Pro allows you to create as many portfolios as you need, so you can efficiently 
manage the records in your collection.
NOTE: In certain instances, such as when exporting information, ImageAXS Pro uses the convention “A 
selection of none equals a selection of all” to decide which records to include. For example, if you have no 
records selected in a collection of 100 records and you perform an export (using the Export command in the
File menu), ImageAXS Pro creates an export file containing all 100 records. If you had a selection of 20 
records when you performed the export, ImageAXS Pro would export the information for only the 20 
records you had selected (out of the 100 record collection).



Slide Show
ImageAXS Pro includes the Slide Show feature, which displays the source files in the current data set one 
at a time, in a full-screen size window with a black background. ImageAXS Pro allows you to run the slide 
show automatically, with the images appearing on the screen for a period you specify, or manually, in 
which you scroll through the images using the Slide Show palette.
Start the slide show by choosing the Slide Show command from the View menu. Use the Behavior area in 
the System Settings dialog box to set the length that source files appear on the screen when running the 
slide show automatically, or to configure the slide show to run manually.



Source Files
A source file is the file from which a record in ImageAXS Pro is created. A source file is usually very large 
(sometimes many megabytes), and for this reason remains outside of the data file created by ImageAXS 
Pro. Instead, when you acquire a source file into a collection, ImageAXS Pro creates a thumbnail and 
places it in a record along with specific data about the source file (called file information). The file 
information ImageAXS Pro stores includes the path to the source file, linking the record to its source file. 
Using this link, ImageAXS Pro can display the source file in the Source File View. If a source file for a 
record is renamed, moved, or deleted from outside ImageAXS Pro, that record is said to be off-line and you
will not be able display the Source File View for the record.
ImageAXS Pro features a set of commands designed to help you manage the source files associated with 
your collection. The Update, Move Source Files, Copy Source Files, Rename, and Delete Source Files 
commands allow you to manage source files without causing your records to fall off-line.
For a list of the file types ImageAXS Pro can accept, see the entry for File types in the Glossary. To see the 
file information for a source file, click the Thumbnail icon for a record (available in the Thumbnails View 
and Text List View), or select the record and choose File Information from the Source File menu 
(ALT+ENTER).



Source File View
The Source File View in ImageAXS Pro is designed to display the source file for a record. If the source file 
for the record is an image, ImageAXS Pro displays the source file in its own window at full size (if 
possible). If the source file is a movie or sound file, ImageAXS Pro displays the source file in the standard 
window used for that kind of information on your system. To display the source file for a record in the 
Source File View, choose Source File from the View menu or click the Source File button in the Toolbar or 
Left Bar.
When you display a source file that is an image, the Source File View also features an Image Tool Palette 
which contains tools that allow you to zoom in on and zoom out from an image, scroll around the image in 
the Source File View, crop a portion of the image and place the data on the Clipboard, and rotate the image 
and display it at different orientations. While an image is being viewed, the Image Tool Palette can be 
toggled on and off using the Image Tool Pallete command in the Tools menu. If you choose not to display 
the Image Tool Pallete and the Left Bar is active, several of the pallete’s buttons appear in the Left Bar.



Source File View
The Source File View in ImageAXS Pro is designed to display the source file for a record. If the source file 
for the record is an image, ImageAXS Pro displays the source file in its own window at full size (if 
possible). If the source file is a movie or sound file, ImageAXS Pro displays the source file in the standard 
window used for that kind of information on your system. To display the source file for a record in the 
Source File View, choose Source File from the View menu or click the Source File button in the Toolbar or 
Left Bar.
When you display a source file that is an image, the Source File View also features an Image Tool Palette 
which contains tools that allow you to zoom in on and zoom out from an image, scroll around the image in 
the Source File View, crop a portion of the image and place the data on the Clipboard, and rotate the image 
and display it at different orientations. While an image is being viewed, the Image Tool Palette can be 
toggled on and off using the Image Tool Pallete command in the Tools menu. If you choose not to display 
the Image Tool Pallete and the Left Bar is active, several of the pallete’s buttons appear in the Left Bar.



Status Bar

The Status Bar, which appears at the bottom of the ImageAXS Pro window, displays the following information:
If you have Caps Lock on.
If you have Num Lock on.
The number of records in the current data set and which (if any) record you last    selected.
You can display or hide the Status Bar using the Status Bar command in the Tools menu. A checkmark appears next 
to the Status Bar command when the Status Bar is visible.



Text List View
The Text List View presents a text-only overview of the records in your current data set. In the Text List 
View you can see the contents of the fields in records in a list format. Each row in the Text List View 
represents one record, each column represents a field. You can open the Sort dialog box in the Text List 
View by clicking any of the column heads. To open the Text List View, choose the Text List command from
the View menu or click the Text List button in the Left Bar.



Text List View
The Text List View presents a text-only overview of the records in your current data set. In the Text List 
View you can see the contents of the fields in records in a list format. Each row in the Text List View 
represents one record, each column represents a field. You can open the Sort dialog box in the Text List 
View by clicking any of the column heads. To open the Text List View, choose the Text List command from
the View menu or click the Text List button in the Left Bar.



Text List View command
Use this command to switch the view in the active window to the Text List View. The Text List View displays a 
columnar list of the records in the current data set. Each row in the Text List View shows one record; each column in
the Text List View shows one field in the record (for example, one of the text, numeric, date/time, or Boolean fields 
in the record, or one of the file information fields).
You can select the field that appears in the column by choosing it from the Field pop-up menu. To open the Field 
pop-up menu, click the icon at the right edge of the head of each column. When you choose the field you want, the 
view changes to show the contents of that field for every record in your data set.
Click this icon to open the Field pop-up menu: 
 You can open the Sort dialog box in the Text List View by clicking the sort icon at the left edge of the head of each 
column.
Click this icon to open the Sort dialog box: 
 You cannot edit the information in fields in the Text List View; to edit the information in a record you must open the
record in the Info Sheet View.

Shortcuts:

Left Bar:
Toolbar:
Keyboard: ALT+V, T

 



Thumbnails View
The Thumbnails View provides a graphic overview of the records in your collection. When you acquire a 
source file to create a record, ImageAXS Pro does not incorporate the source file into your data file. Instead
(for reasons of efficiency), ImageAXS Pro creates a small representation of the source file called a 
thumbnail, and stores a “link” to the location of the source file (also referred to as a path). When you 
display the Thumbnails View, you see the thumbnails ImageAXS Pro has created for the records in your 
current data set. Double-clicking a thumbnail displays the source file for a record. Double-clicking the 
Thumbnail icon displays the file information for the source file associated with the record. To display 
Thumbnails View, choose the Thumbnails command in the View menu, or click the Thumbnails View 
button in the Left Bar.



Thumbnails/Thumbnail icon
A thumbnail is a small representation (no side larger than 128 pixels) of a source file. A thumbnail is 
created and included in a data file instead of the source file because source files can be very large 
(sometimes many megabytes) and a data file containing thousands of source files would be unusable.
Thumbnails can be stored and displayed in the Thumbnails View of the collection window, or a portfolio 
window as large thumbnails (128 x 128 pixels), medium thumbnails (96 X 96) or small thumbnails (80 x 80
pixels). Double-clicking a thumbnail in any view opens the Source File View for the record.
You can specify the caption that appears below thumbnails in the Thumbnails View using the controls in the
Field Labels dialog box. Clicking the caption displays the Info Sheet View for the record.
A Thumbnail icon also appears in the caption area below the thumbnail. This icon denotes the kind of 
source file referenced by the record:

 denotes the record is linked to an image file.
 denotes the record is linked to an sound file.
 denotes the record is linked to an movie file.

 Clicking the icon displays the File Information dialog box which contains information about the source file 
referenced by the record.



Tile
ImageAXS Pro allows you to display Source File Views for several records simultaneously (you can set the
limit for the number of Source File Views ImageAXS Pro can simultaneously display in the Appearance 
area of the System Settings dialog box). The ability to display source files simultaneously is useful for 
comparisons, presentations, and when you want to rapidly evaluate the source files for records.
To help you organize Source File View windows easily, ImageAXS Pro includes the Tile Full Views, Tile 
Vertically, and Tile Horizontally commands in the Source File menu. When you choose one of these 
commands, ImageAXS Pro arranges the windows on your screen so they do not overlap.



Title bar
In ImageAXS Pro. the Title bar (the colored bar at the top of a window) shows the name of the collection 
and the view displayed (Thumbnails, Text List, Info Sheet, or Keywords). If the Source File View is 
displayed, the thumbnail caption appears in the Title bar along with the scale at which the image appears. In
the Info Sheet and Keywords views, the number of the record displayed also appears in the Title bar.



Toolbar
The Toolbar contains buttons which allow you quick access to several menu commands, a list of help 
topics, and context-sensitive help. There are two versions of the Toolbar. When the Left Bar is displayed, 
the shorter version of the Toolbar appears. When the Left Bar is disabled, its buttons appear in the longer 
Toolbar.

Short Toolbar

The short version of the Toolbar includes the Acquire Source File and Portfolios buttons (described below).
Long Toolbar

The long version of the Toolbar is identical to the Short Toolbar, except that it includes buttons which correspond to 
those found on the disabled Left Bar and it lacks the Acquire Source File and Portfolios buttons.
Toolbar buttons

 New Collection
 Open Collection
 Cut
 Copy
 Paste
 Print
 Save
 Go to first record in data set
 Go to previous record in data set
 Go to next record in data set
 Go to last record in data set
 Show all records in collection

NOTE: When the Left Bar is hidden, the Portfolios and Acquire Source File buttons do not appear.
 Displays the Portfolios dialog box
 Acquire Source File
 Show help topics
 Context-sensitive help

NOTE: When the Left Bar is hidden, its buttons appear in the Toolbar. These buttons appear below:
 Displays the Thumbnails View
 Displays the Info Sheet View
 Displays the Text List View
 Displays the Keywords View
 Displays the Source File View
 Opens the Keyword Search dialog box
 Opens the Search dialog box
 Opens the Sort dialog box

 



Views
A view is a way of looking at images and data in ImageAXS Pro. There are five main views in ImageAXS 
Pro: Thumbnails View, Info Sheet View, Text List View, Keywords View, and Source File View.



Volume
A volume is any device on your system that holds information, such as a hard disk, a CD-ROM, or a drive 
that uses removable media (such as a Syquest cartridge, a Zip disk, a tape drive, or other storage medium).



Window menu
The Window menu contains commands allowing you to organize the way windows and icons appear inside 
ImageAXS Pro, as well as means for navigating between and closing open windows. For example, the 
Window menu contains the Cascade, Tile Full Views, Tile Horizontally, and Tile Vertically commands, 
which you can use to arrange Source File View windows for better viewing. 
If you reduce windows to icons (using the Minimize command in the Application Control menu or by 
clicking the minimize button), you can use the Arrange Icons command to organize the icons at the bottom 
of the window.
Because ImageAXS Pro allows you to open several collections simultaneously (and each collection can 
have several open windows), you may encounter difficulty navigating to the exact window you want. To 
solve this problem, ImageAXS Pro includes a list of all open windows in the Window menu; a checkmark 
appears next to the currently active window in the menu. To navigate to another windows, choose it in the 
Window menu. The window you choose immediately becomes active.



e-ZCard
ImageAXS Pro allows you to export records from your collection into a standalone presentation program 
called an e-ZCard. The e-ZCard utility allows you to place images onto a floppy which you can then 
distribute. When users receive the floppy, they can view the images in the e-ZCard by starting the program 
using the Windows Explorer (File Manager on Windows 3.1 systems).
The e-ZCard floppy you create is completely self-contained; users of the floppy do not need any other 
software to see your images. Once the program starts, users see an attractive screen containing one large 
and a number of thumbnail images (ImageAXS Pro allows you to specify how many thumbnails appear on 
a screen). Users navigate through the disk by clicking the image they want to see. Clicking a thumbnail 
enlarges it, replacing the large image on the screen (the large image appears in the place of the clicked 
thumbnail). Clicking the large image presents a full-screen version of the image.
Because you can distribute e-ZCard disks royalty-free, e-ZCards are a handy way to create giveaway disks 
for presentations, résumés, or demonstrations.

NOTE: The e-ZCard export utility is not available on Windows 3.1 systems.



Creating Web Page Templates
NOTE: The HTML export utility is not available on Windows 3.1 systems.
ImageAXS Pro features an HTML Web Page export utility which allows you to automatically export records from 
your collection into pre-formatted HTML web pages. Although ImageAXS Pro comes with a number of standard 
templates, the program also allows you to use templates you create, giving you the ability to generate web pages that
match your web site’s style.
NOTE: For information about the standard templates included with ImageAXS Pro, see the description of the Export
HTML Pages command in the on-line help or in the manual included with the program.

Prerequisites
To create templates for your HTML export, you must have knowledge of HTML programming and the web 
environment. You should also be familiar with ImageAXS Pro and have exported records from it into HTML pages 
using the standard templates (this is the best way for you to become familiar with how ImageAXS Pro formats 
HTML data). The information in this section is of a technical nature and is presented with the understanding that the 
reader is knowledgeable about these topics.

The HTML template
ImageAXS Pro is capable of accepting template files that are HTML-compliant but which contain extensions 
defining substitutions and areas for graphics within the page. All extensions are case sensitive (in accordance with 
the HTML specification). Please note that these extensions are stripped from the final web pages ImageAXS Pro 
produces (making them fully HTML compliant).
The pages ImageAXS Pro creates are essentially tables containing thumbnail images and (if you specify them in the 
HTML Export Wizard) links. The design and functionality of each cell of the Thumbnails Page is determined by the 
Thumbnails Page template structure. The design of the Info Sheet pages (which appear if you select the Link to 
Image through Info Sheet option in the Configure Features dialog box in the HTML Export Wizard) is controlled by 
the Info Sheet templates. The Thumbnail Page displays multiple records and the Info Sheet page and Source File 
page display only one record at a time.

Storing HTML templates
When you create HTML templates for use with ImageAXS Pro, be sure to give the templates you create an “.HTT” 
extension (identifying them as template files to ImageAXS Pro) and store them in the folder titled “Templates” in 
the same folder where you installed ImageAXS Pro. By storing your template files this way, users of the HTML 
Export Wizard will be able to locate the templates in their respective dialog boxes in the HTML Export Wizard 
while exporting their web pages.
NOTE: If HTML Wizard settings have been saved for later use using the controls in the Finish! dialog box, files 
with an “.HTS” extension also appear in the Templates folder. HTS files contain the settings saved in ImageAXS 
Pro’s HTML Wizard. It is not necessary to modify or create HTS files.

Including keyword search capability in your web pages
By selecting the Search Engine option in the Configure Features dialog box, you can allow users to search your 
collection based on keywords in any or all of three ways: direct keyword input; a clickable pop-up list of searchable 
keywords; and an alphabetical clickable table which displays all keywords which begin with the selected letter. 
When you select the Search Engine option, ImageAXS Pro creates a Search page as part of your export. 
Modification of the Search Page template is likely to be limited to changes of background color or font style.

Creating e-ZCards from HTML Pages
ImageAXS Pro contains a feature to include a button on your main web page allowing users to create an e-ZCard of 
the images in your page. To create an e-ZCard, users need only select images in the page and then click the e-ZCard 
output button. The e-ZCard is downloaded to the user’s computer.

Tips about creating e-ZCards
When ImageAXS Pro creates an e-ZCard, the images in the e-ZCard appear in the order that they appear in the web 
page (i.e., left-to-right, top to bottom, in the table). If you have a record that represents your collection (because it 



contains overview information, for example), be sure to place it in the first position in your export. It may be 
necessary to sort the records before creating the HTML export to achieve this.
While the procedures for selecting the content, creating, and downloading the e-ZCard images are fairly simple, it is 
recommended that you include instructions for visitors to your web site. These instructions appear on the Front Page
of the e-ZCard template included with ImageAXS Pro; feel free to paste these instructions into your HTML page 
(perhaps as part of the Collection Info) if you decide to customize your e-ZCard Front Page.
The common gateway interface (CGI) script (IAXZ.CGI or IAXZ.EXE) must be placed in your web server scripts 
folder for the e-ZCard download to function properly.

Template Description tags
Template description tags are included as <META> tags in the <HEAD> section of your HTML template. These 
tags designate which of the four page types the template is intended to create. Template description tags are also 
used to reference specified files and to set table height and width for the page.

NOTE: Each template must have one instance of an Iax.Kind tag; each may have several instances of Iax.Dependant
tags; and may have single instances of Iax.TableWidth and Iax.TableHeight tags.

<META NAME=“Iax.Kind” CONTENT=“Thumbnail”>
This tag specifies the file as a Thumbnail template.
<META NAME=“Iax.Kind” CONTENT=“InfoSheet”>
This tag specifies the file as a Info Sheet template.
<META NAME=“Iax.Kind” CONTENT=“Search”>
This tag specifies the file as a Search template.
<META NAME=“Iax.Kind” CONTENT=“LargeImage”
This tag specifies the file as a Large Image template.
<META NAME=“Iax.Dependant” CONTENT=“file name”>
This tag specifies that the designated file be copied to the destination. (Copies navigation arrows and other graphics 
over to HTML directory.)
<META NAME=“Iax.TableWidth” CONTENT=“number”>
This tag specifies the preferred table width. The number corresponds to the number of cells in the table.
<META NAME=“Iax.TableHeight” CONTENT=“number”>
This tag specifies the preferred table height. The number corresponds to the number of cells in the table.

NOTE: Each template must have one instance of an Iax.Kind tag; each may have several instances of Iax.Dependant
tags; and may have single instances of Iax.TableWidth and Iax.TableHeight tags.

Template Area tags
Template Area Tags define conditional areas in the template file. HTML tags enclosed by Area tags will be output to 
the destination file only if certain conditions are satisfied. The table below details Area tags and their use

Start Tag End Tag Condition

<%if Iax.Table EQ 1%> <%endif%> New table
<%if Iax.Row EQ 1%> <%endif%> New table row
<%if Iax.Cell EQ 1%> <%endif%> New table cell
<%if Iax.FirstPage EQ 1%> <%endif%> There are several pages and the

currentpage is the first one.

<%if Iax.LastPage EQ 1%> <%endif%> There are several pages and the
current page is the last one.

<%if Iax.MiddlePage EQ 1%> <%endif%> There are several pages and the
current page is neither the first nor last.

<%if Iax.SinglePage EQ 1%> <%endif%> There is only one page.



<%if Iax.LinkNone EQ 1%> <%endif%> User requested “None.”
<%if Iax.InfoSheet EQ 1%> <%endif%> User requested link to Info Sheet page.
<%if Iax.LargeImage EQ 1%> <%endif%> User requested link to Large Image page.
<%if Iax.EZCard EQ 1%> <%endif%> User requested EZ-Card functionality.
<%if Iax.EditLine EQ 1%> <%endif%> User requested Edit Line control for

keyword search engine.

<%if Iax.ListBox EQ 1%> <%endif%> User requested List Box control for
keyword search engine.

<%if Iax.KeyTable EQ 1%> <%endif%> User requested First-Character Table
for keyword search engine.

<%if Iax.Keywords EQ 1%> <%endif%> Entire section will be repeated for each
keyword.

<%if Iax.Search EQ 1%> <%endif%> User requested Search Engine functionality.

Collection Related Substitution Symbols
Substitution symbols specify that information be substituted. The following symbols are related to the entire 
collection being    exported from ImageAXS Pro.
[Iax.CollectionName]
Name of the collection. This information is drawn from the Collection Name field of the Collection Information 
dialog box.
[Iax.CollectionInfo]
Collection info. This information is drawn from the Collection Description field of the Collection Information dialog
box.
[Iax.CollectionTotalImages]
Total number of images in collection (search result).
[Iax.CollectionTotalPages]
Total number of pages in collection (search result).
[Iax.ScriptName]
Name of Iax.cgi (vs. Iax.exe)
[Iax.EZCardScriptName]
Name of Iaxz.cgi (vs. Iaxz.exe)

Text Substitution Symbols Related to Current Image
[Iax.Html.ImageWidth]
Image width in pixels. “width=number”
[Iax.Html.ImageHeight]
Image height in pixels. “height=number”
[Iax.Html.ImageFirst]
Link to first image.
[Iax.Html.ImageLast]
Link to last image.
[Iax.Html.ImagePrevious]
Link to previous image.
[Iax.Html.ImageNext]
Link to next image.
[Iax.Html.ThumbnailWidth]
Thumbnail width in pixels. “width=number”
[Iax.Html.ThumbnailHeight]
Thumbnail height in pixels. “height=number”



[Iax.Html.ImagePage]
Link to Large Image Page.
[Iax.Html.ImageFile]
Link to Large Image File.
[Iax.Html.ThumbnailFile]
Link to Thumbnail Image file.
[Iax.ImageDescription]
Image description.
[Iax.ImageCaption]
Image Caption.
[Iax.FieldName.FieldLabel]
Name of the specified field.
[Iax.FieldContent.FieldLabel]
Content of the specified field.
[Iax.Html.ParentPage]
Link to parent page.
[Iax.Html.InfoSheet]
Link to Info Sheet Page.

Numeric Substitution Symbols Related to Current Image
These symbols will be substituted by a decimal numeral.
[Iax.ImageWidth]
Image width in pixels.
[Iax.ImageHeight]
Image height in pixels.
[Iax.ImageNumber]
Number of current image.
[Iax.ImageTotal]
Total number of images.
[Iax.ImageFirst]
First image number (effectively equal to 0).
[Iax.ImageLast]
Last image number (effectively equal to Total -1).
[Iax.ImagePrevious]
Previous image number.
[Iax.ImageNext]
Next image number.
[Iax.ThumbnailWidth]
Thumbnail width in pixels.
[Iax.ThumbnailHeight]
Thumbnail height in pixels.

Numeric Substitution Symbols Related to Current Page
These symbols will be substituted by a decimal numeral.
Symbol 
Symbol definition.
[Iax.PageNumber]
Number of current page (1-based).
[Iax.PageTotal]
Total number of pages.
[Iax.PageFirst]
First page number (effectively equal to 1).
[Iax.PageLast]
Last page number (effectively equal to Total).
[Iax.PagePrevious]



Previous page number.
[Iax.PageNext]
Number of next page.
[Iax.PageFirstImage]
Number of first image on page (based on number 1).
[Iax.PageLastImage]
Number of last image on page (based on number 1).
[Iax.PageImages]
Number of images on page.

Text Substitution Symbols Related to Current Page
[Iax.Html.PageFirst]
Link to first page.
[Iax.Html.PageLast]
Link to last page.
[Iax.Html.PagePrevious]
Link to previous page.
[Iax.Html.PageNext]
Link to next page.
[Iax.Html.Home]
Link to home page.

Text Substitution Symbols Related to Current Keyword
Symbol 
Symbol definition.
[Iax.Html.Keyword]
Keyword name.



Drives area
A list of the volumes accessible by your system (hard drives, network drives, CD-ROMs, floppies, removable 
cartridges, etc.) appears in this area.



Update Thumbnails checkbox (Update Source File dialog box)
Selecting this checkbox causes ImageAXS Pro to create a new thumbnail for the record when updating to the new 
source file. If the appearance of the source file hasn’t changed significantly, you can leave this checkbox unselected 
and speed the update process.



Show Preview checkbox (Update Source File dialog box)
When this checkbox is selected, a preview of the file you select appears in the Thumbnail Display area. Although the
process is faster if this checkbox is not selected, the ability to check the appearance of files before selecting them 
can be highly beneficial (especially if you have to select between several files with similar names)



Thumbnail Display area
If you have the Show Preview checkbox selected, a thumbnail of the file you select appears here.



Path as Keywords checkbox (Acquire Files dialog box)
Selecting this checkbox causes ImageAXS Pro to create a keyword for the record when acquiring the new source 
file that contains the pathname for the file. This keyword is both added to the Master Keyword List and attached to 
the record.



Failed to Open Database message
ImageAXS Pro displays this message when it cannot open a data file for some reason. There are many reasons why 
ImageAXS Pro may be unable to open a data file, including version incompatibility and data corruption. If you are 
attempting to open a data file made with a previous version of ImageAXS Pro (e.g., version 2.5 or earlier), you must
first open the data file using the earlier version of ImageAXS Pro, export the data, and then import the data into a 
data file created using ImageAXS Pro. For more information about importing data into ImageAXS Pro, see your 
User’s manual or the description of the Import ImageAXS 2.x command.



Restore command (Application menu)
If you have minimized or resized a window, choosing this command will return it to its original size.

Shortcuts:
Keyboard: CTRL+F5



Move command (Application menu)
Choose this command to reposition a window on the screen. Although you can always move windows by dragging 
them using the Title bar, when you choose the Move command you can drag the window using any point in the 
window. When you choose the Move command, the cursor becomes a four-headed arrow and the outline of the 
current window changes to show that it is ready to be moved. An outline of the window follows the moving cursor, 
showing where the window will appear after you move it.

Shortcuts:
Keyboard: CTRL+F7



Size command (Application menu)
Choose this command to change the size of a window. When you choose the Size command, the cursor becomes a 
four-headed arrow and the outline of the current window changes to show that it is ready to be resized. Click and 
drag one edge of the window to resize it; an outline of the window follows the moving cursor as you drag, showing 
what size the window will be after you resize it.

Shortcuts:
Keyboard: CTRL+F8



Minimize command (Application menu)
When you choose this command, the active window is minimized to an icon. You can reopen the minimized window
by choosing either Restore or Maximize from the Application menu, or by double-clicking the icon.



Maximize command (Application menu)
When you choose the Maximize command, the active window expands to fill the entire application window (when 
you open the Application menu from a document window) or fill the entire screen (if you open the Application menu
from the Application window).

Shortcuts:
Keyboard: CTRL+F10



Close command (Application menu)
Choosing the Close command closes the window from which you opened the Application menu. Note that if you 
opened the Application menu from the Title bar of the main ImageAXS Pro application, you will exit the program. 
Also, if the window you close is the last open window for a collection, the collection will close (you will need to 
reopen the collection using the Open Collection command in the File menu).

Shortcuts:
Keyboard: CTRL+F4 (Collection window)

ALT+F4 (Application window)



Next Window command (Application menu)
As you navigate through the application, moving from window to window, the operating system maintains a list of 
the windows you activate. Choosing the Next Window command activates the next window on this list, allowing 
you to move between windows in the application without removing your hands from the keyboard.

Shortcuts:
Keyboard: CTRL+F6



Previous Window command (Application menu)
As you navigate through the application, moving from window to window, the operating system maintains a list of 
the windows you activate. Choosing the Next command activates the next window on this list, allowing you to move
between windows in the application without removing your hands from the keyboard.



Task List command (Application menu)
This command is available only from the Application menu of the main ImageAXS Pro window running under 
Windows 3.1 (or Windows NT 3.51). When you choose this command Windows displays the Task List. The Task 
List contains controls allowing you to activate or end other applications that are currently running. You can also 
move to other applications by pressing ALT+TAB (this technique also works in Windows ’95).



Record Number Indicator (Status Bar)
Each record you add to a data file is given a unique identifying number that is used for sorting, searching, etc. This 
number (referred to as a the Record ID Number) appears in the Status Bar.



Filter Duplicates checkbox (Acquire Files dialog box)
When this checkbox is selected, ImageAXS Pro automatically filters out files which have identical filenames 
(preventing duplicate records from being created in your data file).



Acquire Log
A list of the files ImageAXS Pro will acquire appears here. You can remove files from this list by selecting them and
clicking Remove; to remove all the files in the Acquire Log click Remove All.



Add button
When you click this button, ImageAXS Pro adds the selected file to the Acquire Log.



Remove button
To remove one or more files from the Acquire Log, select the file(s) you want to remove and click Remove.



Add All button
To add all files in the folder that currently appears in the Acquire In area, click the Add All button. After you click 
Add All, all multimedia files in the selected folder appear in the Acquire Log.



Add Subtree button
When you click the Add Subtree button, ImageAXS Pro adds to the Acquire Log all multimedia files in folders 
contained in the folder that appears in the Look In area. Note that if there are several nested folders contained in the 
folder (or volume) that appears in the Look In area this procedure can take a long time.



Remove All button
When you click this button, ImageAXS Pro removes all files that appear in the Acquire Log.



Acquire button
When you click this button, ImageAXS Pro begins acquire the files that appear in the Acquire Log, creating a record
for each file.



Slide Show palette

When you choose the Slide Show command from the View menu, ImageAXS Pro begins a slide show displaying the
source files linked to the records you selected to appear. When the slide show is playing, the Slide Show palette 
appears on the screen. The Slide Show palette contains controls which allow you to direct the appearance of images 
in the Slide Show. Note that you can close the Slide Show palette by clicking the close button at the right end of the 
title bar; to end the slide show press ESC.

Slide Show palette controls:

 Clicking this button displays the first record in the data set.
 Clicking this button displays the previous record in the data set.
 Clicking this button displays the next record in the data set.
 Clicking this button displays the last record in the data set.
 Clicking this button pauses the slide show.
 Clicking this button stops the slide show.



Slide Show palette

When you choose the Slide Show command from the View menu, ImageAXS Pro begins a slide show displaying the
source files linked to the records you selected to appear. When the slide show is playing, the Slide Show palette 
appears on the screen. The Slide Show palette contains controls which allow you to direct the appearance of images 
in the Slide Show. Note that you can close the Slide Show palette by clicking the close button at the right end of the 
title bar; to end the slide show press ESC.

Slide Show palette controls:

 Clicking this button displays the first record in the data set.
 Clicking this button displays the previous record in the data set.
 Clicking this button displays the next record in the data set.
 Clicking this button displays the last record in the data set.
 Clicking this button pauses the slide show.
 Clicking this button stops the slide show.



Pause/Resume button (Slide Show controls)
Clicking this button alternately pauses and resumes the slide show. When the slide show is paused this button shows 
a triangle; when the slide show is operating, this button shows two vertical lines.



Stop button (Slide Show controls)
Clicking this button ends the slide show and returns you to ImageAXS Pro.



Scroll Bars
Displayed at the right and bottom edges of the active window. The scroll boxes inside the scroll bars indicate your 
vertical and horizontal location in the active window. You can use the mouse to scroll to hidden parts of the active 
window.



Scroll Bars
Displayed at the right and bottom edges of the active window. The scroll boxes inside the scroll bars indicate your 
vertical and horizontal location in the active window. You can use the mouse to scroll to hidden parts of the .



Info Sheet View scroll bar (Fields area)
This scroll bar allows you to navigate through and display the contents of fields in the current record.
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Page Setup command (File menu)
Use this command to open the Page Setup dialog box The Page Setup dialog box allows you to set the grid pattern 
(the number of thumbnails across and down the page) for thumbnails on your printed output.

Shortcuts
Keyboard: ALT+F, G
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Print Preview command (File menu)
Use this command to display the active view as it will appear when printed. When you choose this command, 
ImageAXS displays the Printing Multiple Records dialog box, allowing you to specify a print range for the records 
in your collection. A Print Preview window opens in which one or two pages appear in their printed format. The 
Print Preview toolbar offers you options to view either one or two pages at a time; move back and forth through the 
document; zoom in and out on pages; and initiate a print job.

NOTE: The Text List View, when printed, is organized according to the default Text List Report template. Text List 
Reports are configurable as templates and can be designed to include or disinclude any field information that you 
want. To configure the Text List Report, use the Text List Report dialog boxand the Customize List Report dialog 
box, which are accessed using the Customize Report command.

Shortcuts
Keyboard: ALT+F, V
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 <<YourApp>> Help Index

How To ...
<<add your application-specific "how to" topics here>>

Commands
File menu
Edit menu
Record menu
View menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print 
Preview

Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Send... Sends the active document through electronic mail.
Exit Exits <<YourApp>>.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Link Pastes from the clipboard a link to data in another application.
Insert New 
Object

Inserts and embeds an object, such as a chart or an equation in a document.

Links List and edit links to embedded documents.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Split Split the active window into panes.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in <<YourApp>>.    Select the type of new file 
you want to create in the File New dialog box.    << Remove previous sentence if your 
application supports only one document type. >>

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

<< Delete this help topic if your application supports only one document type. >>

Specify the type of document you wish to create:
<< List your application's document types here >>



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>

Drives
Select the drive in which <<YourApp>> stores the file that you want to open. 

Directories
Select the directory in which <<YourApp>> stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    <<YourApp>> 
suggests that you save changes to your document before you close it.    If you close a 
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, <<YourApp>> displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, <<YourApp>> displays the Save As dialog box so 
you can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    <<YourApp>> displays the 
Save As dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



Send command (File menu)

Use this command to send the active document through electronic mail.    This command 
presents a mail window with the active document attached to it.    You may then fill out the 
To: field, Subject: field, etc., and add text to the body of the message if you wish.    When you
are finished you may click the "Send" button to send the message.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    <<YourApp>> adds 
the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application 
chooses via the OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your <<YourApp>> session.    You can also use the Close 
command on the application Control menu.    <<YourApp>> prompts you to save documents
with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    
Modify this help text accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in <<YourApp>>, such as File Open.    A check mark appears next 
to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in <<YourApp>>,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your 
application offers. >>

Click To
Open a new document.

Open an existing document.    <<YourApp>> displays the Open dialog box, in which 
you can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, <<YourApp>> displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Reverse the last editing.    Note:    You cannot undo some actions.

Go to the first record in the current selection.

Go to the previous record in the current selection.

Go to the next record in the current selection.

Go to the last record in the current selection.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the <<YourApp>> window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



Split Command (Window menu)

Use this command to split the active window into panes.    You may then use the mouse or 
the keyboard arrows to move the splitter bars.    When you are finished, press the mouse 
button or enter to leave the splitter bars in their new location.    Pressing escape keeps the 
splitter bars in their original location.    << In a single document interface application, this 
command will appear on the View menu. >>



1, 2, ... command (Window menu)

<<YourApp>> displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active window.  
Choose a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using <<YourApp>> and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
<<YourApp>>.



Context Help command 

Use the Context Help command to obtain help on some portion of <<YourApp>>.    When 
you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.    Then click somewhere in the <<YourApp>> window, such as another 
Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the <<YourApp>> window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    <<YourApp>> 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    <<YourApp>> 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts
Toolbar:

Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Record menu commands

 The Record menu offers the following commands:

First Record Shows the first record in the current selection
Previous Record Shows the previous record in the current selection
Next Record Shows the next record in the current selection
Last Record Shows the last record in the current selection

First Record command (Record menu)

Use this command to go to the first record in the current selection.

Shortcut
Toolbar:



Previous Record command (Record menu)

Use this command to go to the previous record in the current selection.

Shortcut
Toolbar:



Next Record command (Record menu)

Use this command to go to the next record in the current selection.    This command will be 
disabled if you are currently viewing the last record and have arrived at this record by a 
series of Next Record commands instead of the Last Record Command.

Shortcut
Toolbar:



Last Record command (Record menu)

Use this command to go to the last record in the current selection.

Shortcut
Toolbar:




